R/3 System
MRP Strategies
Made Easy

™

/3

rR

Fo

Guidebook to Materials
Requirements Planning

ses

lea

Re

SAP Labs, Inc.
R/3 Simplification Group

o3

Dt

3.0
.1I

MRP Strategies Made Easy
Copyright

Copyright
 1998 including screenshots by SAP Labs, Inc. All rights reserved.
Neither this documentation nor any part of it may be copied or reproduced in any form or by any means or
translated into another language, without the prior consent of SAP Labs, Inc.
SAP Labs, Inc. makes no warranties or representations with respect to the content hereof and specifically
disclaims any implied warranties of merchantability or fitness for any particular purpose. SAP Labs, Inc.
assumes no responsibility for any errors that may appear in this document. The information contained in
this document is subject to change without notice. SAP Labs, Inc. reserves the right to make any such
changes without obligation to notify any person of such revision or changes. SAP Labs, Inc. makes no
commitment to keep the information contained herein up to date.

Trademarks
ABAP/4 is a registered trademark of SAP AG.
SAP, R/2, R/3, SAPoffice, SAPscript, SAP EarlyWatch, and SAP Business Workflow are registered
trademark of SAP AG.
All other products mentioned in this documentation are registered or unregistered trademarks of their
respective companies.

MRP Strategies Made Easy

ii

© 1998 SAP Labs, Inc.

MRP Strategies Made Easy
Contents

Contents
Terminology..................................................................................................................................................................................................... vii
Typeface Styles...............................................................................................................................................................................................viii
Special Icons .................................................................................................................................................................................................... ix

Chapter 1: Introduction..............................................................................................................................................1–1
Overview .......................................................................................................................................................................................................1–1
Questions ..............................................................................................................................................................................................1–2
Planning Level.......................................................................................................................................................................................1–2
Production Level....................................................................................................................................................................................1–3
Procuring Components..........................................................................................................................................................................1–3
Responsibility for Production.................................................................................................................................................................1–3
Influence of Stock..................................................................................................................................................................................1–3
Consumption Strategies and Logic ...............................................................................................................................................................1–4
Purpose .................................................................................................................................................................................................1–4
Prerequisites..........................................................................................................................................................................................1–4
Determining the Requirements Type.............................................................................................................................................................1–5
Activities ................................................................................................................................................................................................1–5
Table of Planning Strategy Assignments...............................................................................................................................................1–7
Cross-Plant Planning...................................................................................................................................................................................1–10
Purpose ...............................................................................................................................................................................................1–10
Prerequisites........................................................................................................................................................................................1–10
Process Flow.......................................................................................................................................................................................1–10

Chapter 2: Strategies for Make-to-Stock Production ..............................................................................................2–1
Purpose .........................................................................................................................................................................................................2–3
Prerequisites..........................................................................................................................................................................................2–3
Process Flow.........................................................................................................................................................................................2–3
Planning with Final Assembly (40) ................................................................................................................................................................2–4
Purpose .................................................................................................................................................................................................2–4
Prerequisites..........................................................................................................................................................................................2–4
Process Flow.........................................................................................................................................................................................2–5
Key Properties of Strategy 40................................................................................................................................................................2–5
Other Areas ...........................................................................................................................................................................................2–6
Sample Scenario: Strategy 40...............................................................................................................................................................2–6
Coping with Insufficient Coverage of Components..............................................................................................................................2–12
Production by Lot Size (30) .........................................................................................................................................................................2–14
Purpose ...............................................................................................................................................................................................2–14
Prerequisites........................................................................................................................................................................................2–14
Process Flow.......................................................................................................................................................................................2–14
Key Properties of Strategy 30..............................................................................................................................................................2–15
Other Areas .........................................................................................................................................................................................2–15
Sample Scenario: Strategy 30.............................................................................................................................................................2–16
Net Requirements Planning (10) .................................................................................................................................................................2–18
Purpose ...............................................................................................................................................................................................2–18
Prerequisites........................................................................................................................................................................................2–19
Process Flow.......................................................................................................................................................................................2–19
Key Properties of Strategy 10..............................................................................................................................................................2–19
Other Areas .........................................................................................................................................................................................2–20
Sample Scenario: Strategy 10.............................................................................................................................................................2–20
Comparing Strategies 10 and 40.........................................................................................................................................................2–24
Combining Strategies 10 and 30 .........................................................................................................................................................2–26

© 1998 SAP Labs, Inc.

iii

MRP Strategies Made Easy
Contents

Gross Requirements Planning (11).............................................................................................................................................................2–27
Purpose ...............................................................................................................................................................................................2–27
Prerequisites .......................................................................................................................................................................................2–27
Process Flow.......................................................................................................................................................................................2–27
Other Areas .........................................................................................................................................................................................2–28
Sample Scenario: Strategy 11.............................................................................................................................................................2–28
Planning Without Final Assembly and Without MTO (52) ...........................................................................................................................2–32
Purpose ...............................................................................................................................................................................................2–32
Prerequisites .......................................................................................................................................................................................2–33
Process Flow.......................................................................................................................................................................................2–33
Key Properties of Strategy 52 .............................................................................................................................................................2–33
Other Areas .........................................................................................................................................................................................2–34
Sample Scenario: Strategy 52.............................................................................................................................................................2–34
Planning with a Planning Material and Without MTO (63)...........................................................................................................................2–40
Purpose ...............................................................................................................................................................................................2–40
Prerequisites .......................................................................................................................................................................................2–40
Process Flow.......................................................................................................................................................................................2–42
Key Properties of Strategy 63 .............................................................................................................................................................2–42
Other Areas .........................................................................................................................................................................................2–42
Sample Scenario: Strategy 63.............................................................................................................................................................2–43

Chapter 3: Strategies for Planning Components .................................................................................................... 3–1
Overview .......................................................................................................................................................................................................3–2
Prerequisites .........................................................................................................................................................................................3–2
Process Flow.........................................................................................................................................................................................3–2
Planning at Assembly Level (70)...................................................................................................................................................................3–3
Purpose .................................................................................................................................................................................................3–3
Prerequisites .........................................................................................................................................................................................3–3
Process Flow.........................................................................................................................................................................................3–4
Key Properties of Strategy 70 ...............................................................................................................................................................3–4
Sample Scenario: Strategy 70...............................................................................................................................................................3–5
Planning at Phantom Assembly Level (59) ...................................................................................................................................................3–9
Purpose .................................................................................................................................................................................................3–9
Prerequisites .........................................................................................................................................................................................3–9
Process Flow.......................................................................................................................................................................................3–10
Key Properties of Strategy 59 .............................................................................................................................................................3–10
Sample Scenario: Strategy 59.............................................................................................................................................................3–11
Strategies for Multi-Use Materials ...............................................................................................................................................................3–14
Definition .............................................................................................................................................................................................3–14
Use ......................................................................................................................................................................................................3–15
Combining Sales Order and Production Requirements ......................................................................................................................3–15
Planning Requirements Separately.....................................................................................................................................................3–17
Stock-keeping at Different BOM Levels ......................................................................................................................................................3–20
Stocking Level—Two Levels Below the Finished Product ..................................................................................................................3–21
Stocking Level—One Level Below the Finished Product ....................................................................................................................3–21
No Components Stored on Level Below the Finished Product ...........................................................................................................3–21
Replenishment Lead Time ..........................................................................................................................................................................3–22
Definition .............................................................................................................................................................................................3–22
Use ......................................................................................................................................................................................................3–22
Integration ...........................................................................................................................................................................................3–22

Chapter 4: Strategies for Make-to-Order (MTO) Production .................................................................................. 4–1
Overview .......................................................................................................................................................................................................4–2
Prerequisites .........................................................................................................................................................................................4–2
Process Flow.........................................................................................................................................................................................4–2

iv

© 1998 SAP Labs, Inc.

MRP Strategies Made Easy
Contents

Planning Without Final Assembly (50) ..........................................................................................................................................................4–3
Purpose .................................................................................................................................................................................................4–3
Prerequisites..........................................................................................................................................................................................4–3
Process Flow.........................................................................................................................................................................................4–4
Key Properties of Strategy 50................................................................................................................................................................4–4
Other Areas ...........................................................................................................................................................................................4–5
Sample Scenario: Strategy 50...............................................................................................................................................................4–5
Planning with a Planning Material (60)..........................................................................................................................................................4–8
Purpose .................................................................................................................................................................................................4–8
Prerequisites..........................................................................................................................................................................................4–9
Process Flow.......................................................................................................................................................................................4–10
Sample Scenario: Strategy 60.............................................................................................................................................................4–10
Make-to-Order Production (20) ...................................................................................................................................................................4–13
Purpose ...............................................................................................................................................................................................4–13
Prerequisites........................................................................................................................................................................................4–13
Process Flow.......................................................................................................................................................................................4–14
Key Properties of Strategy 20..............................................................................................................................................................4–14
Other Areas .........................................................................................................................................................................................4–14
Sample Scenario: Strategy 20.............................................................................................................................................................4–14

Chapter 5: Production with Variant Configuration ..................................................................................................5–1
Overview .......................................................................................................................................................................................................5–2
Strategies for Variants...................................................................................................................................................................................5–3
Variants and Variant Determination.......................................................................................................................................................5–3
Make-to-Stock Production for Variants..................................................................................................................................................5–5
Make-to-Order Production for Variants..................................................................................................................................................5–6
Planning Variants (54)...................................................................................................................................................................................5–9
Master Data Setup...............................................................................................................................................................................5–11
Process Flow.......................................................................................................................................................................................5–13
Other Areas/FAQs...............................................................................................................................................................................5–15
Characteristics Planning..............................................................................................................................................................................5–16
Overview..............................................................................................................................................................................................5–16
Creating Planned Independent Requirements for Characteristics Planning .......................................................................................5–17
Integrating Logistics Information System (LIS)....................................................................................................................................5–22
Characteristics Planning with Dependent Requirements (56).............................................................................................................5–23
Assembly Processing with Characteristics Planning (89)....................................................................................................................5–26
Make-to-Order Production with Configurable Materials (25) .......................................................................................................................5–32
Strategy Focus ....................................................................................................................................................................................5–32
Master Data Settings...........................................................................................................................................................................5–32
Process Flow.......................................................................................................................................................................................5–32

Chapter 6: Assembly Orders.....................................................................................................................................6–1
Overview .......................................................................................................................................................................................................6–2
Assembly Processing—Procedure........................................................................................................................................................6–2
Custom Strategies.........................................................................................................................................................................................6–3
Copy the Proper Requirements Classes into your Custom Requirements Class..................................................................................6–4
Create a Requirements type and Include the Newly Created Requirements Class..............................................................................6–5
Create a Planning Strategy ...................................................................................................................................................................6–6
Create a Strategy Group and Include the Newly Created Planning Strategy........................................................................................6–8
Assembly Processing with Production Orders (82) .......................................................................................................................................6–9
Creating a Production Order Directly or Through a Planned Order.....................................................................................................6–10
Special Settings for Production Orders ...............................................................................................................................................6–10
Sample Scenario: Strategy 82.............................................................................................................................................................6–11
Assembly Processing with Planned Orders (81) .........................................................................................................................................6–13
Special Settings for Planned Orders ...................................................................................................................................................6–14

© 1998 SAP Labs, Inc.

v

MRP Strategies Made Easy
Contents

Assembly Processing with Repetitive Manufacturing..........................................................................................................................6–14
Special Settings for Repetitive Manufacturing.....................................................................................................................................6–15
Sample Scenario: Strategy 81.............................................................................................................................................................6–16
Assembly Processing with Characteristics Planning (89) ...........................................................................................................................6–18
Index.........................................................................................................................................................................................................................1

vi

© 1998 SAP Labs, Inc.

MRP Strategies Made Easy
Terminology

Terminology
The following sections explain the terminology used throughout this guide.

Click
When you see the word “click,” use the mouse to point and click to perform the action. “Click” is always
used for on-screen buttons. For example:
The following phrases ask you to use
your left mouse button to click the onscreen button:

3

1. Click Authorizations.

2

2. Click Back.
3. Click possible entries.
Number callouts on the screenshot
help clarify the activity.

1

Choose
The word “choose” always appears
with menu paths. Use your mouse to
select the menu item from the top of
your window. In some cases, a menu
path might lead you through several
screens.

1

Menu paths appear as follows:
1. Choose Activity group → Transport.

© 1998 SAP Labs, Inc.
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Select
The words “select” and “deselect” always appear in instructions for checkboxes and radio buttons. For
example:
1. Deselect Generate folders for project
1
documentation.
2. Select Generate Enterprise IMG.

2

3. Under Payroll area, select Current
period.

3

Sometimes “select” is used in
conjunction with “click” when a user
must click to select a particular line.
For example:
4.

Click to select the Header level
release line.

4

Typeface Styles
The steps that require “user input” (text to be entered into a field or after a command prompt) are
indicated with bold, courier font such as:
Enter 14287 in Personnel number.
Notice that “Personnel number” appears in Object style, which is italicized text that indicates the word is an
on-screen object, such as a:
•

Button

•

Field

•

Screen title

•

Book or chapter title

viii
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•

Screen text or messages

For example:
1. In the User Maintenance screen,
enter SAP* in User.
2. Click Change password.

2
1

With the above examples, in the first step, whenever you see text in courier bold—user input style—you
know that information needs to be entered. Also in the first step, the words User Maintenance and User are
italicized because they refer to a screen title and an on-screen field.
The second step indicates that an action is required. Change password is italicized because it is an on-screen
button.

Special Icons
Throughout this guide you will see special icons indicating important messages. Below are brief
explanations of each icon:
Exercise caution when performing this task or step. An explanation of why you should be
careful will be included.

This information helps you understand the topic in greater detail. It is not necessary to know
this information to perform the task.

These messages provide helpful hints and shortcuts to make your work faster and easier.
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Overview
The overall goal of production planning—and the use of planning strategies—is to better serve your
customers by reducing:
•

Storage costs

•

Replenishment lead times

To reach that goal you should group your materials according to their individual needs. You should create
as few groups as possible (for better transparency on the shop floor) and as many as necessary (for
flexibility). The following examples may provide the criteria to group:
•

Cheap materials, which could be planned-consumption based.
It is more important to have these materials permanently available than to run out of them. The effort
to plan these materials should be minimal.

•

Expensive materials, or those with long replenishment lead times, which need a more sophisticated
planning approach.

Consider the following questions when grouping the materials:

© 1998 SAP Labs, Inc.
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•

Who is responsible for the production plan?

•

Are the materials produced before or after the arrival of sales orders?

•

How should the actual stock level affect production?

•

Do you need a consumption of planned quantities? When should this consumption take place?
Consumption of planned production quantities (planned independent requirements) allows for a
permanent reevaluation of planned quantities based on actual sales orders.

•

On what level in the product structure does your planning take place (finished product vs.
subassembly)

Production planning usually takes place only on one level of your product structure. For example, you
either perform production planning (“forecast” of demand) on the finished product level or on the
subassembly level.

Disclaimer
All scheduling information in the sample scenarios (stock/requirements lists), including the screens, is
subject to your scheduling settings. The actual results depend on your configuration and the setup of your
master data. The data is intended to give you typical examples.

Questions
To select the most appropriate planning strategies, answer the questions for each material group (remember
to use different strategies for different purposes). To make this guidebook easier to use, we have structured
similar strategy groups in such a way as to minimize the time you spend reading the entire document.

Planning Level
On which of the following levels do you want to plan component procurement:
•

Finished product level

•

Subassembly or component level

•

Characteristics or characteristics value level

Finished Product Level
Finished product level planning is used when there is a stable and predictable demand pattern at the
finished product level (the material sold in sales orders).

Subassembly or Component Level
Planning on the component level is used when there is a stable and predictable demand pattern at
component or subassembly level (the material used in production orders).
For the following reasons, it is often more convenient to plan at the component, rather than on the finished
product, level:
•

The demand pattern at finished product may be unstable

•

Many similar variants of finished products require the same component or subassembly

•

Finished products may be consumption based

1–2
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Characteristics or Characteristics Value Level
Planning on the characteristics (value) level is used when, for each configurable product, you have a stable
and predictable demand patterns at characteristics (value). The use of characteristics requires the use of the
variant configurator (see chapter 5, Characteristics Planning). Characteristics selection is translated into
component selection. Therefore, when planning at characteristics (value) level, you are planning, for
example, the characteristic “blue” paint. This characteristic results in the selection of the component “blue
paint.” A more complex example is to plan the characteristic “stick shift,” which results in the selection of
components related to that characteristic’s value.

Production Level
Would you like to produce the planned product in stock before a sales order is entered?
•

If “Yes,” use a make-to-stock strategy (for example, 10, 11, 40).

•

If “No,” use either a make-to-order or a strategy without final assembly (for example, 30, 52, 63, 20, 25,
26, 54, 55, 56, 65, 89)

Procuring Components
Would you like to procure the components before the entry of sales orders?
•

To procure or produce the entire product (the part that you sell) in stock before sales orders can be
placed, you should use a make-to-stock planning strategy (40, 10, 11). The components are
automatically procured before the sales order entry.

•

To procure or produce only subassemblies—essentially planning on a finished product level—you will
most likely use strategies without final assembly (for example, 50, 52, 55, 60, 63 or 65).

•

To procure or produce subassemblies based on plans, which are independent of finished products, you
will most likely use strategies for the planning of components (70 or 59).

Responsibility for Production
Who is responsible for the production quantities?
If your production department is responsible for production quantities and the resulting stock levels (and
they do not want to rely on sales forecast for the finished products), you can use strategies for planning
components and de-couple the two departments.

Influence of Stock
Should the stock level influence the production quantities?
Strategy 11 allows for production that relies only on the planned quantities from Demand Management
(without netting stock quantities). This strategy is particularly useful if you want to have a determined
production plan (for example, if you have to deal with a seasonal demand pattern but want to have
constant production).

© 1998 SAP Labs, Inc.
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Consumption Strategies and Logic
Purpose
In the consumption process, the system compares planned independent requirement quantities and dates
with actual customer requirements. The consumption process is defined for every planning strategy in
Customizing for Demand Management by combining a requirements type from Demand Management and
a requirements type from sales order management. This step means that the requirements type entered
when maintaining planned independent requirements is compared to the customer requirements type
specified in Customizing.

Prerequisites
You must maintain the consumption mode in the Material Master Record (MRP) screen or in Customizing
for Demand Management. The consumption mode determines whether consumption is to be carried out as
backward or forward consumption, or whether both consumption types are allowed. In backward
consumption, the system looks for the planned independent requirement quantity that exists directly
before the sales order.
In forward consumption, the system looks for the planned independent requirement quantity that exists
directly after the sales order. You also need to maintain the consumption period in the MRP screen or in
Customizing for Demand Management. The consumption period (forward or backward) is specified in
workdays and is valid from the current date. Sales orders, material reservations, and dependent
requirements then consume the planned independent requirement quantities that lie within the
consumption period and after (for forward consumption) or before (for backward consumption) the
requirements date.

Process Flow
Planned
indep.reqmts

Backward consumption only

Time
Customer
reqmts

Backward consumption period

PB

Forward consumption only

Time

Forward consumption period

PF

Backward/forward consumption
1

2

Time
PB

PF

The customer requirement consumes the planned independent requirement quantity that either directly
precedes or follows it. If the planned independent requirement quantity directly preceding the customer

1–4
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requirements does not cover the customer’s requirement, then the system looks for the next closest planned
independent requirements in the future or past.
During this process, the system refers to the consumption periods maintained in the material master or in
Customizing for Demand Management (see above). The consumption periods determine the intervals (for
backward or forward consumption) within which customer requirements consume planned independent
requirements. Customer requirements that lie outside the consumption period are not consumed.
If no consumption periods have been maintained, you can only consume requirements that are planned on
the same day. The allocation of customer requirements to planned independent requirements is carried out
dynamic. This step means that if sales orders or planning is rescheduled, the allocation is deleted and
redefined.

Determining the Requirements Type
A requirements type contains the control parameters to plan and consume planned independent
requirements and customer requirements. Different requirements types or combinations of requirements
types from planned independent requirements and customer requirements are defined for each planning
strategy.
You do not have to define any new strategies. SAP’s standard delivery provides you with all
strategies described in this document. There are only a few cases where you should define
your own planning strategies.

Activities
If you want the system to determine the requirements type when automatically creating the planned
independent requirements, enter strategy groups for the corresponding materials in the material master
record. If the strategy group allows a number of planning strategies, the system proposes the requirements
type from the main strategy. You can overwrite this strategy in the sales order using one of the alternative
requirements types in the Overview → Procurement screen.

Assigning a Planning Strategy via the MRP Group
You can also assign the planning strategy with the MRP group.
1. Assign the strategy group to the MRP group (in Customizing for Demand Management, choose Planned
Independent Requirements → Planning Strategy → Assign strategy group to MRP group). The MRP group is
assigned to the material in the material master record.
2. If you have entered a strategy group or an MRP group containing the appropriate strategies in the
material master record, you do not have to enter a requirements type in Demand Management.
The system determines the valid requirements type with the strategy group from the material master
record and automatically proposes this type when creating independent requirements (or customer
requirements). If the strategy group contains more than one planning strategy, the system proposes the
requirements type of the main strategy. If necessary, you can overwrite this proposal using one of the
requirements types from the alternative strategies.

© 1998 SAP Labs, Inc.
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Maintaining and Defining Strategies and Strategy Groups
The planning strategies represent the business procedures to plan and produce a material. In the system,
the planning strategies are recorded in Customizing by a combination of requirements types from
Demands and Sales Order Management. This combination determines either the consumption of planned
independent requirements by customer requirements or how the availability check is to be carried out.
The planning strategies are maintained in Customizing for Demand Management. Here, the requirements
types are combined for the planning strategy. Technically speaking, the requirements types are texts that
represent the planning strategy in the application (Demand Management, Sales and Distribution). The
requirements type is controlled by another key—the requirements class. The requirements class contains
all the control parameters required for Demand Management and Sales and Distribution. To maintain the
planning strategy, you only have to combine the necessary requirements types. The corresponding
requirements class is automatically assigned with all the accompanying control parameters.
By assigning a planning strategy to a particular material, the system determines the correct requirements
type (and all the control parameters of the requirements class) when creating planned independent
requirements or sales orders. To set up this mechanism, certain objects and assignments must be set up in
the system. The standard system is set up so that you can perform all standard processes described in this
guidebook.
The primary object for setup is the planning strategy (in Customizing for Demand Management). This
strategy is defined by a requirements type from Demand Management, Sales Order Management or a
logical combination of both requirements types. These requirements types determine, for example, how the
consumption of planned independent requirements by customer requirements is carried out and whether
the availability check according to the ATP logic also occurs.
The following assignments have to exist to assign the requirements classes to planned independent
requirements and sales orders:
•

Planning strategy to a strategy group (in Customizing for Demand Management) so that a material can
be planned with various planning strategies.
You can maintain one main strategy and up to six alternative strategies.

•

Strategy group to the material (in the material master record), so that the system can automatically
determine the correct requirements type.

A planning strategy can also be assigned with the MRP group. Assign the strategy group in Customizing
for Demand Management to the MRP group. In this case, the MRP group is assigned to the material in the
material master record.

1–6
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Determination of the Requirements Type
Material Master
MPR Group

1
2

Strategy Group
Strategy
Requirements Type

1

Highest Priority

2

Lower Priority

Requirements Class

If you have entered a strategy group or an MRP group containing the appropriate strategies in the material
master record, you do not have to enter a requirements type in Demand Management. The system
determines the valid requirements type with the strategy group from the material master record and
proposes this type automatically when creating independent or customer requirements. If the strategy
group contains more than one planning strategy, the system proposes the requirements type of the main
strategy. If necessary, you can overwrite this proposal using one of the requirements types from the
alternative strategies.
The following strategy groups combine two planning strategies:
•

Strategy 31
Allows you to select the Make-to-Order Production (20) or Production by Lot-size (30) strategies by
selecting the KE or KL requirements types [strategy 20 (KE) is the default]

•

Strategy 32
Allows you to select the Production by Lot-size (30) or Make-to-Order Production (20) strategies by
selecting the KL or KE requirements types [strategy 30 (KL) is the default]

•

Strategy 33
Allows you to select the Production by Lot-size (30) or Planning with Final Assembly (40) strategies by
selecting the KL or KSV requirements types [strategy 30 (KL) is the default]

Table of Planning Strategy Assignments
Strategy

Requirements Type for Independent Requirements Type for Customer
Requirements
Requirements

10

LSF

(Chapter 2)

© 1998 SAP Labs, Inc.

Make-to-stock
production

KSL

Sale from stock without
independent
requirement reduction
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Strategy

Requirements Type for Independent Requirements Type for Customer
Requirements
Requirements

11

BSF

(Chapter 2)

Gross planned
independent
requirements

20

KSL

Sale from stock without
independent
requirement reduction

KE

Individual sales order
without consumption

KEK

Make-to-order with
configurable material

KEL

Make-to-order for
material variants

(Chapter 4
25
(Chapter 5)
26
(Chapter 5)
30

LSF

Make-to-stock
production

KL

Sales order
manufactured by lot
size

VSF

Planning with final
assembly

KSV

Sales order with
consumption

VSE

Planning without final KEV
assembly

Make-to-order with
consumption

VSE

Planning without final KSVS
assembly

Make-to-stock with
consumption without
final assembly

VSE

Planning without final KEKT
assembly

Make-to-order with
consumption of variant

VSE

Planning without final KELV
assembly

Make-to-order variant
with consumption

VSE

Planning without final KEKS
assembly

Make-to-order with
consumption of
characteristics planning

VSEB

Planning; phantom
assemblies

VSEV

Planning the planning KEVV
material

Individual customer
with planning material
consumption

VSEV

Planning the planning KSVV
material

Make-to-stock with
consumption of
planning material

(Chapter 2)
40
(Chapter 2)
50
(Chapter 4)
52
(Chapter 2)
54
(Chapter 5)
55
(Chapter 5)
56
(Chapter 5)
59
(Chapter 3)
60
(Chapter 4)
63
(Chapter 2)

1–8
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Strategy

Requirements Type for Independent Requirements Type for Customer
Requirements
Requirements

65

VSEV

Planning the planning ELVV
material

VSFB

Planning for
assemblies

(Chapter 5)
70
(Chapter 3)
81

KMSE

Assembly planned
order

KMFA

Assembly with
production order

KMSE

Assembly planned
order

(Chapter 6)
82
(Chapter 6)
89

VSE

(Chapter 5)

Planning for
assemblies

Make-to-order variant
with planning material

The following planning strategies are used in the Project System (refer to the Project System
documentation for more details):
•

Strategy 21
Similar to 20 with project settlement.

•

Strategy 51
Similar to 50 with project settlement.

•

Strategy 61
Similar to 60 with project settlement.

•

Strategy 83
Assembly processing for PS.

•

Strategy 85
Assembly processing for PS.

The following planning strategy is used in Service Management (refer to the Service Management
documentation for more details):
Strategy 84

Assembly processing for SM

The following planning strategy is used in PP-PI [(Production Planning for Process Industy) refer to the
PP-PI documentation for more details]:
Strategy 86

Assembly processing for PP-PI
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Cross-Plant Planning
Purpose
Demand Management can also be used to plan across plants. For each material, there is a planning plant
that procures and stores the materials independently of orders. There are also one or more ordering plants
where the materials are used for sales orders, production orders, or for other requirements.

Prerequisites
It is recommended that you first read Planning with Final Assembly (40) in chapter 2 to better understand the
following example.
Set up the material master as follows:
Planning Plant

Ordering Plant

Any strategy group

Special procurement type = 40

Mixed MRP indicator = 1

Process Flow
The following table illustrates a typical process flow:
Planning Plant

Ordering Plant

Planned independent requirements are
created in Demand Management and trigger
procurement.
Procurement takes place before the sales
order arrives and materials are placed in
stock.
Any order (sales order, production order,
reservation) is created.
A stock transport order is created (for
example, by converting a transfer request that
was created by the MRP run).
Delivery for the stock transport order.
Goods receipt for the stock transport order.
Material is available for order.

1–10
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Purpose

Purpose
The planning strategies explained in this section are designed for planning procurement (production or
purchasing) of components by planning the final products. If you can plan at component level more easily,
see chapter 3.

Prerequisites
Choose a make-to-stock strategy, if:
•

The materials are not segregated.
In other words, they are not assigned to specific sales orders.

•

Costs need to be tracked at material level, and not at sales order level.

If you produce stock independently of orders, always use make-to-stock production, because you want to
immediately provide your customers with goods from that stock. You may even want to produce goods
without having sales orders, if you expect that there might be customer demand in future. This means that
make-to-stock strategies can support a close customer-vendor relationship, because the objective is to
quickly provide your customers with goods from your stock. Returns that have passed quality inspection
and other unexpected goods receipts can be used for other sales orders.
Avoid unreasonably high stock levels by:
•

Creating a production plan in advance (in Demand Management) to plan your stock.
If you make use of this option, you may also want to decide whether sales orders exceeding your plan
are to affect production or not.

•

Receiving sales orders as early as possible (using scheduling agreements, for example).

Process Flow
Automate the planning stage by using forecast, flexible planning, or SOP results, and passing the results
from these applications directly to Demand Management. For more information, see Transfer to Demand
Management in the R/3 Library under Sales and Operations Planning (PP-SOP).
In a make-to-stock environment, smoothing production is an important feature. This smoothing means that
the irregular requirements flow resulting from different customer requirements quantities can be
smoothed and simply produced to stock.
Make-to-stock strategies are usually combined with any lot-size key or rounding values. For instance, you
may want to produce the entire amount for the whole month once a month, or you may want to produce
full pallets only. In the following sample scenarios, the lot-size key is always EX for easier understanding.
No specific product structures are required for make-to-stock strategies. In other words, the material may
or may not have a bill of materials (BOM). The material can be produced in-house or it can be externally
procured.
The strategies Planning Without Final Assembly and Without Make-to-Order (52) and Planning with a Planning
Material and Without Make-to-Order (63) are exceptions to these rules. They require a lot-for-lot lot-size key
and require a specific product structure (BOM). From a costing perspective, these are make-to-stock
strategies, because costs are tracked at material level. They enable the procurement of components on the
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basis of planning and final assembly based on sales orders. Make-to-stock strategies generally consist of up
to five stages.
The following table illustrates which stages are involved in which strategies:

Stage

40

30

10

11

52

63

1. Demand Management (Creation
of Planned Independent
Requirements)

Yes

No

Yes

Yes

Yes

Yes

2. Procurement before Sales

Yes

No

Yes

Yes ²

Yes

Yes

3. Sales Order

Yes ¹

Yes

Yes

Yes

Yes ¹

Yes ¹

4. Procurement after Sales

No

Yes

No

No

Yes

Yes

5. Goods Issue for Delivery and
Reduction of Planned
Independent Requirements

Yes

Yes

Yes

Yes ³

Yes

Yes

¹ = + Allocation
² = + Reduction of planned independent requirements

Planning with Final Assembly (40)
Purpose
This strategy is probably the most widely used make-to-stock strategy. If you can forecast production
quantities for the final product, it makes sense to use this planning strategy.
Planned independent requirements are consumed by incoming sales orders so that the master plan is
always adjusted to suit the current requirements situation. Therefore, the important feature of this
planning strategy is that you can react quickly to a customer’s requirements. The smoothing of the master
plan is less important here.

Prerequisites
You need to maintain the following master data for the finished product in the material master:
•

Strategy group 40 on the MRP screen

•

Consumption parameters (Consumption mode, Bwd consumption, Fwd consumption) to allow consumption
of independent requirements
If no consumption parameters are maintained in the material master, default values are taken from the
MRP group.

•

A consumption mode and consumption period to control consumption.
For more information, see Consumption Strategies and Logic.

2–4
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•

Item category group (for example, NORM) on the Sales Organization Data screen.

Process Flow
Consumption

1

3

Independent
Independent
Requirements
requirements

Reduction

5

Pr
odPu
uc sh
tio
n
Production
Push

Sales
Sales Order
order

Warehouse Stock
Finished Product

For a detailed example of the entire process, see Sample Scenario: Strategy 40.

Key Properties of Strategy 40
•

Planned independent requirements are entered at finished product level and trigger the procurement
and production of the necessary assemblies and components before receipt of the sales orders.
It is possible to use information from the sales forecast, or from the Sales Information System, or other
planning tools to plan production quantities.

•

As soon as the sales order is received, it consumes the planned independent requirements.
This step means that you can compare the planned independent requirements situation with the actual
customer requirements situation.

•

An accurate availability check is performed according to ATP (available to promise) logic during sales
order processing.
Here, the system checks whether sufficient planned independent requirements have been planned to
cover the sales order.

•

Requirements from the sales orders are passed onto production and can lead to changes being made to
procurement if the requirements from the sales orders exceed the planned independent requirement
quantities.
If there is insufficient coverage of components—that is, the sales order quantities exceed the planned
independent requirement quantities—the sales orders cannot be confirmed. The system therefore
automatically adjusts the master plan. For more information see Coping with Insufficient Coverage of
Components. Planned independent requirement quantities that are left unconsumed increase the
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warehouse stock of the finished product. However, the system does not create additional production
orders if sufficient stock exists.

Other Areas
Availability Check
Unlike other planning strategies, planning strategy Planning with Final Assembly (40) does not require the
material master MRP availability check to contain a specific value. This field does not impact the strategy 40
planning process. You can also use the SD checking rule with (or without) replenishment lead times and
seen in the sales order under Edit → Item availability → Goto → Scope of check, according to your business
needs.

Statistics in Demand Management
In the total requirements list in Demand Management, R/3 will display only order quantities that have
consumed independent requirements. Quantities in excess of this amount will not be displayed. For
example, examine the following situation:
•

Stock Available 100 PC

•

Planned Independent requirements 50 PC

•

Two sales order, 50 PC each order

Order’s dates are close enough that they consume the planned independent requirements of 50 PC.
Confirm the creation of the sales orders and the consumption of the planned independent requirements in
the Stock/requirements list. The total requirements list (Logistics → Production → Master Planning →Demand
Management → Evaluations → Display total requirements) only shows the sales order(s), that have created a
physical reduction of independent requirements. Orders are allocated to independent requirements on a
first-come–first-serve basis. When independent requirements are fully consumed by current orders, they
cannot be further reduced by new orders. So, those new orders will not display on the total requirements list.
The system performs this process dynamically (based on a calculation). Hence, the allocation will not
display on the database. As a result, the Demand Management statistics may not display all sales figures
over a planning period.
In the above example, only the 50pc of the first sales order will display in the Demand Management’s total
requirements list, even though more were sold. Other functions, such as LIS or SIS, display those extra
orders.

Sample Scenario: Strategy 40
This scenario is based on a production plan where 100 pieces are planned for <reqdat1>, <reqdat2>, and
<reqdat3>.

Stage 1: Demand Management
Planned independent requirements are created for the production plan.

2–6
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1. Enter the material number to be
planned, for example SZ-40.

2

2. Click Enter.

1

3. The system finds requirements
type VSF because the strategy
group has been set to 40 (see the
Table of Planning Strategy
Assignments in chapter 1).

4

3

4. Click Save to pass these
requirements onto production.

5. To check the results of the
previous transactions, choose
Logistics → Production → MRP →
Evaluations → Stock/reqmts list.
The stock/requirements list for
the above example appears as
shown to the right. In the rest of
this documentation, the
stock/requirements list will
appear in table form.

© 1998 SAP Labs, Inc.

2–7

Strategies for Make-to-Stock Production
Planning with Final Assembly (40)

Stage 2: Procurement Before Sales
A procurement requisition is created in the MRP run. To initiate the MRP run, choose Logistics →
Production → MRP → MRP → Total planning...
The resulting stock/requirements list appears as follows:

Date

MRP
Element

Received/
Required
Quantity

Available
Quantity

<today>

Stock

<reqdat1>

PlOrd.

1234/Stck

100 +

100+

<reqdat1>

IndReq

VSF

100 -

0

<reqdat2>

PlOrd.

1235/Stck

100 +

100+

<reqdat2>

IndReq

VSF

100 -

0

<reqdat3>

PlOrd.

1236/Stck

100 +

100

<reqdat3>

IndReq

VSF

100 -

0

0

This procurement requisition is the starting point for production or external procurement. In the R/3
System, various possibilities exist for handling the procurement process. One option would be to convert
the planned order into a production order by releasing the production order and a goods receipt of the
yield quantity. The second option would be to use returns or other goods movements for make-to-stock
production.
After the receipt of the order and a second MRP run, the stock/requirements list appears as follows.

Date

MRP
Element

Received/
Required
Quantity

Available
Quantity

<today>

Stock

<reqdat1>

IndReq

VSF

100 -

0

<reqdat2>

PlOrd.

1235/Stck

100 +

100

<reqdat2>

IndReq

VSF

100 -

0

<reqdat3>

PlOrd.

1236/Stck

100 +

100

<reqdat3>

IndReq

VSF

100 -

0

100

Stage 3: Sales Order
To create a sales order, choose Logistics → Sales and distribution → Sales → Order → Create.
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The following steps (1-4) are optional to check the component availability.

1. On the Create Standard Order:
Overview – Single-Line Entry
screen, choose Edit → Item
availability.

2. The quantities on this screen
confirm the available quantity. In
this example, any quantity—up to
the stock quantity—can be
confirmed based on the ATP
checking rule (100 pieces in this
example).
Checking availability proves that
stock is available.
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3. From the Create Standard Order:
Overview – Single-Line Entry
screen, choose Overview →
Procurement if you wish to check
the requirements types.

4

The Create Standard Order:
Overview – Procurement screen
appears.
Because the strategy group has
been set to 40, the system will find
the requirements type KSV. The
system finds the schedule line
category CP and the item category
TAN because the item category
group was set to NORM.
4. Click Save.
After the sales order has been entered, the stock/requirements list appears as follows:

Date

MRP
Element

Received/
Required
Quantity

Available
Quantity

<today>

Stock

<today>

Order

341/010/01

90 -

10

<reqdat1>

IndReq

VSF

10 -

0

<reqdat2>

PlOrd.

1245/Stck

100 +

100

<reqdat2>

IndReq

VSF

100 -

0

<reqdat3>

PlOrd.

1236/Stck

100 +

100

<reqdat3>

IndReq

VSF

100 -

0

100

Stage 4: Procurement After Sales
This stage does not, as a rule, apply in this strategy. If demand exceeds planning, there may be a need for
production to take place after sales.
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Stage 5: Goods Issue for Delivery and Reduction of Planned Independent Requirements
1. To create a delivery and post a
goods issue choose, for example,
Logistics → Sales and distribution →
Shipping → Delivery → Create.

3

2. In Selection date, enter a date
greater than the Planned delivery
date (as calculated in the sales
order).

2



3. Choose Picking.

4. Enter a Pick quantity.
5. Click Post goods issue.
5

4
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The stock/requirements list appears as follows:

Date

MRP
Element

Received/
Required
Quantity

Available
Quantity

<today>

Stock

< reqdat1>

IndReq

VSF

10 -

0

<reqdat2>

PlOrd.

1245/Stck

100 +

100+

<reqdat2>

IndReq

VSF

100 -

0

<reqdat3>

PlOrd.

1236/Stck

100 +

100

<reqdat3>

IndReq

LSF

100 -

0

10

The reduction of the independent requirements is not visible now, because the planned independent
requirement was allocated during sales order processing. Technically speaking, however, the planned
independent requirement is reduced by the delivery (see Statistics in Demand Management earlier this
chapter).

Coping with Insufficient Coverage of Components
Sales order quantities may exceed planned independent requirements quantities. The scenario that follows
appeared first in the section Sample Scenario: Strategy 40, but also applies to all planning strategies that use
planned independent requirements.

Process Flow
A sales order with a quantity of 75 pieces is entered. Ten pieces remain in stock, but they are unallocated.
Only a quantity up to the stock quantity can be confirmed. The entire quantity, however, is passed onto
MRP. After entry of the sales order and an MRP run, the stock/requirements list appears as follows:
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Date

MRP
Element

Received/
Required
Quantity

Available
Quantity

<today>

Stock

<today>

Order

341/010/01

90 -

10

<today>

Order

390/010/01

75 -

65 -

<t + rlt>

PlOrd.

1234/Stck

65

0

<reqdat2>

PlOrd.

1235/Stck

35

35

<reqdat2>

IndReq

VSF

35 -

0

<reqdat3>

PlOrd.

1236/Stck

100

100

<reqdat3>

IndReq

VSF

100 -

0

100

The stock/requirements list and the total requirements list (Demand Management → Evaluations → Display
total requirements) show the allocation. The combined order quantity of 165 pieces has been allocated to two
planned independent requirements; it has totally consumed the requirement, which was on <reqdat2> and
has partly consumed the next requirement of <reqdat3>. Although the requirement is no longer visible in
the stock/requirements list, it is visible in the total requirements list.

Suggestions for Coping with Insufficient Coverage
To set up the consumption parameters in the material master on the MRP screen, check if the Consumption
mode, Bwd consumption, Fwd consumption fields contain entries. If these fields are empty, default values are
taken from the MRP group parameters in Customizing. If these fields are filled in the material master,
however, they override the MRP group parameters.

© 1998 SAP Labs, Inc.

2–13

Strategies for Make-to-Stock Production
Production by Lot Size (30)

We advise you to review all unconfirmed sales orders. To do this, use the backorder functionality in Sales
and Distribution under Sales → Environment → Backorders → Rescheduling → Execute. If you run the report in
test mode (enter x in the Simulate field), it will provide you with a log that lists all unconfirmed sales
orders. Use this list as the basis for discussions between the sales and production departments to decide
how to proceed.
One option would be to talk to the customer and cancel or postpone the order (or some schedule lines of
it). Another option, if possible, would be to increase production. In both cases, you need to repeat the
availability check for the orders. Backorder processing is the most efficient way of confirming multiple
sales orders.

Production by Lot Size (30)
Purpose
Procurement is based only on sales orders, and no planning for the finished product is involved here.
Depending on the dates, several sales orders can be grouped together for production in one single lot.

Prerequisites
Maintain the following master data for the finished product:
•

Strategy group 30 on the MRP screen

•

Availability check field (on the MRP screen and the Sales: General/Plant screen) so that you perform an
availability check with replenishment lead times (01 in the standard system)

•

Item category group (for example, NORM) on the Sales Organization screen

Process Flow
Goods issue for delivery reduces open sales order
3

Sales order
Sales order
Sales order
Sales order
Sales
Sales order
order

5

Warehouse stock
Finished product

4
Production
Push

Pr
od
uc Pu
tio sh
n

For a detailed example of the entire process, see Sample Scenario: Strategy 30.
Procurement is based only on sales orders. No planning for the finished product is involved here, which
means that you usually have to know the sales order situation in advance. Therefore, with regard to the
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production time and replenishment lead times of the components, this strategy is sometimes combined
with scheduling agreements.
You can also procure the necessary components with the following:
•

Individual planning of the components, for example, using strategy 70 [for more information, see
Planning at Assembly Level (70)]

•

Kanban components

•

Consumption-based components

Key Properties of Strategy 30
•

It is not possible to make use of information from other SAP planning tools, such as forecasting, Sales
Information System, or SOP (except when combined with schedule line agreements).

•

Accurate availability check performed according to ATP logic during sales order processing

•

Lot size optimization or rounding mechanisms
Depending on the dates, several sales orders can be grouped and be collectively produced in a single
lot. The lot size in this procedure depends on various aspects of production, such as pallet size or
production optimization.

•

Leftover stock from previous procurements
Using leftover stock for other sales orders is particularly useful for companies that mainly produce
goods for major customers, but who also require the option of selling smaller requirements from stock.

•

Planned independent requirements not consumed by sales and stock orders
However the delivery “consumes” the schedule lines or sales order items, because it updates the
delivered. If an issue is made for a particular sales order, the system reduces the sales order quantity.
Stock orders are reduced when the goods are sold from stock.

Other Areas
Availability Check
You need to maintain the ATP indicator (Availability check field in the material master) so that you can
check with replenishment lead times. In the standard system, checking rule 01/A checks with
replenishment lead times. To define how the availability of components in production orders is checked in
the Implementation Guide (IMG), in Sales and Distribution, choose Basic Functions → Availability Check and
Transfer of Requirements → Availability Check → Availability Check with ATP logic or against planning → Carry
out control for availability check.
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AV (= Checking
group for
availability check)

Description

RLT
ChR (= Checking
rule for availability
check)

01

Daily requirements

A

“Blank” (= check with
replenishment lead
time)

02

Individual
requirements

A

X (= check without
replenishment lead
time)

The checking rule in the sales order is always A in make-to-stock strategies.
In the standard system, checking group 01 is set up so that daily requirements are passed
onto production. This means that there is only one line visible in the stock/requirements list
(as shown in the following sample senario) that contains the cumulated quantity for one day,
rather than the individual sales orders. Hence, the sales order number does not display on the
Order line in the stock requirements list.

Sample Scenario: Strategy 30
In this example, a quantity of 10 pieces is entered with a required delivery date of today. An order like this
can be confirmed after the replenishment lead time.

Stage 1: Demand Management
This stage does not apply to this strategy.

Stage 2: Procurement Before Sales
This stage is also not applicable in this strategy because production does not take place without a sales
order. If advance sales orders exist in the system, production is carried out before the required delivery
date.

Stage 3: Sales Order
A sales order is created (Logistics → Sales and distribution → Sales → Order → Create).
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In this picture you should note the following:
It is possible to confirm a quantity according to an ATP checking rule (Edit → Check availability on the Sales
Order screen). In this strategy, because you do not always have warehouse stock, it is important to
maintain the Availability check field in the material master so that the replenishment lead time is used in the
check.
The system finds the schedule line category CP and the item category TAN because the item category
group was set to NORM. The system will find the requirements type KL (under the Overview →
Procurement in the sales order menu) because the strategy group has been set to 30.
Once the sales order has been entered, the stock/requirements list appears as follows:

Date

MRP
Element

<today>

Stock

<today>

Order

Received/
Required
Quantity

Available
Quantity
0

10 -

10 -

Stage 4: Procurement After Sales
A procurement requisition is created in the MRP run (Logistics → Production → MRP → Total planning). The
stock/requirements list for the above example would then appear as follows:
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Date

MRP
Element

<today>

Stock

<today>

Order

<t + rlt>

PlOrd.

Received/
Required
Quantity

Available
Quantity
0

000214/Stck

10 -

10 -

10

0

t + rlt = today + replenishment lead time

This procurement requisition is the starting point for production or external procurement. In the R/3
system, various possibilities exist to handle the procurement process. One option would be to convert the
planned order into a production order, releasing the production order and a goods receipt of the yield
quantity. Another option is to use returns or other goods movements for make-to-stock production.
After receiving the order and a second MRP run, the stock/requirements list is as follows:

Date

MRP
Element

<today>

Stock

<today>

Order

Received/
Required
Quantity

Available
Quantity
10

10 -

0

Stage 5: Goods Issue for Delivery and Reduction of Planned Independent Requirements
After delivery (Logistics → Sales and distribution → Shipping → Delivery → Create) and goods issue, the
stock/requirements list is reset to initial (empty).

Net Requirements Planning (10)
Purpose
This planning strategy is particularly useful in mass production environments. It is often combined with
repetitive manufacturing. Choose this strategy if you want production to be determined by a production
plan (Demand Management), and if you do not want sales orders to directly influence production. One of
the most important features of this planning strategy is that it enables you to smooth the demand program.

Examples from Industry
Strategy 10 is used in the customer packaged goods industry because it is possible to plan the demand for
ice cream, for example, while a single order should not affect production. Strategy 10 is also used for
products with seasonal demand where production needs to be smoothed.
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Prerequisites
Maintain the following master data for the finished product:
•

Strategy group 10 on the MRP screen.

•

Item category group (for example, NORM) on the Sales Organization screen.

•

Availability check field in Customizing so that you perform an availability check without replenishment
lead times (in the standard system, you need to enter 02 here). For more information, see the Other
Areas section below.

Process Flow
Consumption

11

33
Sales
Sales Order
order

Warehouse Stock
Finished Product

Independent
Independent
Requirements
requirements

2

5

5

Pr
odPu
uc sh
tio
n
Production
Push

Reduction

For a detailed example of the entire process, see Sample Scenario: Strategy 10.
Procurement quantities can be planned relatively effectively with planned independent requirements. It is
possible to use information from the sales forecast, or from the Sales Information System, or from other
planning tools to plan production quantities. This means that production and procurement of the required
components is triggered before receiving sales orders.

Key Properties of Strategy 10
•

Procurement is only determined by planned independent requirements.
This property lends itself to a smoothing of production, which means that you can create a smooth
production plan that is unaffected by irregular sales orders.

•

An accurate availability check is performed using ATP logic during sales order processing.

•

Sales orders can be displayed for information purposes only.
They do not affect production quantities. Goods are sold from stock in this strategy.

•

The planned independent requirements are reduced at goods issue for the delivery.
You can compare the planned independent requirements situation with the actual customer
requirements.
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•

Planned independent requirements left unreduced increase the warehouse stock of the finished
product and cause procurement to be decreased or, due to netting, to not take place at all in the next
period.

If you want the system to reduce future planned independent requirements when it makes withdrawals for
unplanned sales orders, maintain the appropriate consumption period. See Consumption Strategies and Logic
in chapter 1 for more information.

Other Areas
Availability Check
You need to work with an availability check that checks without RLT (such as 02 in the standard system).
Refer to the Other Areas section in Production by Lot Size (30) for more information.
For this strategy, it usually makes sense to create a new checking rule that combines “check
without RLT” with the passing of daily requirements.

Displaying Sales Orders
To turn off the orders display, set the No MRP indicator to 2 in Customizing (choose Sales and Distribution
→ Basic Functions → Availability Check and Transfer of Requirements → Transfer of Requirements → Define
Requirements Classes).

Leaving the No MRP field blank in strategy 10 leads to serious consequences!

This IMG activity is linked to LSF in Customizing under Sales and Distribution → Basic Functions →
Availability Check and Transfer of Requirements → Transfer of Requirements → Define requirements types.

Sample Scenario: Strategy 10
This example is based on a production plan in which 100 pieces are planned for <reqdat1>, <reqdat2>, and
<reqdat3>.

Stage 1: Demand Management
In this scenario, planned independent requirements are created for the production plan.
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The system will find requirements type LSF because the strategy group has been set to 10 (see Table of
Planning Strategy Assignments). The requirements are passed onto MRP. The stock/requirements list
(Logistics → Production → MRP → Evaluations → Stock/reqmts list) for the above example would appear as
follows:

Date

MRP
Element

Received/
Required
Quantity

Available
Quantity

<today>

Stock

<reqdat1>

IndReq

LSF

100 -

100 -

<reqdat2>

IndReq

LSF

100 -

200 -

<reqdat3>

IndReq

LSF

100 -

300 -

0

Stage 2: Procurement Before Sales
Procurement requisitions are created in the MRP run (Logistics → Production → MRP → Total planning). The
stock/requirements list for the above example would then appear as follows:
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Date

MRP
Element

Received/
Required
Quantity

Available
Quantity

<today>

Stock

<reqdat1>

PlOrd.

1234/Stck

100

100

<reqdat1>

IndReq

LSF

100 -

0

<reqdat2>

PlOrd.

1235/Stck

100

100

<reqdat2>

IndReq

LSF

100 -

0

<reqdat3>

PlOrd.

1236/Stck

100

100

<reqdat3>

IndReq

LSF

100 -

0

0

These procurement requisitions are the starting point for production or external procurement. In the R/3
System, various possibilities exist for handling the procurement process. One option would be to convert
the planned order into a production order and release the production order and a goods receipt of the
yield quantity. The other option would be to use returns or other goods movements for make-to-stock
production.
After goods receipt for the order, the stock/requirements list appears as follows:

Date

MRP
Element

Received/
Required
Quantity

Available
Quantity

<today>

Stock

<reqdat1>

IndReq

LSF

100 -

0

<reqdat2>

PlOrd.

1235/Stck

100 +

100

<reqdat2>

IndReq

LSF

100 -

0

<reqdat3>

PlOrd.

1236/Stck

100 +

100

<reqdat3>

IndReq

LSF

100 -

0

100

Stage 3: Sales Order
A sales order is created (Logistics → Sales and distribution → Sales → Order → Create).
Note the following:
•

You can confirm any quantity up to the stock quantity (100 pieces in this example) by choosing Edit →
Check availability.
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•

The system will find the requirements type KSL (choose Overview → Procurement in the sales order
menu) because the strategy group has been set to 10, and it is not possible to select another
requirements type. The table of planning strategy assignments shows this mechanism.

•

The system finds the schedule line category CP and the item category TAN because the item category
group was set to NORM.

After the sales order has been entered, the stock/requirements list appears as follows:

Date

MRP
Element

Received/
Required
Quantity

Available
Quantity

<today>

Stock

<today>

Order

327/010/01

90 -

<reqdat1>

IndReq

LSF

100 -

0

<reqdat2>

PlOrd.

1235/Stck

100 +

100

<reqdat2>

IndReq

LSF

100 -

0

<reqdat3>

PlOrd.

1236/Stck

100 +

100

<reqdat3>

IndReq

LSF

100 -

0

100

In Net Requirements Planning, according to strategy 10, the order does not create a requirement; the sales
order is displayed, but does not generate planned orders. In the table above, you can see that the order
does not reduce the Available Quantity in the right-hand column, which remains at 100 pieces. When you
perform the availability check (in the sales order or in the stock/requirements list under List → Calculate
ATP quantity), however, only 10 pieces are available.
The planned quantity is still 100 pieces. The source of the requirement is the independent requirement
alone. The planned independent requirement was neither changed, nor was an allocation carried out.

Stage 4: Procurement After Sales
This stage does not apply to this strategy.

Stage 5: Goods Issue for Delivery and Reduction of Planned Independent Requirements
After goods issue for the delivery (Logistics → Sales and distribution → Shipping → Delivery → Create), the
stock/requirements list appears as follows:
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Date

MRP
Element

Received/
Required
Quantity

Available
Quantity

<today>

Stock

<reqdat1>

IndReq

LSF

10 -

0

<reqdat2>

PlOrd.

1235/Stck

100 +

100

<reqdat2>

IndReq

LSF

100 -

0

<reqdat3>

PlOrd.

1236/Stck

100 +

100

<reqdat3>

IndReq

LSF

100 -

0

10

The planned independent requirement is reduced during processing of the goods issue. Old quantities can
still be retrieved by choosing either Goto → Schedule line history in Demand Management, or by using the
total requirements list (choose Evaluations → Display total requirements from the Demand Management
menu). The quantities issued are displayed in the Withdrwl qty field, as seen in the following picture.

The system always reduces the oldest planned independent requirements unless the consumption fields
(Consumption mode, Fwd consumption per., Bwd consumption per.) are maintained in the material master or in
the MRP group.

Comparing Strategies 10 and 40
Net Requirements Planning (10) and Planning with Final Assembly (40) are similar in certain areas. The
following graphic applies to both strategies:
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Consumption

1

3
Sales
Sales order
order

3

1

Warehouse stock
Finished product

Independent
Independent
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requirements

2

5
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Production
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However, the following differences exist between the two strategies:

Strategy

10

40

Customer requirements passed No
onto production

Yes

This means . . .

. . . sales orders do not
influence production

. . . sales orders that exceed
planned independent
requirements can influence
production

. . . the main objective is
to ensure smooth
production

. . . the most important
factor here is the ability to
react flexibly to customer
demand

No

Yes

Planned independent
requirements allocated during
sales order processing

Yes
Planned independent
requirements reduced at goods
issue for delivery
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Yes, physical reduction
takes place
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Combining Strategies 10 and 30
Prerequisites
Creating a new strategy group that combines the Net Requirements Planning (10) and Production by Lot Size
(30) is useful only if you can make use of lot size optimization and simultaneously satisfy large and small
demand levels.
Sales order
(KL)

Stock requirement
(LSF)

3

1
2,4

R
e
d
u
c
t
i
o
n

R
e
d
u
c
t
i
o
n

MRP and
Production

Warehouse stock
Finished product

3
Delivery

Sale from stock (KSL)
or internal demand

5

Setup Procedure
To set up this strategy:
1. Combine strategy 10 with strategy
30 in the IMG for Demand
Management under Production →
Master Planning → Demand
Management → Planned Independent
Requirements → Planning Strategy
→ Define strategy group.
2. Make the planning strategy you
use most often in your sales orders
your Main planning strategy.
3. Maintain a material master with
this new strategy group.

Result
You can now sell this material by changing the requirements type by choosing Overview → Procurement
menu in the sales order menu.
•

If you maintain requirements type KL in the sales order, the process flow will be the same as for
Production by Lot Size (30).
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•

If you maintain requirements type KSL in the sales order, the process flow will be the same as for Net
Requirements Planning (10).

Gross Requirements Planning (11)
Purpose
The make-to-stock strategy Gross Requirements Planning is particularly useful in mass production
environments and is often combined with repetitive manufacturing. This strategy is particularly useful if
you need to produce, regardless of whether you have stock. This strategy is useful for steel or cement
because they cannot shut down production. A blast furnace or a cement factory must continue to produce,
even if this means producing stock.
This strategy is also frequently used if there is a material requirements planning system in a legacy system
that needs to be linked to R/3, which serves as a production execution system. The legacy system
calculates a specific production plan, which has to be executed, regardless of the stock situation in R/3.

Examples from Industry
This strategy is often used in heavy-duty industries such as steel manufacturing (blast furnace) and the
cement industry. It is also used to interface non-SAP MRP systems.

Prerequisites
Maintain the following master data for the finished product:
•

Strategy group 11 on the MRP screen

•

Set the Mixed MRP indicator to 2 on the MRP screen

•

Item category group (for example, NORM) on the Sales Organization screen

•

The Availability check field so that you perform an availability check without the replenishment lead
time (checking group 02 in the standard system).
For more details, see the Other Areas section in Production by Lot Size (30).

Process Flow
This planning strategy is to some extent similar to Net Requirements Planning (10). However, the following
differences exist:
•

There is no netting of stock with demand; only the planned quantities are produced.

•

Production is only determined by planned independent requirements, which lends itself to production
smoothing.

•

Reduction of planned independent requirements during goods receipt for an order (planned order in
repetitive manufacturing, production order, process order, or purchase order)
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Strategy

10

11

Stock is taken into account

Yes

No

Reduction of planned
independent requirements
takes place during . . .

. . . goods issue for the
delivery

. . . goods receipt for a
production order (discrete
production), for a planned
order (repetitive
manufacturing), or for a
purchase order (trading
goods).

Gross Requirements Planning also has the following features in common with Net Requirements Planning
(10):
•

Production quantities can be planned relatively effectively by means of planned independent
requirements.
You can use information from the Sales Information System, flexible planning, or other planning tools
to plan production quantities. Therefore, production and procurement of the required components is
triggered before the sales order stage.

•

Individual sales orders, which can be somewhat irregular, do not affect production.

•

An accurate availability check is performed according to ATP logic during sales order processing.

•

Using lot size or rounding keys, you can perform a lot size optimization during planning so that you
always plan convenient lot sizes in Demand Management or during the MRP run.

Other Areas
Availability Check
You need to work with an availability check that functions without checking the replenishment lead time.
For more details, see the Other Areas section in Production by Lot Size (30) and Net Requirements Planning
(10).

Sample Scenario: Strategy 11
This example is based on a production plan in which 100 pieces are each planned for <reqdat1>, <reqdat2>,
and <reqdat3>

Stage 1: Demand Management
In this scenario, planned independent requirements are created as follows for the production plan.
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The system will find requirements type BSF because the strategy group has been set to 11. The
requirements are passed onto MRP.
The stock/requirements list (Logistics → Production → MRP → Evaluations → Stock/reqmts list) for this
example would appear as follows:

Date

MRP
Element

<today>

Stock

<today>

Received/
Required
Quantity

Available
Quantity
0

→Gross reqmts. Plan

<reqdat1>

IndReq

BSF

100 -

100 -

<reqdat2>

IndReq

BSF

100 -

200 -

<reqdat3>

IndReq

BSF

100 -

300 -

Entry of the independent requirements is very similar to that in strategy 10 (net requirements planning),
the only difference being that the requirements have requirements type BSF, because the strategy group
has been set to 11. See the table of planning strategy assignments.

There is now a special segment in the stock/requirements list, used only for planning
purposes.
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Stage 2: Procurement Before Sales
Procurement requisitions are created in the MRP run (Logistics → Production → MRP → Total planning). The
stock/requirements list for the above example would then appear as follows:

Date

MRP
Element

Received/
Required
Quantity

Available
Quantity

<today>

Stock

<today>

→ Gross reqmts plan

<reqdat1>

PlOrd.

0001234/Stck

100

100

<reqdat1>

IndReq

BSF

100 -

0

<reqdat2>

PlOrd.

0001235/Stck

100

100

<reqdat2>

IndReq

BSF

100 -

0

<reqdat3>

PlOrd.

0001236/Stck

100

100

<reqdat3>

IndReq

BSF

100 -

0

0

These procurement requisitions are the starting point for production or external procurement. In the R/3
System, various possibilities exist to handle the procurement process. One option would be to convert the
planned order into a production order and release the production order and a goods receipt of the yield
quantity. Another option would be to use returns or other goods movements for make-to-stock production.
After goods receipt of 90 pieces of the order (you can work with all kinds of orders, such as production
orders, a run of schedule headers in repetitive manufacturing, and purchase orders), the
stock/requirements list appears as follows:

Date

MRP
Element

<today>

Stock

<today>

→Gross reqmts plan

<reqdat1>

PrdOrd.

1000060/PP01/PD

10

10

<reqdat1>

IndReq

BSF

10 -

0

<reqdat2>

PlOrd.

0001235/Stck

100

100

<reqdat2>

IndReq

BSF

100 -

0

<reqdat3>

PlOrd.

0001236/Stck

100

100

<reqdat3>

IndReq

BSF

100 -

0

2–30

Received/
Required
Quantity

Available
Quantity
90
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And the Demand Management screen appears as follows:

The demand quantity, as seen in the planned independent requirements, is reduced when the goods
receipt is posted for the production order. The original demand quantity in Demand Management
(Logistics → Production → Master Planning → Demand Management → Planned Ind. Reqmnts → Display) can be
seen by choosing Goto → schedule line history, or by choosing Environment → Display total reqmnts. (In this
view, the total demand is the sum of the goods movement quantity plus the total quantity).
The system always reduces the oldest planned independent requirements unless the consumption fields
(Consumption mode, Fwd consumption per., Bwd consumption per.) are maintained in the material master or in
the MRP group.

Stage 3: Sales Order
To create a sales order, choose Logistics → Sales and distribution → Sales → Order → Create. You may confirm
any quantity up to the stock quantity (90 pieces in this example) by choosing Goto → Item → Schedule lines
→ Quantities/dates. The system will find the requirements type KSL (choose Overview → Procurement in the
sales order menu) because the strategy group has been set to 11. The system finds the schedule line
category CP and the item category TAN because the item category group was set to NORM.
After the sales order has been entered, the stock/requirements list appears as follows:
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Date

MRP
Element

Received/
Required
Quantity

Available
Quantity

<today>

Stock

<today>

Order

<today>

→Gross reqmts plan

<reqdat1>

PrdOrd.

1000060/pp01/PD

10

10

<reqdat1>

IndReq

BSF

10 -

0

<reqdat2>

PlOrd.

0001235/Stck

100

100

<reqdat2>

IndReq

BSF

100 -

0

<reqdat3>

PlOrd.

0001236/Stck

100

100

<reqdat3>

IndReq

BSF

100 -

0

90
0000337/0010/001

90 -

In strategy 11, the order does not create a requirement; it is only displayed. You can hide the display of the
orders as described in the Other Areas section of Net Requirements Planning (10). In the above table, you can
see that the order does not reduce the Available Quantity in the right-hand column, which remains at 90
pieces. When you perform the availability check (in the sales order or in the stock/requirements list under
List → Calculate ATP quantity), however, no stock is available.

Stage 4: Procurement After Sales
This stage does not apply to this strategy.

Stage 5: Goods Issue for Delivery
After delivery (Logistics → Sales and distribution → Shipping → Delivery → Create) and goods issue, the
stock/requirements list shows only the remaining planned independent requirements and their associated
planned orders

Planning Without Final Assembly and Without MTO (52)
Purpose
This strategy, along with Planning with a Planning Material and Without Make-to-Order (MTO) (63), allows
you to procure components based on planned independent requirements. Production of the finished
product, however, is based on actual sales orders, similar to make-to-order strategies. This planning
strategy ensures that you can react quickly to customer requirements, even if the finished product has a
long overall lead time. You can avoid the main value-added process until you have a customer. This
strategy is very similar to strategy 50, which uses make-to-order production. For more information on the
differences between these two strategies, see Planning Without Final Assembly (50) in chapter 4.
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Prerequisites
You need to maintain the following master data for the finished product:
•

Strategy group 52 on the MRP screen

•

Lot-size key EX must be set in the MRP screen because lot size optimization would be incompatible
with the allocation logic, which could result in over-planning and incorrect result in the ATP check.
You also need to ensure that no rounding profile or rounding values are taken into account.

•

Consumption parameters (Consumption mode, Bwd consumption, Fwd consumption) so that the
independent requirements can be found.

•

Item category group (for example, NORM) on the Sales Organization screen
A BOM is required for the finished product, and there are no major implications for the BOM
components. However, for the components it is important to set the:
•

MRP type to P* (or M*) on the MRP screen to plan the components in MRP.

•

Individual/coll. indicator to 2 on the MRP screen as a starting point for your master data
setup. See chapter 3 for more information

Process Flow
Consumption

3

Final
Assembly
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Sales
Sales Order
order
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1
Finished
Product
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Independent
Requirements
requirements

4
5
Warehouse Stock
Assembly 01

Reduction

Warehouse Stock
Assembly 02

2
Production
(Push)
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od(P
uc us
tioh)
n

For a detailed example of the entire process, see Sample Scenario: Strategy 52.
Production quantities can be planned relatively effectively with planned independent requirements for the
finished product. It is possible to use information from the sales forecast, the Sales Information System, or
other planning tools to plan production quantities. Only the procurement of the component is triggered
before the sales order stage. Final assembly takes place after a sales order has been entered.

Key Properties of Strategy 52
•

The planned independent requirements are consumed during the sales order stage. Therefore, you can
compare the planned independent requirements situation with the actual customer requirements.

© 1998 SAP Labs, Inc.

2–33

Strategies for Make-to-Stock Production
Planning Without Final Assembly and Without MTO (52)

•

An availability check is performed on the basis of the planned independent requirements.

•

Demand from sales orders is passed onto production and triggers production after the sales order
stage, even if insufficient components are planned. The sales orders, however, cannot be confirmed if
there is insufficient coverage of components. For more information, see Coping with Insufficient Coverage
of Components.

•

Planned independent requirement quantities for the finished products that are left unconsumed
increase the warehouse stock and cause procurement to decrease or not take place at all in the next
period. This procedure is known as “netting.”

•

Seen from a costing perspective, this strategy is a make-to-stock strategy, in contrast to strategy 50,
which is make-to-order. This means that stock of the finished material is not linked to each customer
order. As such, this strategy does not take stock that exceeds the planned independent requirements
(due to customer returns, over production, etc.) into account, when creating a sales order. Stock for
finished goods should be handled through an exception process.

Other Areas
Availability Check
In this strategy, there is only an availability check against planned independent requirements. A material is
considered available if a planned independent requirement can be consumed. Therefore, unplanned stock
(returns or unplanned production quantities such as over-deliveries) is not taken into account. The
Availability check indicator (MRP and Sales: General/Plant Data screens) is not relevant in this case because an
availability check according to ATP logic does not take place.

Stocking Level for Components
See Stockkeeping at Different BOM Levels in chapter 3.

Selling Unplanned Stock
Unplanned stock (returns or unplanned production quantities such as over-deliveries) is not taken into
account in the availability check, and is therefore not automatically considered for sales. You can ensure
that this stock is sold by changing the requirements type (from KSVS to KL or KSV, for example) in the
sales order menu under Procurement type.
You also need to have added an alternative strategy (either 30 or 40 in this case) to strategy group 52 in the
IMG for production (choose Master Planning → Demand Management → Planned Independent Requirements →
Planning Strategy → Define strategy group). It is also necessary to inform sales personnel of this unplanned
stock.

Sample Scenario: Strategy 52
This example is based on a production plan in which 100 pieces are planned for <reqdat1>, <reqdat2>, and
<reqdat3>. The BOM structure for this example has a parent material SZ-52 and a component ROH52A. The
BOM has an item quantity of 1.
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Stage 1: Demand Management
Planned independent requirements are created for the production plan. The system will find requirements
type VSE because the strategy group has been set to 52.
The requirements are passed onto MRP. The stock/requirements list (Logistics → Production → MRP →
Evaluations → Stock/reqmts list) for the finished product would appear as follows:

Date

MRP
Element

Received/
Required
Quantity

Available
Quantity

<today>

Stock

<today>

→ Planning without assembly

<reqdat1>

IndReq

VSE

100 -

100 -

<reqdat2>

IndReq

VSE

100 -

200 -

<reqdat3>

IndReq

VSE

100 -

300 -

0

Stage 2: Procurement Before Sales
Procurement requisitions are created in the MRP run (Logistics → Production → MRP → Total planning). The
stock/requirements list for the finished product would then appear as follows:

Date

MRP
Element

Received/
Required
Quantity

Available
Quantity

<today>

Stock

<today>

→ Planning without assembly

<reqdat1>

PlOrd.

1234/IndR

100

100

<reqdat1>

IndReq

VSE

100 -

0

<reqdat2>

PlOrd.

1235/IndR

100

100

<reqdat2>

IndReq

VSE

100 -

0

<reqdat3>

PlOrd.

1236/IndR

100

100

<reqdat3>

IndReq

VSE

100 -

0

0

These procurement requisitions are the starting point for production or external procurement. In the R/3
System, various possibilities exist for handling the procurement process. The following factors, however,
are important for this strategy:
•

Stock at finished product level is not taken into account for calculating the production plan.
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•

The planned orders are not yet “real” because production of the finished product must be executed
after receipt of the sales orders.
Technically speaking, the planned orders are independent requirements with order type VP. It is
impossible to convert these (VP) planned orders into production orders, or to use them in a repetitive
manufacturing environment. The Conversion field in the display of the planned order is not set, which
indicates that it is not possible to produce this planned order.

Conversion field
Order type

The MRP run also creates procurement requisitions for the components. In this example, the
stock/requirements list for the component ROH52A appears as follows (this example assumes that the
Individual/coll. Indicator was set to 2):
Date

MRP
Element

<today>

Stock

<reqdat1>

PlOrd.

1237/Stck

100

100

<reqdat1>

DepReq

SZ-52

100 -

0

<reqdat2>

PlOrd.

1238/Stck

100

100

<reqdat2>

DepReq

SZ-52

100 -

0

<reqdat3>

PlOrd.

1239/Stck

100

100

<reqdat3>

DepReq

SZ-52

100 -

0
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Due to Demand Management, the main objective of this strategy—procurement of components—has now
been triggered without sales orders. Procurement of the components can occur in a variety of ways. In this
case, we assume that a goods receipt (for a purchase order, for example) takes place.
The stock/requirements list for all components of the material then appears as follows:

Date

MRP
Element

Received/
Required
Quantity

Available
Quantity

<today>

Stock

<reqdat1>

DepReq

SZ-52

100 -

200

<reqdat2>

DepReq

SZ-52

100 -

100

<reqdat3>

DepReq

SZ-52

100 -

0

300

Stage 3: Sales Order and Allocation
A sales order for the parent material is created.
The system will find the requirements type KSVS because the strategy group has been set to 52 (see Table of
Planning Strategy Assignments). It is possible to confirm a quantity that has been previously planned (100
pieces for each schedule line in this example). Note the header text that says Preliminary Planning
Assignment indicates that this is not a check according to ATP logic but rather an availability check based
on planned independent requirements. The system finds the schedule line category CP and the item
category TAN because the item category group was set to NORM.
Suppose that for this example an order with a quantity of 90 pieces is entered with a required delivery date
of today. This order can be confirmed after the first planned independent requirement date <reqdat1> if the
consumption parameters have been defined accordingly and this date can be found. For more information,
see Consumption Strategies and Logic in chapter 1.
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After entry of the sales order, the stock/requirements list for the parent material appears as follows:

Date

MRP
Element

<today>

Stock

<today>

Order

<today>

→ Planning without
assembly

<reqdat1>

PlOrd.

1234/IndR

100

100

<reqdat1>

IndReq

VSE

10 -

90

<reqdat2>

PlOrd.

1235/IndR

100

190

<reqdat2>

IndReq

VSE

100 -

90

<reqdat3>

PlOrd.

1236/IndR

100

190

<reqdat3>

IndReq

VSE

100 -

90
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Stage 4: Procurement After Sales
After a second planning run, the stock/requirements list of the parent material appears as follows:

Date

MRP
Element

Received/
Required
Quantity

Available
Quantity

<today>

Stock

<today>

Order

000333/0010/ 90001

90-

<t+rlt>

PlOrd.

1237/Stck

90

0

<today>

→ Planning without
assembly

<reqdat1>

PlOrd.

1234/IndR

10

10

<reqdat1>

IndReq

VSE

10 -

0

<reqdat2>

PlOrd.

1235/IndR

100

100

<reqdat2>

IndReq

VSE

100 -

0

<reqdat3>

PlOrd.

1236/IndR

100

100

<reqdat3>

IndReq

VSE

100 -

0

0

The planned order (Stck) for the parent material can now be converted to either a production order, a
process order, or allow backflushing in the repetitive manufacturing process. This conversion triggers the
production after sales order stage. Production of this material can be performed quickly because the necessary
components are already available. After creating and releasing the production order (for the parent
product) the stock/requirements situation remains the same. This process means that the planned order is
replaced by a production order.
Working with production orders is only one option for production. This process is also possible in
repetitive manufacturing. At component level (ROH52x), the dependent requirements (DepReq in the
planned order) are replaced by an order reservation (OrdRes in a production order). Perform a goods
receipt for the “parent” material, after production. Note the increase in available stock in the stock
requirements list of the parent material.

Stage 5: Goods Issue for Delivery and Reduction of Planned Independent Requirements
After goods issue for the delivery (Logistics → Sales and distribution → Shipping → Delivery → Create) for the
parent material, the stock/requirements list of the parent material is reset to empty. In other words, it only
shows the remaining planned independent requirements and the corresponding planned orders. The
planned independent requirements are, of course, reduced.
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Planning with a Planning Material and Without MTO (63)
Purpose
This strategy:
•

Procures non-variable components based on the planned independent requirements of a planning
material.
Production of the finished product, however, is based on actual sales orders. This procedure guarantees
that you can quickly react to customer requirements, even if the finished product has a long overall
lead time, and avoid the main value-added process until you have a customer.

•

Has the same basic features as Planning Without Final Assembly and Without MTO (52). In addition, more
than one material can consume the planned independent requirements of one planning material.

•

Lends itself to the planning of variants of one product.
(The term variant, here, indicates similar products, not variant configuration.) For example, imagine
similar parts sharing a BOM group (which is not necessary in this strategy) so that you can easily
exchange a component in all similar BOMs. You usually have up to several dozen variants whereas
variance would be much higher in variant configuration.

Examples from Industry
This strategy lends itself to the planning of different sizes or packages for one product. For instance, you
may want to sell a product in packages:
•

Containing 1 liter, 2 liters, and 1 gallon

•

Labeled in English, German, and Japanese

All variants are set up as different material numbers. Also, a planning material that consists of only nonvariant components, which means excluding the packaging materials that form the variants is usually set
up. All variants are linked to the planning material with the correct conversion factors. The packaging
materials (boxes or cartons for the different sizes or different labels) can be planned based on consumption,
because they are not too expensive.

Prerequisites
You need to maintain the following master data for the products:
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Master Data Field

“Variant” products

Planning material

Strategy group

63

63

Such as NORM

Sales organization screens
are not required

EX

EX

Not to be maintained, the
values of the planning
material are used.

Need to be maintained so
that the planned
independent requirements
can be found.

(MRP screen)
Item category group
(Sales organization screen)
Lot size key
(MRP screen)
Consumption parameters
(Consumption mode,
Bwd consumption per., Fwd
Consumption per.)
(MRP screen)
Planning material, Planning
plant and Plng conv. Factor

Need to be maintained.

(MRP screen)
Bill of material

Required

Required

Contains all parts

Contains the non-variable
parts

Although there are no major implications for the BOM components, you should set the:
•

MRP type of the components (on the MRP Screen) to P* or M* to plan the component in
MRP

•

Individual//coll. indicator (on the MRP Screen) to 2
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For a detailed example of the entire process, see Sample Scenario: Strategy 63.

Key Properties of Strategy 63
The planning material could be sold in the same way as any variant product. However, it is generally used
as an “artificial” material that only contains the non-variant parts. The BOMs of the variant products
contain additional components that diversify the product. These variant components cannot be planned
exactly using this strategy.
Instead you need to handle the variant components in the following manner:
•

The variant components are consumption-based.

•

The variant components are planned independently using a planning strategy for components.

•

An over-planning or an under-planning of the variant components is accepted.

If your products have a high level of variance, you may want to use characteristics planning to automate
the planning of components. See Characteristics Planning (for strategies 56 and 89) in chapter 5 for more
information. This strategy can also be used as a cross-plant version of strategy 52 (see Cross-Plant Planning
in chapter 1 for more information).

Other Areas
The Other Areas section of Planning Without Final Assembly and Without MTO (52) also applies to this
strategy.

Capacity Planning Using Strategy 63
This strategy is often used to manage a simple but effective method of capacity planning. The planned
independent requirements for the planning material represent a given capacity situation. All variant
materials require a similar capacity and there is an allocation of given capacity with requested capacity at
the order entry stage. Using the total requirements list, you can easily check the capacity situation.
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Overplanning and Underplanning of Components
Imagine that the planning material contains the components A, B, and D. The variant material contains the
components A, B, and C. The planning material is planned with 100 pieces each month. There are,
therefore, dependent requirements for 100 components each month. Because the planning material is a
representation of all variants, too much is planned for component D and too little is planned for
component C. If you want to over-plan component D on purpose, to have a higher stock level for it, for
instance, this situation is not a problem.
In most cases, however, you would avoid this situation by using other means, such as excluding
components C or D in the BOM of the planning material. The variant parts could be planned using
Planning at Assembly Level (70), or by simply using consumption-based variant parts.

Sample Scenario: Strategy 63
This example is based on a production plan in which 100 pieces are planned for <reqdat1>, <reqdat2>, and
<reqdat3>.

Stage 1: Demand Management
Planned independent requirements are created for the production plan. The material number of the
planning material is entered and the requirements that are expected to be the total for all variants are
created. The system will find requirements type VSEV because the strategy group has been set to 63.
The requirements are passed onto MRP. The stock/requirements list for the planning material (Logistics →
Production → MRP → Evaluations → Stock/reqmts list) for the above example appears as follows:

Date

MRP
Element

Received/
Required
Quantity

Available
Quantity

<today>

Stock

<today>

→ Planning without assembly

<reqdat1>

IndReq

VSEV

100 -

100 -

<reqdat2>

IndReq

VSEV

100 -

200 -

<reqdat3>

IndReq

VSEV

100 -

300 -

0

Stage 2: Procurement Before Sales
Procurement requisitions are created in the MRP run (Logistics → Production → MRP → Total planning). The
stock/requirements list of the planning material appears as follows:
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Date

MRP
Element

Received/
Required
Quantity

Available
Quantity

<today>

Stock

<today>

→ Planning without assembly

<reqdat1>

PlOrd.

1234/IndR

100

100

<reqdat1>

IndReq

VSEV

100 -

0

<reqdat2>

PlOrd.

1235/IndR

100

100

<reqdat2>

IndReq

VSEV

100 -

0

<reqdat3>

PlOrd.

1236/IndR

100

100

<reqdat3>

IndReq

VSEV

100 -

0

0

These procurement requisitions are the starting point for production or external procurement. Various
possibilities exist for handling the actual production process. The following factors, however, are
important for this strategy:
•

Stock of the planning material is not taken into account to calculate the production plan.

•

The planned orders are not yet real, because the variant product cannot be produced until after receipt
of the sales order.
Technically speaking, the planned orders have order type VP. It is impossible to convert these VP
planned orders into production orders, or to use them in a repetitive manufacturing environment. The
Conversion field in the display of the planned order is not set. Therefore, it is not possible to produce
this planned order.

The MRP run also creates procurement requisitions for the components of the planning material. The
stock/requirements list for the component, for example, is as follows:

Date

MRP
Element

<today>

Stock

<reqdat1>

PlOrd.

1237/Stck

100

100

<reqdat1>

DepReq

PLANNINGMATL

100 -

0

<reqdat2>

PlOrd.

1238/Stck

100

100

<reqdat2>

DepReq

PLANNINGMATL

100 -

0

<reqdat3>

PlOrd.

1239/Stck

100

100

<reqdat3>

DepReq

PLANNINGMATL

100 -

0
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The main objective of this strategy has now been reached; procurement for the components has been
triggered, based on the sales forecast from Demand Management, without sales orders. Procurement of the
components can occur in a variety of ways. In this case, we assume that a goods receipt (for a purchase
order, for example) takes place. The stock/requirements list for all components of the planning material
then appears as follows:

Date

MRP
Element

Received/
Required
Quantity

Available
Quantity

<today>

Stock

<reqdat1>

DepReq

PLANNINGMATL

100 -

200

<reqdat2>

DepReq

PLANNINGMATL

100 -

100

<reqdat3>

DepReq

PLANNINGMATL

100 -

0

300

Stage 3: Sales Order and Allocation
After a sales order for a variant material is entered.
•

The system will find the requirements type KSVV because the strategy group is set to 63.
See the Table of Planning Strategy Assignments in chapter 1.

•

You can confirm a quantity that has been previously planned (100 pieces in this example). Note the
header text that says Preliminary Planning Assignment, indicating that this is not a check according to
ATP logic but rather an availability check based on planned independent requirements.

•

The system finds the schedule line category CP and the item category TAN because the item category
group was set to NORM.

Suppose that for this example an order with a quantity of 90 pieces is entered with a required delivery date
of today. This order can be confirmed after the first planned independent requirement date <reqdat1>, if
the consumption parameters have been maintained correctly (Consumption mode, Bwd consumption per., Fwd
consumption per.) in the planning material and this date and the planned independent requirements can be
found. For more information, see Consumption Strategies and Logic in chapter 1.
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Variant

After the sales order has been entered, the stock/requirements list of the variant material appears as
follows:

Date

MRP
Element

<today>

Stock

<orderdat1>

Order

2–46
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The stock/requirements list for the planning material changes as follows because an allocation has taken
place:
Date

MRP
Element

Received/
Required
Quantity

Available
Quantity

<today>

Stock

<today>

→ Planning without assembly

<reqdat1>

PlOrd.

1234/IndR

100

100

<reqdat1>

IndReq

VSEV

10 -

90

<reqdat2>

PlOrd.

1235/IndR

100

190

<reqdat2>

IndReq

VSEV

100 -

90

<reqdat3>

PlOrd.

1236/IndR

100

190

<reqdat3>

IndReq

VSEV

100 -

90

0

At component level, the requirement from the planning material has been switched to a requirement from
the variant material. The sum of the requirements stays the same.
Date

MRP
Element

Received/
Required
Quantity

Available
Quantity

<today>

Stock

<orderdat1>

DepReq

VARIANT

90 -

210

<reqdat1>

DepReq

PLANNINGMATL

10 -

200

<reqdat2>

DepReq

PLANNINGMATL

100 -

100

<reqdat3>

DepReq

PLANNINGMATL

100 -

0

300

Stage 4: Procurement After Sales
After a second planning run, the stock/requirements list of the variant is as follows:

Date

MRP
Element

<today>

Stock

<orderdat1>

PlOrd.

000335/Stck

90

90

<orderdat1>

Order

00035/0010/001

90 -

0
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The planned order (Stck) for the parent material can now be converted to either a production order, a
process order, or allow backflushing in the repetitive manufacturing process. This triggers the production
after sales order stage. Production of this material can now be executed quickly because all the necessary
components are already available.
After creation and release of the production order (for the variant product) the stock/requirements
situation remains the same. Essentially, the planned order is replaced by a production order. Working with
production orders is only one option for production. This process is also possible in the area of repetitive
manufacturing. At component level, the dependent requirements (DepReq in the planned order) are
replaced by an order reservation (OrdRes in a production order).

Stage 5: Goods Issue for Delivery and Reduction of Planned Independent Requirements
After goods issue for the delivery (Logistics → Sales and distribution → Shipping → Delivery → Create) for the
variant material, the stock/requirements list of the planning material is reset back to empty. The planned
independent requirements are, of course, reduced.
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Overview
The planning strategies explained in this section are designed to plan the procurement (production or
purchasing) of components by planning the components. These strategies are particularly useful if:
•

There is a variety of finished products (possibly with an irregular demand pattern where planning is
not possible).

•

The finished products are consumption-based.

•

The planning of components also lends itself to separate organizational departments. Component
planning in one department is not influenced by the planning of the finished product in another
department.

The purpose of planning at component level is to procure components to stock (without sales orders) and
quickly react to customer demand.

Prerequisites
Choose a strategy for planning components if:
•

The components are not segregated (that is, they are not uniquely linked at specific orders).

•

Costs should be tracked at component (material) level and not at order level.

Process Flow

Strategies for planning components can be used for both make-to-stock and make-to-order scenarios. To
use a strategy for a make-to-stock planning of components in a make-to-order environment, you should
consider setting the Individual/coll. indicator (on the MRP screen) to 2 as a starting point for your master
data setup.
The planning of components has the following in common with make-to-stock strategies:
•

3–2

You can automate the planning stage by using information from the forecast, and pass on the results
from these applications directly to Demand Management.
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•

Make-to-stock costing applies.

•

Smoothing of production against customer requirements may be an important aspect.

•

Strategies for planning components are usually combined with a lot-size key different from EX or with
rounding values. In the following Sample Scenario sections, however, lot-size key EX is used for the sake
of simplicity.

In Planning at Assembly Level (70), no specific product structure of the component is required. In other
words, it does not matter whether the component has a BOM. The material can be produced in-house or
procured externally (for example, raw materials). Planning at Phantom Assembly Level (59) requires a special
product structure.
For information on special issues concerning procuring components using strategies 50, 52, 60, 63, and all
make-to-order strategies, see Stockkeeping at Different BOM Levels later this chapter. For information on how
the replenishment lead time is interpreted, see Replenishment Lead Time at the end of this chapter.

Planning at Assembly Level (70)
Purpose
If a more reliable forecast can be produced for certain assemblies than for the multitude of product
variants, this planning strategy is particularly useful for manufacturers of products with variants.

Prerequisites
To maintain the master data of the assembly:
1. Open strategy group 70 on the MRP screen.
2. On the MRP screen, enter 1 for assembly planning (the Mixed MRP indicator).
3. Set consumption parameters (Consumption mode, Bwd consumption, Fwd consumption, on the MRP screen)
to allow for consumption of planned independent requirements.
If you use this strategy in a make-to-stock environment, you also need to enter 2 for the Individual/coll.
indicator on the MRP screen.
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For a detailed example of the entire process, see the next section, Sample Scenario: Strategy 70.
This strategy is very similar to Planning with Final Assembly (40) in chapter 2, the difference being, however,
that planned independent requirements are allocated to consumption of production orders (or schedule
lines in repetitive manufacturing) and not to consumption of sales orders. The material to be planned is a
component in a larger structure, often referred to as an assembly or subassembly. Although all graphics in
this documentation show this component-one level below the finished product, it can be on any BOM
level.

Key Properties of Strategy 70
The following information should be considered:
•

Stock for the assembly usually exists.

•

Planned independent requirements are entered at assembly level.
Procurement (planned by means of the planned independent requirements) is therefore triggered
before the production order stage (or schedule line in repetitive manufacturing).

•

The planned orders for the assembly/components are convertible.

•

You can smooth procurement according to order demand.
In this strategy, however, the ability to react flexibly to requirements is more important.

•

An accurate availability check is performed according to ATP logic during order processing.

•

Requirements from production orders (or planned orders) are passed onto production and can lead to
changes being made to procurement after the sales order stage, if the order quantities exceed the
planned independent requirement quantities.

3–4
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However, order quantities cannot be confirmed if there is insufficient coverage of components.
Therefore, the system automatically adjusts the master plan. For more information, see Coping with
Insufficient Coverage of Components in chapter 2.
•

The planned independent requirements are consumed during the production stage.
This step means that you can compare the planned independent requirements situation with the actual
order requirements.

•

The unconsumed planned independent requirement quantities increase the warehouse stock of the
component, and cause procurement to decrease or not take place at all in the next period (this
procedure is called netting).

Sample Scenario: Strategy 70
This example is based on a production plan in which 100 pieces are planned for <reqdat1>, <reqdat2>, and
<reqdat3>.

Stage 1: Demand Management
In this scenario, planned independent requirements are created as follows for the production plan.

The system will find requirements type VSFB because the strategy group has been set to 70. See the table of
planning strategy assignments in chapter 1. The requirements are passed onto MRP. The
stock/requirements list (Logistics → Production → MRP → Evaluations → Stock/reqmts list) for the above
example appear as follows:

© 1998 SAP Labs, Inc.
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Date

MRP
Element

Received/
Required
Quantity

Available
Quantity

<today>

Stock

<reqdat1>

IndReq

VSFB

100 -

100 -

<reqdat2>

IndReq

VSFB

100 -

200 -

<reqdat3>

IndReq

VSFB

100 -

300 -

0

Stage 2: Procurement Before Use in Production
A procurement requisition is created in the MRP run (Logistics → Production → MRP → Total planning). The
stock/requirements list for this example would then appear as follows:

Date

MRP
Element

Received/
Required
Quantity

Available
Quantity

<today>

Stock

<reqdat1>

PlOrd.

123/Stck

100

100

<reqdat1>

IndReq

VSFB

100 -

0

<reqdat2>

PlOrd.

124/Stck

100

100

<reqdat2>

IndReq

VSFB

100 -

0

<reqdat3>

PlOrd.

125/Stck

100

100

<reqdat3>

IndReq

VSFB

100 -

0

0

This procurement requisition is the starting point for production or external procurement. You have a
variety of options to handle the procurement process in the R/3 System. One possibility would be to
convert the planned order into a production order, releasing the production order and a goods receipt of
the yield quantity. Another possibility is to use returns or other goods movements for make-to-stock
production.
After goods receipt for the order, the stock/requirements list is as follows:
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Date

MRP
Element

Received/
Required
Quantity

Available
Quantity

<today>

Stock

<reqdat1>

IndReq

VSFB

100 -

100

<reqdat2>

IndReq

VSFB

100 -

0

<reqdat3>

PlOrd.

125/Stck

100

100

<reqdat3>

IndReq

VSFB

100 -

0

200

Stage 3: Production Order and Allocation
A production order that uses the planned component is created (Logistics → Production → Production control
→ Order → Create). Note that two different things happen, an availability check and allocation.
An availability check is performed by choosing Component → Availability → Check availability.
For example, let us assume that
production is 50 pieces of the material
and the material has an in-house
production time of zero. A popup
window appears containing the
information displayed to the right.

The availability check is always performed according to ATP logic. This logic is determined by the
checking rule (maintained for PP in the IMG in Production → Production Orders → Operations → Availability
check → Define checking rule), and the checking group (maintained in the material master and defined in
IMG under Production → Production Orders → Operations → Availability check → Define checking group).
By comparison, in sales and distribution, the checking rule cannot be defined by
configuration. If the sales and distribution logic is make-to-stock, then the checking rule will
have the value A. If the logic is make-to-order, then the checking rule will have the value AE.
The checking rule and checking group comprise the scope of the check (maintained in the IMG under
Production → Production Orders → Operations → Availability check → Define scope of check).
The scope of the check defines:
•

Which MRP elements, such as purchase orders and reservations, the system includes in the availability
check.
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•

Whether the check includes only the replenishment lead time or the end of the planning horizon.

In addition, the checking control (maintained in the IMG under Production → Production Orders →
Operations → Availability check → Define checking control). During order creation (or release), when check
availability can be performed, checking control defines a plant and production order type combination.
In terms of allocation, the planned quantity—which is not visible in the production order—is allocated to
the component quantity. You can, however, control the allocation in the stock/requirements list or in the
total requirements list.
The screenshot to the right shows
the total requirements list.

After creating the production order, the stock/requirements list is as follows:
Date

MRP
Element

Received/
Required
Quantity

Available
Quantity

<today>

Stock

<today>

OrdRes

SZ-10

50 -

150

<reqdat1>

IndReq

VSFB

50 -

100

<reqdat2>

IndReq

VSFB

100 -

0

<reqdat3>

PlOrd.

125/Stck

100

100

<reqdat3>

IndReq

VSFB

100 -

0

200

Any parent material that consists of this component is automatically allocated to this plan. In practice,
there are several header materials (like SZ-10 in this example) that allocate this material.

Stage 4: Procurement After Production
This stage does not apply to this strategy.
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Stage 5: Goods Issue for Production Order
After goods issue for the production order (Logistics → Materials management → Inventory management →
Goods movement → Goods issue), the stock/requirements list appears as follows:
Date

MRP
Element

Received/
Required
Quantity

Available
Quantity

<today>

Stock

< reqdat1>

IndReq

VSFB

50 -

100

<reqdat2>

IndReq

VSFB

100 -

0

<reqdat3>

PlOrd.

125/Stck

100

100

<reqdat3>

IndReq

VSFB

100 -

0

150

Planning at Phantom Assembly Level (59)
Purpose
This strategy can be used for a set of components that:
•

Are always assembled together in various finished products

•

Are planned together

•

Do not make up an assembly (they constitute a phantom assembly)

Prerequisites
You need to maintain the master data of the phantom assembly in the following way:
•

Enter 59 for strategy group on the MRP screen.

•

For assembly planning and the Mixed MRP indicator, enter 1 on the MRP screen.

•

Consumption parameters (Consumption mode, Bwd consumption, Fwd consumption, on the MRP screen) to
allow for consumption of planned independent requirements.

•

Enter 50 in the Special procurement field on the MRP screen (phantom assembly)

•

Enter 2 for the Individual/coll. indicator on the MRP screen.

To maintain the master data of the components in the phantom assembly, enter 1 in the Backflush field (2
may also be possible) on the MRP screen. Backflushing is essential because the components are planned
with only one planned independent requirement and not with individual planned independent
requirements. Subsequently the strategy can only work correctly if all reservations are simultaneously
reduced. This procedure is only possible when the goods issue for the components is posted at a later
stage, as in backflushing. In addition, all components of the phantom structure have to be linked to the
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same operation. BOMs must be maintained for the finished product(s) and for the phantom assembly.
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For a detailed example of the entire process, see the next section Sample Scenario: Strategy 59.

Key Properties of Strategy 59
This strategy is similar to Planning at Assembly Level (70), as you can see below:
•

Component requirements can be planned relatively effectively.
Procurement (planned by means of planned independent requirements) is triggered before the
production order stage.

•

You can smooth procurement based on order demand.
In this strategy, however, the ability to react flexibly to customer requirements is more important.

•

An accurate availability check is performed according to ATP logic during production order
processing.
An availability check at component level is possible in the production order.

•

If the order quantities exceed the planned independent requirement quantities, requirements from
production orders (or schedule lines) are passed onto production and can lead to changes being made
to procurement after the sales order stage.

•

The planned independent requirements are consumed during the production stage.
You can compare the planned independent requirements situation with the actual order requirements.

Due to its “phantom” nature, in contrast to strategy 70, stock does not exist for the assembly in strategy 59.

3–10
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Sample Scenario: Strategy 59
This example is based on a production plan in which 100 pieces are planned for <reqdat1>, <reqdat2>, and
<reqdat3>.

Stage 1: Demand Management
Planned independent requirements are created for the production plan. The system will find requirements
type VSEB because the strategy group has been set to 59 (see the Table of planning strategy assignments in
chapter 1).
The requirement is passed onto MRP. The stock/requirements list (Logistics → Production → MRP →
Evaluations → Stock/reqmts list) for the phantom appears as follows:

Date

MRP
Element

Received/
Required
Quantity

Available
Quantity

<today>

Stock

<today>

→ Planning without assembly

<reqdat1>

IndReq

VSEB

100 -

100 -

<reqdat2>

IndReq

VSEB

100 -

200 -

<reqdat3>

IndReq

VSEB

100 -

300 -

0

Stage 2: Procurement Before Use in Production
Procurement requisitions are created in the MRP run (Logistics → Production → MRP → Total planning). The
stock/requirements list for the phantom would then appear as follows:

Date

MRP
Element

<today>

Stock

<today>

→ Planning without assembly

<reqdat1>

PlOrd.

1234/IndR

100

100

<reqdat1>

IndReq

VSEB

100 -

0

<reqdat2>

PlOrd.

1235/IndR

100

100

<reqdat2>

IndReq

VSEB

100 -

0

<reqdat3>

PlOrd.

1236/IndR

100

100

<reqdat3>

IndReq

VSEB

100 -

0
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This procurement requisition is the starting point for production or external procurement. You have a
variety of options to handle the procurement process. The following factors, however, are most important
in this strategy:
•

At phantom assembly level, stock is not taken into account.

•

The planned orders are not yet “real” because production of the finished product must be executed
after receipt of the sales orders.
Essentially, the planned orders are independent requirements with order type VP. It is impossible to
convert these (VP) planned orders into production orders, or to use them in a repetitive manufacturing
environment. The Conversion field in the display of the planned order is not set, which indicates that it
is not possible to produce this planned order.

•

The MRP run also creates procurement requisitions for the components of the phantom assembly (In
this example, SZ-59 is the phantom assembly).

The stock/requirements list for a component of the phantom assembly is as follows:
Date

MRP
Element

Received/
Required
Quantity

Available
Quantity

<today>

Stock

<reqdat1>

PlOrd.

1237/Stck

100

100

<reqdat1>

DepReq

SZ-59

100 -

0

<reqdat2>

PlOrd.

1238/Stck

100

100

<reqdat2>

DepReq

SZ-59

100 -

0

<reqdat3>

PlOrd.

1239/Stck

100

100

<reqdat3>

DepReq

SZ-59

100 -

0

0

Due to Demand Management, the main objective of this strategy—procurement for the components of the
phantom assembly—has now been reached. In this scenario, we now assume that a goods receipt (for a
purchase order, for example) takes place. The stock/requirements list for all components of the phantom
assembly then appears as follows:
Date

MRP
Element

<today>

Stock

<reqdat1>

DepReq

SZ-59

100 -

200

<reqdat2>

DepReq

SZ-59

100 -

100

<reqdat3>

DepReq

SZ-59

100

0
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Stage 3: Production Order and Allocation
A sales order is created for a finished product whose BOM contains the phantom assembly (50 each in the
following example). The requirements type of the finished product does not matter here. More
importantly, a planned order for the finished product is created which includes (at least) the phantom
assembly and the components of the phantom assembly. The requirement from the production order
consumes the planned independent requirements immediately.
After a second MRP run, the stock/requirements list for the phantom assembly is as follows:
Date

MRP
Element

Received/
Required
Quantity

Available
Quantity

<today>

Stock

<today>

→ Planning w/o assembly

<reqdat1>

PlOrd.

1234/IndR

50

50

<reqdat1>

IndReq

VSEB

50 -

0

<reqdat2>

PlOrd.

1235/IndR

100

100

<reqdat2>

IndReq

VSEB

100 -

0

<reqdat3>

PlOrd.

1236/IndR

100

100

<reqdat3>

IndReq

VSEB

100 -

0

0

The independent requirements for the phantom assembly have been consumed, resulting in a reduction of
the planned independent requirements. A reservation was therefore created one level lower, shifting the
source of the requirement from the independent requirement (Dep Reg) to the dependent requirement
(Ord Res) of the sales order.
The stock/requirements list of the component of the phantom assembly is as follows:

Date

MRP
Element

<today>

Stock

<today>

OrdRes

SZ-59

50 -

250

<reqdat1>

DepReq

SZ-59

50 -

200

<reqdat2>

DepReq

SZ-59

100 -

100

<reqdat3>

DepReq

SZ-59

100 -

0
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Today’s dependent requirement was created by the planned order for the finished product [containing the
phantom assembly and the component(s) of the phantom assembly]. The other dependent requirements
were created by the independent requirements.
When a production order is created for the finished product (Logistics → Production → Production control →
Order → Create), an availability check can be performed for all components of the order (Component →
Availability → Check availability). For more information, see Stage 3 in Sample Scenario: Strategy 70. The
source of a requirement for a component of the phantom assembly shifts from the planned order to a
production order.

Stage 4: Procurement After Production
This stage does not apply for this strategy.

Stage 5: Goods Issue for Production Order
After goods issue for the production order (Logistics → Production → Prod. control → Confirmation →), the
stock/requirements list for the phantom assembly looks the same as in stage 3. The stock/requirements list
for the component(s) of the phantom assembly is as follows:
Date

MRP
Element

Received/
Required
Quantity

Available
Quantity

<today>

Stock

<reqdat1>

DepReq

SZ-59

50

200

<reqdat2>

DepReq

SZ-59

100 -

100

<reqdat3>

DepReq

SZ-59

100 -

0

250

It is vital that you use backflushing to when withdrawing the components. See the Prerequisites section in
Planning at Phantom Assembly Level (59) for more information.

Strategies for Multi-Use Materials
Definition
A multi-use material is a material, which can be used at the same time in the following areas:
•

Production

•

Sales orders

•

Other areas (such as requirements from cost centers)

3–14
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Use
Strategies for multi-use materials are most typically used for components sold as spare parts.
The objectives for including a multi-use material in your planning can be either one of the following:
•

Use one combined plan for all uses of the material. See the next section, Combining Sales Order and
Production Requirements, for more information.

•

Create one plan for use in production and a separate plan for use in sales orders. See Planning
Requirements Separately later this chapter.

Combining Sales Order and Production Requirements
This procedure involves one combined plan for use in production and sales orders (for spare parts, for
example). In the same manner as strategy 70 (Planning at Assembly Level), this procedure is particularly
efficient if the component is used in several finished products, or if:
•

Different planning strategies are used at the parent level.

•

The parent material(s) is/are planned-consumption based.

Requirements from
finished products
(e.g. 200 pieces)

Requirements from sales
orders (e.g. 50 pieces)

“Spare Part”
(new strategy
group)

Requirements from
cost centers

Requirements
RESE 200
CREQ 50
Total

© 1998 SAP Labs, Inc.

ONE combined plan in
Demand Mgmt for all
types of requirements

Planned
indep. reqmts
250+ VSFB

250
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Procedure
Create a new strategy in the IMG for
production (choose Master Planning →
Demand Management → Planned
Independent Requirements → Planning
Strategy → Define strategy), which
combines the requirements type for
independent requirements (VSFB),
and the requirements type for
customer requirements (KSV). This
new strategy combines the planning
side (KSV) of strategy 40 and the sales
order side (VSFB) of strategy 70.

Next, create a corresponding strategy
group in the IMG for production
(choose Master Planning → Demand
Management → Planned Independent
Requirements → Planning Strategy →
Define strategy group).

Maintain the following in the material master for the spare part:
1. Enter your new strategy group on the MRP screen
2. Enter 1 for Mixed MRP.
3. Set the consumption fields (Consumption mode, Fwd consumption per., Bwd consumption per.) to enable
consumption of the planned independent requirements.
4. Enter 2 for Individual/coll. if you are working in a make-to-order environment for the parent materials.

3–16
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Result
Using the Material as a Component

The process flow for use as a component is identical to the description in Planning at Assembly Level (70). In
addition, however, you can allocate customer requirements to the same planned independent
requirements. Make sure that the Consumption indicator (Planned independent requirements → Create/change →
Requirements parameters), is set to 3 (the default value for requirements type VSFB in the standard system).
This configuration enables consumption of sales orders and other requirements.
Using the Material in Sales Order Processing

The process flow is as follows:
•

Planned independent requirements are created for use in production and sales orders. The system
generates VSFB requirements, as described in Planning at Assembly Level (70).

•

The Procurement before sales order stage is carried out as normal.

•

During sales order processing, the system performs an availability check according to ATP logic and
finds requirements type KSV, as in Planning with Final Assembly (40).

•

There is no Procurement after sales stage.

•

Goods issue functions in the same way as for Planning with Final Assembly (40).

As seen in the report Display Total
Requirements (Logistics → Production →
Demand Management → Evaluations →
Display total reqmts) the VSFB
requirements are consumed by a
production order (element RESE in
the total requirements list) and a sales
order (customer requirements,
element CREQ).

Planning Requirements Separately
This procedure for a multi-use material involves creating separate requirements for a component used in
producing a finished product and for use in sales orders. In this case, the components (usually spare parts)
are sold with sales orders, but you can choose between the following two options for planning the multiuse material for production of a finished product. You can:
•

Use both a plan for the parent material and a separate plan for sales orders.

•

Plan the components independently of the parent material.

© 1998 SAP Labs, Inc.
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Planning with Requirements from the Parent Material
This procedure assumes that usable dependent requirements exist at the parent level. The parent
material(s) of the component can be easily planned, and you want to use the results of this planning. You
may apply any planning strategy for the parent materials. This procedure is typically employed if the
component is only used in a limited number of parent materials. Additionally, you want to plan demand
for “spare parts.”
Plan(s) for the
parent material(s)

Parent
Material(s)

Dependent requirements
according to the plan(s) for
parent material(s)

Demand from sales
orders (e.g. 50 PC)

One plan 1 ONLY
for the requirements
from sales orders

“Spare Part”
(strategy
group 40)
1

Customer
requirements
CREQ 50

Planning

1

The dependent requirements
do NOT consume the plan
for sales order demand

50+ VSF

The stock/requirements list contains two requirements elements:
•

Dependent requirements (Dep Req) from the parent material(s)
The dependent requirements do not consume the plan for sales order requirements (for example, for
spare parts).

•

Planned independent requirements (Ind Req, VSF) for additional sales orders
These requirements are consumed by sales orders for spare parts, for instance.

Date

MRP
Element

Received/
Required
Quantity

Available
Quantity

<today>

Stock

<reqdat1>

DepReq

<Parent
material>

50 -

100

<reqdat2>

IndReq

VSF

200 -

100 -

<reqdat3>

PlOrd.

0123/Stck

100 +

0

150

Procedure

1. Maintain strategy group 40 on the MRP screen of the material master for the component (spare part) to
support this scenario.
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2. Set the consumption fields (Consumption mode, Fwd consumption, Bwd consumption) to enable
consumption of the planned independent requirements.
3. Enter 2 for Individual/coll. if you are working in a make-to-order environment.
Result

To use the component in production of a finished product, ensure that:
•

No planned independent requirements are created for the component.

•

There is no procurement of the component without dependent requirements.

•

Dependent requirements are generated by a sales order for the parent material (or by means of normal
production).

•

Procurement of the components takes place.

•

Goods issue takes place.

The process flow for use of the component in sales orders is identical to the process flow described in
chapter 2, Planning with Final Assembly (40).

Planning Without Requirements from the Parent Material
This procedure assumes that no usable dependent requirements exist at parent level. The parent
material(s) of the component cannot be easily planned. This issue may be due to one of the following
reasons:
•

The component is used in completely different parent materials (where any planning strategy can be
used at parent level).

• The parent material(s) is/are planned on the basis of consumption.
The issue is further complicated when this multi-use material is sold in sales orders (for example, as a
spare part).
In this procedure, there are independent plans for use of this component in production of a finished
product and for use of this component in sales orders.
Parent
Material(s)

Requirements
DepReq 200

Planning

2

200+ VSFB

Requirements for
parent material(s)
(e.g. 200 PC)
One Plan 2 ONLY
for the requirements
from parent material(s)

Requirements from
sales orders (e.g. 50 PC)

Requirements
CREQ 50
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“Spare Part”
(strategies
40 & 70)

One Plan 1 ONLY
for the requirements
from sales orders

1

50+ VSF
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Procedure

1. Create a new strategy in the IMG for production (choose Master Planning → Demand Management →
Planned Independent Requirements → Planning Strategy → Define strategy group), which combines strategy
40 and strategy 70, where strategy 40 is the main strategy.
2. Maintain the following production plan for the use as a component in production:
- Maintain VSFB as the requirements type (these are requirements that are consumed in production)
for planned independent requirements in the IMG for production (choose Master Planning →
Demand Management → Planned Independent Requirements → Planning Strategy → Define strategy
group)
- In the initial screen for maintaining planned independent requirements (Production → Master
Planning → Demand Management → Planned independent requirements → Create/Change →
Requirements parameters), enter 2 for the Consumption indicator.
3. Maintain the following production plan for the use of the component in sales orders (as a spare part,
for example):
- Maintain VSF as the requirements type (these are requirements that are consumed in sales orders)
for planned independent requirements in the IMG for production (choose Master Planning →
Demand Management → Planned Independent Requirements → Planning Strategy → Define strategy
group
- In the initial screen for maintaining planned independent requirements (Production → Master
Planning → Demand Management → Planned independent requirements → Create/Change →
Requirements parameters), enter 1 for the Consumption indicator.
Result

The process flow for use as a component is exactly the same as described in Planning at Assembly Level (70),
earlier this chapter. The process flow for use in sales orders is exactly the same as described in Planning
with Final Assembly (40) at the beginning of chapter 2.

Stock-keeping at Different BOM Levels
When using strategy 52, 63, 50, 60, or similar strategies for the finished product, certain issues arise as to
the level at which the materials should be kept in stock.
You can choose between the following options, illustrated in the graphic that follows:
Finished
Product

2

“Stocking Level”

2

Assembly

1

1

Assembly

Assembly

Assembly
or Raw Matl

Assembly
or Raw Matl

1

Assembly
or Raw Matl

Assembly
or Raw Matl

To be kept in stock (order-independent,

1 procurement before sales order is entered)
2 To be assembled after sales order is entered
(can be order-specific)
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Stocking Level—Two Levels Below the Finished Product
This manner of stock-keeping corresponds to the assembly on the left-hand side of the above graphic. The
components should be assembled during the Procurement After Sales Order stage, whereas the components
of the assembly should be kept in stock during the Procurement Before Sales Order stage (on the basis of
planned independent requirements, and not assigned to a specific sales order).
Maintain the master data as follows:
•

The assembly must have the Special procurement field set to 60 (Phantom in planning) on the MRP
screen. Essentially, the assembly is not built until a sales order exists for the finished product. There
will, however, be a planned order (and production order) for the assembly once the sales order has
been entered.

•

The Individual/coll. indicator must be set to 2 on the MRP screen for the components of the assembly.
The components are procured in accordance with the planning at finished product level.

Stocking Level—One Level Below the Finished Product
This manner of stock-keeping corresponds to the assembly in the center of the above graphic. The
components should be assembled during the Procurement Before Sales Order stage and should be kept in
stock, without being assigned to a specific sales order.
Maintain the master data as follows:
•

Enter 2 for the Individual/coll. indicator on the MRP screen for the component/assembly. The
components are procured in accordance with the planning at finished product level.

•

This manner of stock-keeping is probably the most common way of using the strategies without final
assembly (52, 63, 50, 60).

No Components Stored on Level Below the Finished Product
This manner of stock-keeping corresponds to the component/assembly on the right-hand side of the above
graphic. The components should be assembled during the Procurement After Sales Order stage, and not kept
in stock. If the finished product is assembled according to make-to-order (strategy 50 or 60), the component
is also assembled according to make-to-order. Therefore, a customer-specific segment will exist in the
stock/requirements list.
To maintain the master data, enter 1 for the Individual/coll. indicator or leave it blank on the MRP screen for
the component/assembly. The components are not procured until a sales order exists for the finished
product. If you work in a make-to-order environment, do not forget to set the Individual/coll. indicator
again for the levels below this assembly until you reach an assembly that is either set to 2, or not planned at
all. Otherwise, the whole structure below this assembly will be produced according to make-to-order.

© 1998 SAP Labs, Inc.

3–21

Strategies for Planning Components
Replenishment Lead Time

Replenishment Lead Time
Definition
Replenishment lead time is the total time for either in-house production or the external procurement of a
product. In in-house production, the replenishment lead time is determined to cover all BOM levels.

Use
As a rule, the replenishment lead time is used in the availability check. If the replenishment lead time is not
maintained, then the system uses the in-house production time (for internally produced materials) or the
planned delivery time (for externally procured materials) to determine component availability. If both are
maintained, the in-house production time and the planned delivery time have higher priority than the
replenishment lead time.

Integration

The replenishment lead time is interpreted as follows:
•

When planning at component level, the replenishment lead time is reduced to the in-house production
time.

•

When planning at finished product level, the replenishment lead time is considered to be the
production time of the overall structure. Therefore, if you want to react quickly to customer demand,
you need to ensure the following:
- Planned independent requirements are maintained at finished product level.
- Sales orders are entered a long time in advance.
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Overview
The planning strategies in this section are designed to produce a material for an individual sales order.
That is, you do not want to produce finished products until you receive a sales order. Therefore, make-toorder strategies always support a very close customer-vendor relationship because sales orders are closely
linked to production. Make-to-order is also used in production using variant configuration and assembleto-order environments. The usage in this areas is due to the close relationship between the sales order and
production that exists in a make-to-order environment and is required in assemble-to-order and variant
configuration.

Prerequisites
Choose a make-to-order strategy, if:
•

The materials are segregated and uniquely assigned to specific sales orders.

•

Costs need to be tracked at sales order, not at material level.

For the sake of clarifying the master data settings,Make-to-order strategies should always be combined
with lot-size key EX (lot-for-lot), and rounding values should not be used. Even if you would maintain
other lot-size keys or rounding values these values do not take effect in make-to-order strategies.

Process Flow
Sales
order

Order
stock

Extensive options exist that enable you to procure components for specific sales order items. You may,
however, want to use a different planning strategy to procure components without having a sales order
yet. Using one of these planning strategies allows you to keep your replenishment lead time low.
You can keep the replenishment lead time low by:
•

Planning on the basis of the finished product [see the next section, Planning Without Final Assembly (50),
or Planning with a Planning Material (60) later this chapter.]

•

Planning at component level (see Strategies for Planning Components in chapter 3)

•

Using consumption-based or Kanban-controlled components

4–2
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Customer stock can exist on any BOM level. See Stockkeeping at Different BOM Levels in chapter 3 for more
information. The close link of sales orders to stock results in the customer section of the
stock/requirements list.
In the basic make-to-order strategy, Make-to-Order Production (20), no specific product structures are
required. Therefore, it does not matter if the material has a BOM or not. The material can be produced inhouse or procured externally. No planning is involved in this strategy.
Planning Without Final Assembly (50) and Planning with a Planning Material (60) do require a specific product
structure (that is, a BOM, which means the BOM header material is always produced in-house). These
planning strategies assume that you want to plan the procurement (production or purchasing) of your
components by planning the finished products. This strategy means you need a fairly stable demand for
your finished products. If, however, you can plan more easily at component level than at finished product
level, see Strategies for Planning Components.

Planning Without Final Assembly (50)
Purpose
It makes sense to use this planning strategy when the main value-added process is final assembly. This
strategy and Planning with a Planning Material (60) are probably the most widely used strategies in a maketo-order environment. Like all make-to-order strategies, use strategy 50 if production is unique for every
customer, where it is impossible to change the stock for different sales orders.

Prerequisites
Maintain the following master data for the finished product:
•

Strategy group 50 on the MRP screen.

•

Consumption parameters (Consumption mode, Bwd consumption, Fwd consumption) so that the
independent requirements can be found.
If no independent requirements can be found, default values are taken from the MRP group. For more
information, see Consumption Strategies and Logic.

•

Item category group (for example, NORM) on the Sales Organization screen.

A BOM is required for the finished product There are no major implications for the BOM components.
However, you need to maintain the following settings for the BOM components:
• Set the MRP type to P* (or M*) to plan the components in MRP (of course you are also free to use, for
example, consumption-based components).
• You may want to consider setting the Individual/coll. indicator to 2 for a make-to-stock procurement of
components in a make-to-order environment.
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Process Flow
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For a detailed example of the entire process, see Sample Scenario: Strategy 50.

Key Properties of Strategy 50
•

Production quantities can be planned effectively. You can use information from the Sales Information
System, SOP, or other planning tools to plan production quantities.

•

Procurement of the components is organized by means of planned independent requirements entered
at finished product level. The system creates special planned orders at finished product level for these
planned independent requirements. These orders are only relevant for production once a sales order
for the finished product exists.

•

Planned independent requirements that are scheduled using this particular strategy are listed in a
separate segment in the MRP list. The planned orders are created with the order type VP and are
unconvertible. The sales orders for this strategy are entered as individual customer requirements and
maintained in a separate segment in the planning run.

•

The assemblies are, however, produced or procured before the sales order is entered. Production is
carried out up to one level before the finished product level, and the assemblies and components
required for producing the finished product are placed in stock to await the incoming sales order.

•

Final assembly is triggered once a sales order has been entered.

•

An availability check is performed on the basis of planned independent requirements. Therefore,
unplanned stock (such as returns) is not considered for sales.

•

The incoming sales order consumes the planned independent requirements, and this in turn reduces
the unconvertible planned order quantity.

•

The system creates a new convertible planned order for the sales order quantity. If the unconvertible
planned order quantity is not exhausted by the sales order quantity, it remains in the system. If the
sales order quantity exceeds the planned independent requirements quantity, the unconvertible
planned order quantity is increased. For additional information, see the section Coping with Insufficient
Coverage of Components in chapter 2.
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•

The planned independent requirement quantities that remain unconsumed increase the warehouse
stock of the components and cause procurement to decrease or not take place at all in the next period.
This process is called netting.

Strategies 50 and 60 are very similar to strategies 52 and 63. The following differences exist, however:
Strategy

50, 60

52, 63

Costing, settlement, workin-progress, etc.

Make-to-order

Make-to-stock

Finished product stock (and Segregated per sales order
item
component stock (if
required)

Not segregated

Lot-size indicator and
rounding values

User has to ensure that the
appropriate values are set

Lot-size indicator and
rounding values being
ignored

Other Areas
Stocking Levels
See Stockkeeping at Different BOM Levels in chapter 3.

Availability Check
In this strategy, there is only an availability check against planned independent requirements. A material is
considered available if a planned independent requirement can be consumed. Therefore, unplanned stock
(returns or unplanned production quantities such as over-deliveries) is not taken into account. The
Availability check indicator (MRP and Sales: General/Plant Data screens) is not relevant in this case because an
availability check according to ATP logic does not take place.

Sample Scenario: Strategy 50
The process flow for strategy 50 is very similar to strategy 52. This sample scenario therefore refers to
Sample Scenario: Strategy 52 in chapter 2. This example is based on a production plan in which 100 pieces
are planned for <reqdat1>, <reqdat2>, and <reqdat3>.

Stage 1: Demand Management
This stage is the same as strategy 52, which means planned independent requirements are created for the
production plan, and the system finds requirements type VSE. See the Table of Planning Strategy
Assignments in chapter 1.
The requirements are passed onto MRP. The stock/requirements list (Logistics → Production → MRP →
Evaluations → Stock/reqmts list) for this example would appear as follows:
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Date

MRP
Element

Received/
Required
Quantity

Available
Quantity

<today>

Stock

<today>

→ Planning w/o assembly

<reqdat1>

IndReq

VSE

100 -

100 -

<reqdat2>

IndReq

VSE

100 -

200 -

<reqdat3>

IndReq

VSE

100 -

300 -

0

Stage 2: Procurement Before Sales
This stage is the also the same as strategy 52, which means non-convertible planned orders are created for
the finished product. Procurement for the components takes place.

Stage 3: Sales Order and Allocation
A sales order is created for the parent material. Unlike strategy 52, the system finds the requirements type
KEV because the strategy group is set to 50. See the Table of Planning Strategy Assignments in chapter 1.
Like strategy 52, the following things happen:
•

A quantity that was previously planned (such as 100 pieces for each schedule line in this example) can
be confirmed (Edit → Item availability in the sales order menu). Note the header text that says
Assignment of Planned Independent Requirements. This header signifies that the availability check is not
performed according to ATP logic, but instead it is based on planned independent requirements.

•

The system finds the schedule line category CP and the item category TAN because the item category
group was set to NORM.

After the sales order has been entered, the stock/requirements list for the parent material appears as
follows:
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Date

MRP
Element

Received/
Required
Quantity

<today>

Stock

<today>

Cstock

000333/0010

<today>

Order

000333/0010/001

<today>

→ Planning w/o assembly

<reqdat1>

PlOrd.

<reqdat1>

Available
Quantity
0
0

90 -

90 -

1234/IndR

100

100

IndReq

VSE

10 -

90

<reqdat2>

PlOrd.

1235/ IndR

100

190

<reqdat2>

IndReq

VSE

100 -

90

<reqdat3>

PlOrd.

1236/ IndR

100

190

<reqdat3>

IndReq

VSE

100 -

90

The only difference between this stock/requirements list and the one at the same point in strategy 52 is the
Cstock line that segregates the different sales order stocks.

Stage 4: Procurement After Sales
This stage is similar to strategy 52. The stock/requirements list for the parent material appears as follows:

Date

MRP
Element

<today>

Stock

<today>

Cstock

000333/0010

<today>

Order

000333/0010/001

90 -

0

<t+rlt>

PlOrd.

1237/Ord.

90

0

<today>

→ Planning w/o assembly

<reqdat1>

PlOrd.

1234/IndR

10

10

<reqdat1>

IndReq

VSE

10 -

0

<reqdat2>

PlOrd.

1235/IndR

100

100

<reqdat2>

IndReq

VSE

100 -

0

<reqdat3>

PlOrd.

1236/IndR

100

100

<reqdat3>

IndReq

VSE

100 -

0
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Here the difference between this strategy and strategy 52 is that the system creates a planned order with
order type ORD (make-to-order) instead of STCK.
The goods receipt from production results in a customer stock and the stock/requirements list then
appears as follows (note the stock in the Cstock line):

Date

MRP
Element

Received/
Required
Quantity

<today>

Stock

<today>

Cstock

000333/0010

<today>

Order

000333/0010/001

<today>

→ Planning w/o assembly

<reqdat1>

PlOrd.

<reqdat1>

Available
Quantity
0
90

90 -

90 -

1234/IndR

10

10

IndReq

VSE

10 -

0

<reqdat2>

PlOrd.

1235/IndR

100

100

<reqdat2>

IndReq

VSE

100 -

0

<reqdat3>

PlOrd.

1236/IndR

100

100

<reqdat3>

IndReq

VSE

100 -

0

As long as you have set the Individual/coll. indicator to 2, there are no differences at component level.

Stage 5: Goods Issue for Delivery and Reduction of Planned Independent Requirements
This stage is the also the same as strategy 52, which means that the planned independent requirements are
physically reduced.

Planning with a Planning Material (60)
Purpose
This planning strategy is particularly useful for planning BOMs that contain variant and non-variable
parts. The important feature of this strategy is that you can procure non-variable components based on
planning in Demand Management. Production of the finished product is based on actual sales orders. This
procedure ensures that you can quickly react to customer requirements even if the finished product has a
long overall lead time. You can avoid the main value-added process until you have a customer.
This strategy lends itself to planning the variants of one product. The term variant is used here to indicate
similar products. It is not used in the sense of variant configuration. You need to imagine similar parts
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sharing a BOM group so that you can easily exchange a component in all similar BOMs, for example. You
usually have several dozen variants, whereas variance would be much higher in variant configuration.

Examples from Industry
This strategy lends itself to the planning of different sizes or packages for one product. For instance, you
may want to sell a product in packages:
•

Containing 1 liter, 2 liters, and 1 gallon

•

Labeled in English, German, and Japanese

Prerequisites
You need to create a separate material master record for the planning material and enter the planning
material in the material master record (on the MRP screen) of all finished products that are to be planned
using this planning strategy.
Maintain the products in the following fashion:

Strategy group

Variant products

Planning material

60

60

for example, NORM

Sales organization screens
are not required

Not to be maintained, the
values of the planning
material are used.

Need to be maintained so
that the planned
independent requirements
can be found.
(See Consumption Strategies
and Logic in chapter 1)

(MRP screen)
Item category group
(Sales organization screen)
Consumption parameters
(Consumption mode, Bwd
consumption per., Fwd
Consumption per.)
(MRP screen)
Planning material, Planning
plant and Plng conv. Factor

Need to be maintained.

(MRP screen)
Bill of material

Required

Required

Contains all parts

Contains the non-variable
parts

There are no major implications for the BOM components. However, you:
•

Need to enter P* or M* for MRP type (on the MRP screen) to plan the component in MRP.

•

May want to consider setting the Individual/coll. indicator (on the MRP Screen) to 2 for a make-to-stock
procurement of components in a make-to-order environment.
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For a detailed example of the entire process, see the next section, Sample Scenario: Strategy 60. This strategy
has the same basic features as strategy 50. In addition, many materials can consume the planned
independent requirements of one planning material. For more information on the differences between
these strategies, see Planning Without Final Assembly (50).
In the current strategy the non-variable parts are planned using the BOM of a so-called planning material. In
this instance, the planning material is used purely for planning purposes. It is not actually produced itself,
but rather used to pass on the dependent requirements of the non-variable parts from the finished product.
The variant parts can be planned using the strategy Planning at Assembly Level (70) in chapter 3. The
advantage of planning with a planning material is that you can plan all the non-variable parts included in
several finished products together.
These variant components cannot be planned exactly using this strategy. Instead you need ensure that the
variant components are:
•

Consumption-based

•

Independently planned using a planning strategy for components (see Strategies for Planning
Components in chapter 3 for more information)

Alternatively, you can accept an over-planning or under-planning of the variant components.
If you have high variance in your products, you may want to automate the planning of components. See
Strategies for Configurable Materials in chapter 5 for more information. This strategy can also be used as a
cross-plant version of strategy 50. See Cross-Plant Planning in chapter 1 for more information.

Sample Scenario: Strategy 60
The process flow for strategy 60 is very similar to the process for strategy 63. This sample scenario
therefore refers to Sample Scenario: Strategy 63 in chapter 2. This example is based on a production plan in
which 100 pieces are planned for <reqdat1>, <reqdat2>, and <reqdat3>.
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Stage 1: Demand Management
This stage is the same as for strategy 63, which means planned independent requirements are created for
the planning material, and the system finds requirements type VSEV. See the Table of Planning Strategy
Assignments in chapter 1. The requirements are passed onto MRP.
The stock/requirements list for the planning material (Logistics → Production → MRP → Evaluations →
Stock/reqmts list) for the above example would appear as follows:

Date

MRP
Element

Received/
Required
Quantity

Available
Quantity

<today>

Stock

<today>

→ Planning without assembly

<reqdat1>

IndReq

VSEV

100 -

100 -

<reqdat2>

IndReq

VSEV

100 -

200 -

<reqdat3>

IndReq

VSEV

100 -

300 -

0

Stage 2: Procurement Before Sales
This stage is the also the same as strategy 63, which means non-convertible planned orders are created for
the planning material. Procurement for the components of the planning material takes place.

Stage 3: Sales Order and Allocation
A sales order is created for the variant material. Unlike strategy 52, the system finds the requirements type
KEVV because the strategy group is set to 60. See the Table of Planning Strategy Assignments in chapter 1.
Similar to strategy 52, the following things happen:
•

A previously planned quantity (such as 100 pieces for each schedule line in this example) can be
confirmed (Edit → Item availability in the sales order menu). Note the header text that says Assignment of
Planned Independent Requirements. This header signifies that the availability check is not performed
according to ATP logic, but is based instead on planned independent requirements.

•

The system finds the schedule line category CP and the item category TAN because the item category
group was set to NORM.

After the sales order has been entered, the stock/requirements list for the variant material appears as
follows:
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Date

MRP
Element

Received/
Required
Quantity

<today>

Stock

<today>

Cstock

00035/0010

<orderdat>

Order

00035/0010/001

Available
Quantity
0
0

90 -

90-

The stock/requirements list for the planning material changes as follows, because an allocation has taken
place:
Date

MRP
Element

Received/
Required
Quantity

Available
Quantity

<today>

Stock

<today>

→ Planning w/o assembly

<reqdat1>

PlOrd.

1234/IndR

100

100

<reqdat1>

IndReq

VSEV

10 -

90

<reqdat2>

PlOrd.

1235/ IndR

100

190

<reqdat2>

IndReq

VSEV

100 -

90

<reqdat3>

PlOrd.

1236/ IndR

100

190

<reqdat3>

IndReq

VSEV

100 -

90

0

At component level, the requirement from the planning material switches to a requirement from the
variant material. The sum of requirements remains the same.

Stage 4: Procurement After Sales
This stage is similar to strategy 63. The stock/requirements list for the variant material appears as follows:

Date

MRP
Element

<today>

Stock

<today>

Cstock

000335/0010

<orderdat>

PlOrd.

000335/Ord.

90

90

<orderdat>

Order

000333/0010/001

90 -

0

4–12

Received/
Required
Quantity

Available
Quantity
0
90
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At this point, the difference between this strategy and strategy 63 is that the system creates a planned order
with order type ORD. (make-to-order) instead of STCK. The planned order for the variant material is now
convertible and triggers production after the sales order has been entered. As long as you have set the
Individual/coll. indicator to 2 on the MRP screen (to ensure a make-to-stock procurement of components in a
make-to-order environment), there are no differences at component level.

Stage 5: Goods Issue for Delivery and Reduction of Planned Independent Requirements
This stage is the also the same as for strategy 63, which means that the planned independent requirements
are physically reduced.

Make-to-Order Production (20)
Purpose
As the name would suggest, in make-to-order production, a product is produced specifically for an
individual sales order. This planning strategy is used when planning of the (parent) product is neither
required nor possible. Demand Management is not involved in this process, nor is there an allocation
mechanism. Orders are taken as they come. This strategy represents a production procedure where, in
theory, each product is only produced once, although over time the same or similar production processes
are repeated. Each product is specifically produced for an individual customer; therefore the finished
product is rarely placed in stock.

Prerequisites
Considering the purpose of this strategy the following requirements have to be met by the components:
•

Procure all necessary components within the total replenishment lead time

•

Plan on component level, if required

•

Use consumption-based components or Kanban-based components

Alternatively, you can receive the sales orders at a very early stage with regard to the replenishment lead
time.
You also need to maintain the following master data settings for the finished product:
•

Strategy group 20 on the MRP screen

•

Item category group (such as NORM) on the Sales Organization screen

No specific product structure is required. Therefore, it does not matter if the material has a BOM (internal
production) or not (and is procured externally). The material is, however, usually produced in-house as in
the subsequent sample scenario.
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For a detailed example of the entire process, see Sample Scenario: Strategy 20 earlier this chapter.

Key Properties of Strategy 20
•

The sales order quantities are planned for production using the sales order number.
The quantities produced for the individual sales orders cannot be changed. Each quantity is maintained
specifically for the individual sales order. A separate segment is created in the MRP list for make-toorder production.

•

Starting from the sales order, you can apply this type of planning to as many levels of the BOM as you
want.
Assemblies and components are also produced or procured specifically for the pegged order, and stock
is also managed separately for this sales order.

•

The production and procurement costs are maintained for each sales order in either a settlement order
or in a project at sales order item level.
A detailed analysis of the planned and actual costs is ensured.

•

You can also use this production technique to create assembly orders.
The assembly order triggers the creation of either a production order or a planned order and provides
you with a precise delivery schedule. The delivery schedule is based on availability and the production
requirements of the relevant assemblies and components.

Other Areas
Stocking Level
See Stockkeeping at Different BOM Levels in chapter 3 for more information.

Sample Scenario: Strategy 20
Stage 1: Demand Management
This stage does not apply to this strategy.
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Stage 2: Procurement Before Sales
This stage does not apply to this strategy in the sense that there is no production without a sales order. If
sales orders exist in the system in advance, production is performed before the required delivery date.

Stage 3: Sales Order and Allocation
Once a sales order is created, the following can happen:
•

Any quantity can be confirmed according to the ATP checking rule for a make-to-order environment,
AE. Note the header text, which says Availability Control. This statement indicates that this is an
availability check according to ATP logic.

•

The system finds the schedule line category CP and item category TAN because the item category
group was set to NORM.

•

The system finds the requirements type KE (under the Overview → Procurement in the sales order menu)
because the strategy group has been set to 20.

•

In this scenario, an order with a quantity of 10 pieces is now entered with a required delivery date of
today. This order can be confirmed after the replenishment lead time.

Once the sales order has been entered, the stock/requirements list appears as follows:

Date

MRP
Element

Received/
Required
Quantity

<today>

Stock

<today>

Cstock

000333/0010

<today>

Order

000333/0010/001

Available
Quantity
0
0

10 -

10 -

Note the Cstock lines divide the total stock into independent customer sections.

Stage 4: Procurement After Sales
A procurement requisition is created in the MRP run (Logistics → Production → MRP → Total planning). The
stock/requirements list is then as follows:
Date

MRP
Element

Received/
Required
Quantity

Available
Quantity

<today>

Stock

<today>

Cstock

000333/0010

<today>

Order

000333/0010/001

10 -

10 -

<t+rlt>

PlOrd.

000214/Stck

10

0

0
0

t + rlt = today + replenishment lead time
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This procurement requisition is the starting point for production or external procurement. Various
possibilities exist for handling the procurement process in the R/3 System. One option would be to convert
the planned order into a production order, and release the production order and a goods receipt of the
yield quantity.
After goods receipt for the order and a second MRP run, the stock/requirements list appears as follows:

Date

MRP
Element

Received/
Required
Quantity

<today>

Stock

<today>

Cstock

000333/0010

<today>

Order

000333/0010/001

Available
Quantity
0
10

10 -

0

Stage 5: Goods Issue for Delivery
After goods issue for the delivery (Logistics → Sales and distribution → Shipping → Delivery → Create), the
stock/requirements list is reset to empty.
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Overview
This chapter explains the issues involved in the planning of configurable materials. This chapter is not
about variant configuration as such. We must infer that you are familiar with variant configuration (refer
to the online help if necessary).
All strategies, newly explained in this chapter, are make-to-order strategies. Refer to chapter 4 for more
information on issues such as:
•

Costing

•

Segregated materials management

The variance of your product(s) is the key driver to choosing the right planning strategies. Planning with
only a few variants differs fundamentally from planning thousands or millions of variants.
Some examples for configurable products are bicycles, personal computers, automobiles, or elevators. This
series of products shows increasing variance.
•

A bicycle might have only a few characteristics (for example, color and frame type).

•

A personal computer might have more characteristics (for example, hard-disk, casing, CPU, country,
color).

•

A car might have hundreds of characteristics, each with a number of characteristics values.

•

An elevator includes a set of components that cannot be reasonably assembled without constructing
new parts for each elevator.

The number of characteristics and characteristic values leads to different approaches on the way these
materials could be planned. To make this point clear, you should consider the number of possible variants:
•

A bicycle might have 7 colors and 2 frame types, which result in 7 * 2 = 14 variants.

•

A personal computer might have 2 hard-disk types, 3 casing types, 2 CPU types, 2 country versions,
and 3 possible colors, resulting in 2 * 3 * 2 * 2 * 3 = 72 variants.

•

A car with some dozens variants can easily have a million or more variants.

•

An elevator might have millions of standard variants and an unlimited number of additional variants
(that is, parts that are produced customer-specific).

After further examination, you could reduce the variants for planning purposes:
•

The colors of the bicycle are typically cheap and planned-consumption based. You might want to plan
only the two variants of the frame type.

•

A similar reduction could be applied to the PC as well. For example, you could use consumption-based
procurement for cheap components and certain software components. Then you would plan only the
expensive components (for example, you might want to plan only CPU types and casing types,
resulting in 6 variants)

5–2
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•

Similar planning approaches can be used for more complex products such as cars and elevators.

This reduction makes a planning of the variant products easier. Up to a certain complexity you can plan on
the finished product level. For example, you could plan as follows:
•

Planning 600 PC of men’s bicycles and 400 PC of women’s bicycles.

•

Planning the amount of different PCs (for example, 100 PC of Desktop PC with a Pentium processor, 80
PC of Tower PC with a 486 processor, and so on).

The planning of products such as cars could occur with two different approaches.
•

If you let your customers configure the product fully you could plan the components directly (for
example, using strategy Planning at Assembly Level (70) from chapter 3). This approach would result in
one set of planned independent requirements for all components (which are not procured
consumption-based or Kanban-controlled). The generation of these planned independent requirements
could be performed manually, from a technical point of view. Yet to simplify this process you might
want to plan the characteristics directly and have the system generate the planned independent
requirements of the components (the characteristics planning sections explain the details on this
procedure).

•

A totally different approach, even for complex products such as cars, would be to define a set of
variants (formerly called stockable-types) that are produced make-to-stock. The advantage of this
approach is that your customers can be served immediately from stock. The downside is that your
customers cannot fully configure the product; they need to willingly buy from stock.

Strategies for Variants
This chapter describes potential ways to cope with products that have a practical limited number of
possible permutations of characteristics and characteristic values (low variance). Essentially, this chapter
describes the use of variants to sell configurable materials.
Variants can be used to facilitate work with configurable materials. Variants of a configurable material are,
for example, defined to prefabricate frequently required configurations and place them in stock (For that
reason, variants were formerly called stockable types).
For some configurable materials, it may be difficult to determine the possible variants. To use strategies for
variants effectively you must have an estimate of future consumption for each variant. If the configuration
is not changed during the sales order stage, production can occur at the production before sales order’ stage.
The customers need to be willing to purchase the variants as they are or as they were planned. The benefit
of this strategy is that products can be immediately shipped to the customers if they are in stock.

Variants and Variant Determination
Variants can be used for products as complex as cars, for example. The variance is reduced artificially.
Manufacturers define a set of variants ranging from basic versions to heavily equipped models. Including
the different colors, there are several hundred variants to be planned, even if there are theoretically billions
of possible variants.
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Variant determination is often used to find the variants, since each variant needs a unique material number
and the sales personnel might not know the material numbers of all variants. To use variant determination,
enter a material number for a configurable material and configure/value the characteristics. As soon as
you have chosen characteristics values this variant displays at the bottom of the configuration screen as
shown below. You can display the detailed configuration of the variant by double-clicking on it.
Depending on the strategy, in Logistics → Central Functions → Var.Configuration, Environment → Conf.
Simulation, Goto → Var.value assigmt. the variant has to match the configurable material partly or
completely.

Notification
of Variant

Settings for Variant Determination and Ability to Change the Variant
In the standard R/3 System, the configurable material entered in the sales order will be replaced by a
variant material. Depending on the configuration, you could instead receive a notification asking if you
want the configurable material replaced with the variant. This option is set by choosing IMG → Sales and
Distribution → Sales → Sales Documents → Sales Document Item → Define Item Categories; this notification is
not a feature of variant configuration or Demand Management itself.
Variant determination is not possible if you either:
•

Deal with multi-level configuration

•

Have not maintained the sales views in the material master of the variants

5–4
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In addition, you can decide if the configuration of the variant can be changed or not. This change depends
on:
•

The structure scope in IMG → Sales and Distribution → Sales → Sales Documents → Sales Document Item →
Define Item Categories, that is, control by the item category and/or by the item category group of the
material master

•

The Cnfg. field in IMG → Sales and Distribution → Basic Data → Availability check and transfer of
requirements → Transfer of Requirements → Define Requirement Class, that is, control by requirements
class, requirements type, and ultimately by the strategy group in the material master.

In the system, one or both of the following master data settings allow the variant to be configured:
•

Item category group for configuration, for example 0002, resulting in item category TAC

•

Strategy groups for configuration, for example 54, 55, 56, 65.

On the contrary, item category group NORM and the strategy group Planning without Final Assembly (50)
would not allow for the configuration of the variant.

Master Data Settings
In addition to the usual configuration data such as characteristics, classes, dependencies, and configuration
profiles for the configurable material, you have to maintain the following data for a variant:
•

To create a variant, maintain the following data in its material master:
- Leave the Material is Configurable field on the basic data screen blank.
- Enter the configurable material on the basic data or MRP2 screen.
- Maintain configuration (you will be prompted for it after entering the configurable material).
- Maintain the usual materials master settings, such as item category group, availability check, MRP
type, and consumption parameters.

•

The configurable material has to be maintained such that:
- An item category will be found which features variant determination such as TAC. Thus, maintain a
suitable item category group such as 0002 in the standard system.
- You consider choosing continuous testing on existing variants during the configuration of the
configurable material. Select Find continuous in Logistics → Central Functions → var.Configuration,
Environment → Conf. Simulation, Goto → Var.value assigmt. in the application menu.

•

To use the same BOM and routing for the variants and the configurable material:
- Use Goto → Header overview, Routing → Material allocation in the transaction to change the routing
(Logistics → Production → Master Data → Routings, Routings → Routings → Change) and enter the
variant material.
- Use Bills of Material → Material BOM → Alloc. Config. Mat → Create in the BOM menu and enter the
variant and the BOM group number

Make-to-Stock Production for Variants
Variants can be planned on the finished product level using any make-to-stock strategy, such as Planning
with Final Assembly (40) or Net Requirement Planning (10). Refer to chapter 2 for how to work with these
strategies.
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The planning of variants with make-to-stock strategies combines the advantages of make-to-stock
production (that is, very short delivery time) with the advantages of variant configuration (that is, one
BOM and one routing for a whole product family).
Planning via variants can be combined with the strategy Characteristics Planning with Dependent
Requirements (56), if you want to accept additional sales orders for any configuration.

Make-to-Order Production for Variants
Variants can be planned on the finished product level using any make-to-order strategy, such as Planning
without Final Assembly (50) or Planning with a Planning Material (60). Refer to chapter 4 for how to work with
these strategies.
The planning of variants with make-to-order strategies combines the advantages of make-to-order
production (that is, very short delivery time or cost tracking on sales order level) with the advantages of
variant configuration (that is, one BOM and one routing for a whole product family).
The following table illustrates which stages are involved in which strategies:

Strategy/Stage

55

26

65

Similar Make-toOrder Strategy

50

20

60

1. Demand
Management

Yes

No

Yes

2. Procurement
before Sales

Yes

No

Yes

3. Sales Order

Yes

Yes

Yes

4. Procurement
after Sales

Yes

Yes

Yes

5. Goods Issue for
Delivery and
reduction of PIR

Yes

Yes

Yes

Make-to-Order for Material Variants (26)
The strategy Make-to-Order for Material Variants (26) is similar to the strategy Make-to-Order Production (20)
as described in chapter 4. The difference is that Make-to-Order for Material Variants (26) lets you change the
configuration of the variant.
See the following matrix for differences and commonalties between strategies 25 and 26.
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Strategy

25

26

Configuration (of a variant)

Must

Can

Material used in sales order

Configurable material

Variant

Default configuration (frequently used
configurations can be stored)

One configuration can be
defaulted per configurable
material using the defaults in
characteristics

Several configurations
can be stored, that is one
configuration can be
stored per variant

Entry in SD order

Configurable material

Variant

Master Data Settings

The master data settings include the following:
•

One configurable material with the usual configuration data, such as characteristics, classes,
configuration profiles, etc.

•

One variant for defined combinations of characteristics values, where the number of permutations
must be limited practically.

The requirements type display for strategy 26 is KEL, as seen in the Procurement → Overview screen of the
sales order.
Process Flow

1. Demand Management
Does not apply.
2. Procurement before sales
Does not apply.
3. Sales order
Creation of sales orders either directly by entering a variant or by entering a configurable material and
using variant determination.
The requirements type display for strategy 26 is KEL, as seen in the Procurement → Overview screen of
the sales order.
4. Production after sales
Make-to-order production of the finished product takes place.
5. Delivery
Delivery of the finished product takes place.

Planning Variants Without Final Assembly (55)
The strategy Planning Variants Without Final Assembly (55), plans variants in a manner similar to the
strategy Planning without Final Assembly (50) for non-configurable materials, as described in chapter 4. The
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difference between these two strategies is that Planning Variants Without Final Assembly (55) allows the user
to reconfigure the variant during a sales order.
Changes to the configuration must not affect planned components. Planned independent
requirements for variants do not make sense when changing the configuration of the variant in
the sales order. The result can be a sold item that has no relation of the configuration of the
planned variant. For this reason, perform configuration changes to Planning Variants Without
Final Assembly (55) with care.
Master Data Settings

Master data settings include the following:
•

One configurable material with the usual configuration, such as characteristics, classes, configuration
profiles, etc.

•

One variant per possible permutation of characteristics values, hence the number of permutations must
be practically limited

Process Flow

1. Demand Management
One planned independent requirement per variant. The variant has to be completely configured.
2. Procurement before sales
Procurement of the variants’ components takes place.
3. Sales order
Creation of sales orders either directly by entering a variant or by entering a configurable material and
using variant determination. The requirements type display for strategy 55 is KELV, as seen in the
Procurement → Overview screen of the sales order. The system automatic adjusts the master plan, if no
planning variant can be found.
4. Production after sales
Make-to-order production (assembly) of the finished product takes place.
5. Delivery
Delivery of the finished product takes place.

Planning Variants with a Planning Material (65)
The strategy Planning Variants with a Planning Material (65) plans variants in a manner similar to the
strategy Planning without Final Assembly (60) for non-configurable materials, as described in chapter 4. The
difference between these two strategies is that Planning Variants with a Planning Material (65) allows the
user to reconfigure the variant during a sales order.
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Changes to the configuration must not affect planned components. Planned independent
requirements for variants do not make sense when changing the configuration of the variant in
the sales order. The result can be a sold item that has no relation of the configuration of the
planned variant. For this reason, perform configuration changes to Planning Variants with a
Planning Material (65) with care.

Master Data Settings

Master data settings include the following:
•

One configurable material with strategy group 65 and the usual configuration such as characteristics,
classes, configuration profiles, etc.

•

One planning material that contains the non-variable parts.
The variable components cannot be planned with strategy 65. The reasons are described in Planning
with Planning Material without Make-to-Order (63) and Planning with Planning Material (60). Set strategy
group 65 and the consumption parameters (Fwd. consumption, Bwd. Consumption, and consumption
mode).

•

One variant material per each actual permutation of the characteristic values.
The number of realistic permutations, and therefore variant materials, must be limited for this strategy.

Process Flow

1. Demand Management
One planned independent requirement per variant. The variant has to be completely configured.
2. Procurement before sales
Procurement of the variants’ components takes place.
3. Sales order
Creation of sales orders either directly by entering a variant, or by entering a configurable material and
using variant determination.
The requirements type display for strategy 55 is ELVV, as seen in the Procurement → Overview screen of
the sales order.
4. Production after sales
Make-to-order production (assembly) of the finished product takes place.
5. Delivery
Delivery of the finished product takes place

Planning Variants (54)
The strategy described in this section has the following intention: planned independent requirements are
only used to procure components, which are important for planning purposes. Important components are
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either expensive, or have long replenishment lead times. In the following example, only the frame of a
bicycle is considered important. Such components should be MRP driven, (MRP type of P* or M* on the
MRP screen).
Unimportant components are either inexpensive, or have a short replenishment lead time. In the following
example, all other components of a bicycle are considered unimportant. These components should have an
MRP type that is consumption-based, V* on the MRP screen, for example. Components marked
consumption-based planning do not generate requirements at the planning or production before sales order stage.

Planning of “Important” Components
Product
(e.g. Bicycle)

Pink
Silver

Men’s Frame

Red
Women’s Frame
Extra 5

Important

Unimportant

PD

VB

Corresponding characteristic
is marked for
“Type matching”

Blue

Unimportant

VB

R

Strategy Planning Variants (54) allows for the planning of important components. This planning is done by:
•

Creating planning variants
These planning variants represent configurations that are used to procure the components with long
replenishment lead times.

•

Allocating the actual quantity sold to a planning variant during the sales order stage that has the
closest configuration
This allocation is called a similarity check.

This procedure requires that the characteristics that determine the similarity check match the components
that are important for planning purposes. The remaining characteristics should influence only components
that are unimportant for planning purposes, such as consumption-based components.
The challenge is to describe the products in a way that characteristics are connected to important
components using the type matching function. With strategy 54, you have to perform that task on your own,
whereas strategy 56 calculates the dependencies automatically. Moreover you need to estimate or forecast
each of the planning variants, for example, based on past data.
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Planning Variants
Planning
PlanningVariants:
Variants:Environment
Environment
Separate
Separatematerial
materialmaster
master
Partial
Partialconfiguration
configuration
Limited
Limitednumber
numberof
ofvariants
variants

Simple
Simpleto
toPlan:
Plan:
Planned
Plannedindependent
independentrequirements
requirementsatatplanning
planningvariant
variantlevel
level
Creation
of
order
proposals
in
MRP
Creation of order proposals in MRP
Similarity
Similaritycheck
checkand
andconsumption
consumptionof
ofplanning
planningvariant
variant

Master Data Setup
Configurable Material

Planning Variant(s)

Strategy group

54

54

Consumption parameters
(Consumption Mode, Bwd
Consumption, Fwd Consumption)

Will be ignored

To be maintained such that
planned independent
requirements can be found

Item category group

0002

(No SD screens necessary for the
planning variants)

For type matching:
The important characteristics are set as required in Logistics → Central Functions → Var. configuration →
Environment → Conf. Simulation, enter the configurable material and choose Goto → Char.Value assignment
then chose Environment → Modelling → Planning → Type matching. In the Type matching screen, select the
names of the important characteristics. Set their type matching value to Required, using the radio buttons.
Those characteristics that are not important for planning set to Optional. You can set a weight number for
the optional characteristics, so that the most important characteristics in selecting a variant material have
the largest weight number. This number is not a percent value. It is a value relative to the weight value of
the other characteristics.
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Similarity Check
Sales Order

(1)

(2)

Weight

Characteristics

Similarity Check
CPU
Casing
PSCI-RAM

10
2

Mandatory
Optional
Optional

Availability Check
Consumption
(3)
Confirmation

Similarity Check and Consumption
Material Master

Create Sales Order

Planning Variant

Order number 2386
Customer 0815

CPU
Casing
PSCI-RAM

Pentium
Tower
16 MB

Quantity
Date

100 pc
29.12.19xx

CPU
Casing
PSCI-RAM

Pentium
Tower
32 MB

Material Number 4760
CPU
Casing
PSCI-RAM

5–12

Pentium
Desktop
32 MB

27.12.19xx
28.12.19xx

Consumption

Material Number 4750

Material Number 4750

Material Number 4141

Similarity Check

486
Desktop
8 MB

Independent Requirements

Sales Order

Material Number 4711
CPU
Casing
PSCI-RAM

Independent Req.

20 pc
80 pc

Material Number 4711
27.12.19xx
28.12.19xx

40 pc
37 pc

Material Number 4760
Planning Materials 4750

27.12.19xx
28.12.19xx

54 pc
62 pc
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Process Flow
Stage 1: Demand Management
Determine which characteristics are important for planning, that is which characteristics should be used for
type matching.
Create a material master for all planning variants and value the characteristics according to planning
needs. The planning variant must be completely configured. You should choose practical configurations
that are aimed for the proper planning of components and not for representing complete assemblies.
Planned independent requirements have to be entered for the planning variants. This stage is similar to the
strategy Planning without Final assembly (50).

Stage 2: Procurement Before Sales
The procurement of the planning variants’ components takes place after the next MRP run. Ideally the
MPR run should generate only proposals for the important components.

Stage 3: Sales Order
This stage represents the creation of sales orders by entering the configurable material.
First, the system checks if a variant exists. If it does exist, then the configurable material is replaced as
described in Variants and Variant Determination, earlier this chapter.
Second, if no (material) variant is found, the system tries to allocate a planning variant to the configurable
material. Unlike the strategy Planning Variants Without Final Assembly (55) discussed earlier this chapter,
the configurable material is not replaced. You can check the type matching results in the sales order in the
configuration screen by choosing Environment → Planning → Type Matching.
The requirements type display for strategy 54 is KEKT, as seen in the Procurement → Overview screen of the
sales order.
After entering the sales order, the total requirements for a planning variant DPC6-T02 list appears as
follows (where DPC6 is the configurable material that was entered in the sales order):
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No allocation takes place if no planning variant can be found. The sales order increases the production
plan (automatic adjustment of master plan).

Stage 4: Production After Sales
Make-to-order production (assembly) of the finished product takes place. Perform a goods issue of the
components and a goods receipt of the configurable material.

Stage 5: Delivery
Delivery of the finished product (configurable material) takes place.
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Other Areas/FAQs
Differences Between Strategies 55 and 54
The differences between strategies 55 and 54 are described in the following matrix:

Strategy

55

54

Master data

A lot of variants (one variant for
each and every possible
permutation of characteristics)

Relatively few planning variants
(planning variant for planning
purposes only)

Additional characteristics settings

(No)

Logistics → Central Functions →
Var. configuration → Environment
→ Conf. Simulation → Goto →
Char.Value assignment →
Environment → Modelling →
Planning → Type Matching

Goal of variant

The variants must be completely
configured. The configuration
must be such that it could be
practically assembled.

The planning variant must be
completely configured (for the
planning relevant characteristics).

Major SD function involved

Variant determination

Similarity check

Allocation Level

Material variant

Configurable material

Production plan (“Forecast”)

Can be created for each variant,
that is, for each combination of
characteristic values. A sales
history should exist for each
variant.

A sales history is only for the
necessary important components.
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You should choose practical
configurations that aim for a
proper planning of components
and not for representing complete
assemblies.
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The following picture compares the number of necessary variants (full black bullets) for one material.

Difference 55/54
Example: Bicycle with 3 characteristics
• Frame (men/women frame)
• Extras (5 extras)
• Color(4 colors)

Number of Variants
•2
• 32 = 0 of 5 + 1 of 5 + 2 of 5 + 3 of 5 + 4 of 5 + 5 of 5
•4
Total Variants: 256 = 2 * 32 * 4

Strategy 54

Strategy 55
Variant Determination

Similarity Check

Frame

Frame
Extras

Women

Women

Men

Color
red

Extras

blue

pink

Men

silver

Color
red

blue

pink

silver

Characteristics Planning
Overview
This section describes how to plan products with an almost unlimited number of possible combinations of
characteristics and characteristics values (high variance). We assume that you want to sell any feasible
combination of characteristic values, and that you do not want to do final assembly for your finished
products. Typical examples for such products can be cars, elevators, forklifts, trucks, busses, etc.
Variants as described earlier this chapter in the section Strategies for Variants cannot be used to plan these
products because you would have to create billions of variants. Entering usage probabilities for
characteristic values instead allows you to plan materials that have a large number of variants. This
procedure also improves change management for the components because planning is separated from
construction changes.

BOM Characteristics Planning
BOM Characteristics Planning
Environment for BOM Characteristics
• Very high number of variants
• Large BOM structures
• Many BOM changes

Requirements maintained automatically
•
•

5–16

Configuration of materials in planned independent
requirements
Requirements determined according to usage probability
Assemblies planned using dependent requirements
(Strategy 56)
Assemblies planned using independent requirements
(Strategy 89)
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Creating Planned Independent Requirements for Characteristics Planning
When creating or changing the planned independent requirements for configurable materials, the usage
probabilities, and the quantities and dates of the planned independent requirements are maintained
individually per date and quantity.

Maintaining Usage Probabilities
Material: "PC"
Reqmts type : VSE Version 00
Characteristics valuation
Date
Quarter 01
Quarter 02
Quarter 03
Quarter 04

Quantity
100
145
150
160

“C
on
fig
ur
ati
on
”

Quarter
Quantity

: MAT: "PC"

01
100

02
145

03
150

04
160

40%
60%
40%

40%
20%
40%

30%
60%
10%

40%
40%
20%

70%
30%

70%
30%

30%
70%

30%
70%

Charac .: Casing
Desktop
Laptop
Tower

Charac .: CPU
Pentium
486

Charac .: Country
Germany
USA

30%
70%

30%
70%

30%
70%

30%
70%

Prerequisites
To maintain usage probabilities, the following items are mandatory:
•

The material must be a configurable material.

•

Strategy groups 56 (Characteristics Planning with Dependent Requirements), 89 (Assembly
Processing with Characteristics Planning), or a similar custom strategy must be maintained in the
material master record.

•

The characteristics of the configurable material to be planned must be flagged relevant to planning.

To make configurable materials relevant to planning, perform the following steps.

© 1998 SAP Labs, Inc.
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1. Choose Logistics → Central
Functions → Var. configuration →
Environment → Conf. Simulation.
The Configuration: Initial Screen
appears.

3
2

2. Enter the configurable material.
3. Click Chars or choose Goto →
Char.Value assignment.
4. On the Configuration: Char. Val.
Asigmt screen, choose Environment
→ Modeling → Planning → Relevant
to planning.

On the Modeling: Planning screen, all
characteristics are optional by default.
After a characteristic is marked
required, its name appears in blue.
5. To make a characteristic relevant
for planning, double-click on the
characteristic (for example, Case
Type for Desktop PC).
5

Marking as relevant for planning
should not be confused with marking
characteristics as Entry required in the
transaction Create/Change
Characteristics. When you make that
selection you must enter a
characteristic value in the
Configuration screen.

5–18
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6. Select Required.
- Optional characteristics do not
need a sum of usage
probabilities of 100%.
- Required characteristics need a
sum of usage probabilities of
100%.

6
7

7. Click Enter.
8. A dialog box appears containing
the allowed values of the
8
characteristics. The characteristics
values you select here can have a
usage probability relevant for
MRP.
9
9. Click Enter.
You enter usage probabilities when you create planned independent requirements in Demand
Management as described below. You can plan only the characteristics values that you defined as relevant
for planning. You cannot plan characteristics that you have not defined as relevant. Underplanning or
overplanning of characteristics can occur while creating the planned independent requirements, resulting
in a warning.

Procedure
SAP recommends the following procedure for maintaining usage probabilities:
1. Choose Logistics → Production → Master Planning → Demand Management → Planned Independent
Requirements → Create.
2. In Material, enter the configurable
material to be planned.

4

3. In Plant, enter the appropriate
plant.
4. Click Enter.
2

3

© 1998 SAP Labs, Inc.
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5. Enter the Schedule lines.
6. Select the necessary schedule
line(s). To create or change usage
probabilities for planned
independent requirements.

9

7

6

5

To see all dates in the configuration
table, select all schedule lines.
7. Click Conf. Supp. Pnt.
The Configuration: Maintain Usage
Probabilities window appears, and
displays all characteristic values
relevant for planning for each
schedule line date.

8

8. To enter usage probabilities as
percentages, enter data in the Usge
prob. column.
9. To enter the usage probabilities as
quantities, click Quantity. Enter
data in the Usge prob. column.
Manual entries are automatically
provided with a firming indicator,
and are thus protected from
automatic changes.
10. Click Next schedule line to go to the
next line.
11. Click Auto.consistency to check the
consistency of the usage
probabilities.

11
9

10

Only the characteristics values selected as relevant for planning appear in this screen.
Compare to step 8 of the previous section Prerequisites.
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12. As an alternative to step 7, click
Config. table on the Plnd ind. Reqmts
Create: Schedule Lines screen if you
require an overview of usage
probabilities.
The system displays scheduled
dates and quantities.

When creating the planned independent requirements, all scheduled dates are proposed for processing.
When changing the planned independent requirements, only the scheduled dates that were given values
when created appear.

Copying Data per Column
1. To copy usage probabilities and absolute quantities for each column, select the date with the value you
want to copy. The heading of the column contains the quantity and the date of the schedule line.
2. Click Select mode/select. The column is highlighted.
3. Click Copy. The highlighted column is copied.
4. Position the cursor on the date to which you want to insert the copied values.
5. Click Insert.

Copying Data per Line
1. To copy usage probabilities and absolute quantities for each line, select the characteristic with the
values you want to copy.
2. Click Select mode/select. The column is highlighted.
3. Click Copy. The highlighted column is copied.
4. Select the characteristic to which you want to insert the copied values.
5. Click Insert. The system adds the values to the column selected.

© 1998 SAP Labs, Inc.
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Integrating Logistics Information System (LIS)
To copy data from LIS, proceed as follows:
1. In the transaction Create/maintain Planned Independent Requirements, choose Settings → Assign
info.structure.
2. Enter the info structure of the combination keys, and the appropriate version of the info structure.
The info structure is assigned to the current version of the planned independent requirements.
3. Click Conf. supporting pnt.
4. The system displays the dialog box, Configuration: Maintaining Usage Probabilities. Only the info
structure for the combination keys is relevant. The key figures contained in the info structure are
displayed with reference to the individual combination keys in the statistics column.
5. To copy the key figures to the usage probabilities, select the combination keys of the key figures you
intend to copy, and position the cursor in the statistics column to be copied.
6. Click Copy.
Firmed combination keys are not changed, just as they are unchanged in the automatic correction.
Combination keys are automatically firmed when you enter them manually on the Configuration
supporting point screen. See the previous section Processing Configuration Supporting Points.
The key figure appears as a quantity or as a probability depending on whether a required quantity or a
usage probability is maintained.
7. If no info structure is assigned, the system automatically assigns the standard info structure, S137 or
S136 with version 000.

Updating Products with Variants

SD
Documents

S128
SD View

Configuration

Period: week

Copy
mgmt
S126
Configuration
object

+

S127
Chars/
Values

CM

S129
Planning

Method
Period: day

Period: day

Period: week
R
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Characteristics Planning with Dependent Requirements (56)
Strategy Focus
With this strategy, planned independent requirements are created for configurable materials. In addition,
the usage probabilities for characteristics are entered into a configuration table. The requirements for
components are automatically calculated as a component quantity multiplied by a usage probability,
which also takes into account the dependencies between characteristics.
The allocation takes place on the header level; that is, sales orders consume the configurable material’s
independent requirement, not the component’s dependent requirements.
Master Data Settings

In addition to the usual master data settings such as creation of BOMs and routings, and the various
configuration data (configuration classes, characteristics, profiles, and object dependencies) the following
has to be set up:
•

Material master
- Enter the Item category group (for example, 0002).
- Enter 56 for Strategy group.
- Set consumption parameters (Consumption Mode, Fwd Consumption, Bwd Consumption), such that
planned independent requirements can be found.

•

Components
- Consider setting the Individual/Collective indicator to 2, as described in chapter 3.
- Components should not have strategy group 70 or 59, in order to take dependent requirements
from the planning of configurable material.

•

Select Relevant for planning for those characteristics that should have a usage probability in Demand
Management.

Process Flow
Stage 1: Planning

Planned independent requirements are entered at configurable material level, as described in the section
Creating Planned Independent Requirements for Characteristics Planning earlier this chapter.
For the configurable material, the planning results in a stock/requirements list that could appear as
follows:
Date

MRP
Element

<today>

Stock

<today>

→

Planning without assembly

<reqdat1>

IndReq

VSE

100-

100-

<reqdat2>

IndReq

VSE

100-

200-

<reqdat3>

IndReq

VSE

100-

300-

© 1998 SAP Labs, Inc.

Received/
Required

Available
Quantity
0
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Stage 2: Procurement Before Sales

Dependent requirements are created in the MRP run. The actual required component quantity is calculated
as the product of usage probability and the original component quantity from the BOM.
The following example may illustrate the functionality:
BOM
Item

BOM
Quantity

Object Dependency

Usage Probability
of
Characteristic_A

A

100

Characteristic_A = ‘<CVA>’

40%

B

100

Characteristic_B = ‘<CVB>’

C

100

Characteristic_A = ‘<CVA>’
AND Characteristic_B =
‘<CVB>’

Usage Probability
of
Characteristic_B

Required
Quantity
40

40%

60%

60

60%

24

Different characteristics are assumed to be statistically independent. The required quantity for item C is
calculated as 100 * 40% * 60%, resulting in 24 pieces.
For a component planned with a usage probability of 40%, the following stock/requirements list results:
Date

MRP
Element

Received/
Required

Available
Quantity

<today>

Stock

<reqdat1>

DepReq

DPC1

40-

40-

<reqdat1>

PlOrd.

001234/ExtP

40+

0

<reqdat2>

DepReq

DPC1

40-

40-

<reqdat2>

PlOrd.

001235/ExtP

40+

0

<reqdat3>

DepReq

DPC1

40-

40-

<reqdat3>

PlOrd.

000126/ExtP

40+

0

0

The procurement proposals lead to the stock for the components.
Stage 3: Sales Order

The entry of a sales order with a specific configuration results in an allocation of the planned independent
requirement for the configurable material, similar to strategy 50.
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Date

MRP
Element

Received/
Required

<today>

Stock

<today>

Cstock

000987/0010

<orddat>

Order

987/0010/001

<today>

→

Planning without assembly

<reqdat1>

IndReq

<reqdat1>

Available
Quantity
0
0

10-

10-

VSE

90-

90-

PlOrd.

00456/IndR

100+

10+

<reqdat2>

IndReq

VSE

100-

90-

<reqdat2>

PlOrd.

00457/IndR

100+

10+

<reqdat3>

IndReq

VSE

100-

90-

<reqdat3>

PlOrd.

00458/IndR

100+

10+

The requirements type display for strategy 56 is KEKS, as seen in the Procurement → Overview screen of the
sales order.
Note that the allocation at the configurable material level leads to a reduction of all the configurable
material’s dependent requirements. Also, the components not sold with the actual order will be reduced
with the next MRP run.

Consumption at Configurable Material Level
BOM
KMAT: 4710

Indep.reqmts
Material: 4710
Quantity: 100 pc
Reduction: 90 pc
Charac.: Casing
Desktop
40%
Laptop
60%

Component 01
Casing EQ Desktop
Component 02
Casing EQ Laptop

-

Sales order
Sales order
Quantity: 10 pc
Casing = Desktop

100 * 0.4 = 40pc
90 * 0.4 = 36pc

Dep.reqmts: 10pc

100 * 0.6 = 60pc
90 * 0.6 = 54pc

Dep.reqmts : 0pc

Stage 4: Procurement After Sales

Production of the configurable material takes place. This stage is similar to strategy 50.
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Stage 5: Goods Issue for Delivery and Reduction of Planned Independent Requirements

The goods issue of the configurable material takes place. This stage is similar to strategy 50.

Assembly Processing with Characteristics Planning (89)
Strategy Focus
This strategy creates automatically planned independent requirements for the configurable material’s
component. This procedure works as described in section Planning at Assembly Level (70) in chapter 2. The
major advantage is you do not have to enter the component’s quantities manually any more. They are
calculated based on the quantities of the configurable material’s planned independent requirements and
the usage probabilities of the corresponding characteristics.
The allocation takes place at the component level, rather than the configurable material level. As a result,
MRP planning runs do not reformulate the components’ planned requirements based on allocation at the
configurable material level, as seen in the section Characteristics Planning with Dependent Requirements (56)
earlier this chapter.
The component’s planned independent requirement may be entered manually, as described in strategy 70.
However, an easier and more efficient method of producing independent requirements for the
configurable material’s component is through R/3’s long-term planning process.

Assembly Processing
This strategy incorporates assembly processing. See chapter 6 for more details. In a nutshell, assembly
processing supports the following features, which are new in respect to the strategies previously discussed:
•

Production is triggered within sales order processing (refer to chapter 6 on how to link different order
types such as planned orders, production orders, or networks to assembly processing).

•

The characteristic values assigned to the configurable material are passed onto the planned order,
production order, or network.

•

The BOM components and operations you require are selected on the basis of these characteristic
values.

•

An availability check at component level is possible (even multi-level availability check is possible
when you work with collective orders or phantom assemblies; availability check is not possible for
BOMs that contain other non-stockable configurable materials).

Master Data Settings
In addition to the usual master data settings, such as creation of BOMs and routings and the various
configuration data (configuration classes, characteristics, configuration profile, object dependencies), the
following has to be set up:
•

Material master
- Enter the Item Category group (for example, 0002).
- Enter 89 for Strategy group.
- Enter 01 for Availability check, to transfer individual requirements.
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•

Components
- Consider setting the Individual/Collective indicator to 2, as described in chapter 3.
- Components have to have strategy group 70 (or 59 as described in chapter 3) in order to get
dependent requirements from the planning of configurable materials.
- You must enter 1 for Mixed Indicator.
- Set consumption parameters (Consumption Mode, Fwd Consumption, Bwd Consumption), such that
planned independent requirements can be impacted.

•

Select Relevant for planning for those characteristics that should have a usage probability in Demand
Management. See Creating Planned Independent Requirements for Characteristics Planning earlier this
chapter.

Process Flow

Consumption at Assembly Level
Configurable
’PC’

Plnd indep.reqmts100
indep.reqmts100 pc
CPU = Pentium : 70%
CPU = 486
: 30%
Country = Germany : 30%
Country = USA
: 70%

Sales order quantity: 100 pc
Configuration

1a

3 CPU = Pentium
Country = USA

(4)
C.assembly
Long-term
1c
planning

BOM
explosion

(5)
Simulative reqmts

4

Assembly

Dependent reqmts

4

(6)
(3)

1c
Reqmts transfer

Consumption

PIRs
Allocation 4

Stage 1a: Creating Inactive Planned Independent Requirements

Planned independent requirements are entered as described earlier this chapter in Creating Planned
Independent Requirements for Characteristics Planning.
With this strategy, the planned independent requirements have to be entered in an inactive version. Make
sure that the checkbox Active is not marked. Use a special version for all materials using this strategy
because long-term planning requires a special version later on.
You cannot see the planned independent requirement in the stock/requirements list, because it is not
active.
Stage 1b: Creating and Releasing the Planning Scenario in Long-Term Planning

Long-Term Planning utilizes the previously entered version numbers to differentiate these simulative
versions from the demand program’s operative versions. In Long-Term Planning, you can either create

© 1998 SAP Labs, Inc.
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new versions of planned independent requirements or you can copy existing planned independent
requirements to a simulative version number. A special report is available to copy existing versions.
Create and release a planning scenario using Logistics → Production → Master Planning → Long-Term
Planning → Scenario → Create. This scenario provides the control data for long-term planning.
•

Allocate the plants to be planned according to this scenario. Choose Edit → Plants and click New entry

•

Allocate the independent requirement’s versions for planning. Only the version to be used in the
Version field is required entry for this example. Choose Edit → Plannd Indep.Req. and click New entry.

•

Choose Edit → Release and Save.

Long-Term Planning is used in this discussion as a tool only. Refer to the online documentation PP LongTerm Planning for further information.
Stage 1c: Carry Out MRP for Long-Term Planning

This stage is similar to the operative planning that exists among other single item and multiple item MRP
programs for long term planning. Use one of these programs (for example, Logistics → Production → Master
Planning → Long-Term planning → Planning run → As backgroud job for the created scenario) to create
simulative dependent requirements in Long-Term Planning.
For the configurable material, only one stock/requirements list in Long-Term Planning could look as
follows:

Date

MRP
Element

Received/
Required

Available
Quantity

<today>

Stock

<today>

→

Planning without assembly

<reqdat1>

IndReq

VSE

100-

100-

<reqdat2>

IndReq

VSE

100-

200-

<reqdat3>

IndReq

VSE

100-

300-

0

Stage 1d: Transferring Requirements

In order to plan and consume requirements in the operative system, the simulative requirements created in
Long-Term Planning must be copied to the operative system as independent requirements. This copying is
accomplished by choosing Logistics → Production → Master Planning → Long-Term Planning → Planned
indep. requirements → Copy sim requirements; specify the independent requirements target version, and the
Date Type in the Aggregation field. The system will copy the simulative requirements from long-term
planning to the operative system.
Now planned independent requirements exist for the configurable material’s components that have been
set up according to master data setup (that is, strategy 70, Mixed Indicator 1, and Individual/Collective
Indicator 2). These settings have exactly the same properties as planned independent requirements created
manually, as described in Planning at Assembly Level (70) in chapter 3.
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For a component planned with a usage probability of 40%, the following stock/requirements list results in
operative planning:
Date

MRP
Element

Received/
Required

Available
Quantity

<today>

Stock

<reqdat1>

IndReq

VSFB

40-

40-

<reqdat1>

PlOrd.

001234/ExtP

40+

0

<reqdat2>

IndReq

VSFB

40-

40-

<reqdat2>

PlOrd.

001235/ExtP

40+

0

<reqdat3>

IndReq

VSFB

40-

40-

<reqdat3>

PlOrd.

000126/ExtP

40+

0

0

The procurement proposals lead to the stock for the components.
Stage 2: Procurement Before Sales

The procurement of components is started based on the planned independent requirements created in
stage 1, similar to strategy Planning at Assembly Level (70) in chapter 3.
Stage 3: Sales Order

The sales order is created for the configurable material. No consumption takes place on the configurable
material level.
Stage 4: Procurement After Sales

The operative MRP run creates dependent requirements for the components. Opposite from the strategy
Characteristics Planning with Dependent Requirements (56) discussed earlier this chapter, the component
requirements are allocated to the planned independent requirements, because these components should be
scheduled using the strategy Planning at Assembly Level (70) in chapter 3.
In comparison to strategy 56 only the proper components get allocated when a sales order is entered.

© 1998 SAP Labs, Inc.
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Consumption at Assembly Level
Configurable
’PC’

Plnd indep.reqmts100
indep.reqmts100 pc
CPU = Pentium : 70%
CPU = 486
: 30%
Country = Germany : 30%
Country = USA
: 70%

Sales order quantity: 100 pc
Configuration

1a

3 CPU = Pentium
Country = USA

(4)
C.assembly
Long-term
1c
planning

BOM
explosion

(5)
Simulative reqmts

4

Assembly

Dependent reqmts

4

(6)

Consumption

(3)

1c
Reqmts transfer

PIRs
Allocation 4

For the component mentioned above, the following stock/requirements list results in operative planning:
Date

MRP
Element

Received/
Required

Available
Quantity

<today>

Stock

<reqdat1>

DepReq

DPC1

10-

90

<reqdat1>

IndReq

VSFB

30-

60

<reqdat2>

IndReq

VSFB

40-

20

<reqdat3>

IndReq

VSFB

40-

20-

<reqdat3>

PlOrd.

000126/ExtP

20+

0

100

Stage 5: Goods Issue

The goods issue of the components reduces their planned independent requirements. The goods issue of
the configurable material has no consequences, because the planned independent requirements for the
configurable material are not active.
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Other Areas/FAQs
Comparison Between Characteristics Planning with Dependent and Independent Requirements

Technical differences:
Characteristics Planning with
Dependent Requirements (56)

Assembly Processing with
Characteristics Planning (89)

Long-Term Planning

-

LTP scenario

Components

No specific strategy group at
component level

Strategy group 70, mixed MRP = 1

Creation of Planned
Independent
Requirements

Active version

Inactive version

Consumption and
Reduction at header level

Allocation at configured material
level, and indirectly (after MPR)
reduction of all components

No allocation

Consumption and
Reduction at Component
Level

Consumption at component level
does not take place. However,
requirements for components are
indirectly reduced for all
components after consumption at
header level

Only components that are used in
configuration are reduced

Example for Reduction at
Component Level:

An order for 20 PC (featuring
characteristic A) is entered
resulting in:

An order for 20 PC (featuring
characteristic A) is entered
resulting in:

The requirement for the
components change to:

The requirement for the
components change to:

•

56 PC (=80 PC * 70%) of
component A

•

50 PC (=70 PC – 20 PC) of
component A

•

24 PC (=80 PC * 30%) of
component B

•

30 PC (=30 PC – 0 PC) of
component B

Planned Quantity 100 PC
Usage Probability of
Characteristic value A =
70%
Usage Probability of
Characteristic value B =
70%
Resulting in requirements
for 70 PC of component A
and 30 PC of component B.
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This leads to the following conclusions:
Characteristics Planning with
Dependent Requirements (56)
General

Performance

Easier to handle (batch run after
completion of planning, monthly),
especially if you cannot plan
precisely or if you only want to
plan capacity on header level
MRP has to plan customer order
AND planning of demands
management all the time

Assembly Processing with
Characteristics Planning (89)
•

More precise planning of
components

•

Better overview of component
situation

Planning of Demand Management is
done in LTP (typically only in the
planning period, for example week
or month) and independent of MRP

Make-to-Order Production with Configurable Materials (25)
Strategy Focus
This strategy shares the basic features with the strategy Make-to-Order Production (20), therefore, this
strategy is used when planning of the (parent) product is neither required nor possible. Components have
to be planned by other means.
This strategy, Make-to-Order Production with Configurable Materials (25), is used for configurable materials;
configuration is required.

Master Data Settings
Material master
•

Item category group (for example, 0002)

•

Strategy group 25

Process Flow
Stage 1: Planning
Does not apply.

Stage 2: Procurement Before Sales
Does not apply.

Stage 3: Sales Order
The variant material and its configuration are entered. The configuration is entered from scratch. The
default characteristic values apply, which could be used as default configuration.
5–32
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Stage 4: Procurement After Sales
The production of variant materials occurs.

Stage 5: Goods Issue for Delivery and Reduction of Planned Independent Requirements
Goods issue occurs for the configurable material.
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Overview
To provide your customers with more reliable delivery dates, you may want to check resources and the
availability situation for make-to-order production when creating the sales order. You should recognize
whether the desired quantity is available on the desired delivery date. If the complete quantity cannot be
committed, you need to know the following information:
•

When will the total quantity be available?

•

Can you commit a partial quantity?

When the finished product is not usually kept in stock, it makes sense to check at component level.
Another important factor for ensuring that the customer is always provided with reliable information is the
constant communication and feedback between sales and production. Information on changes to either
quantities or dates in production, or in the procurement of components, must also be passed onto the sales
order of the finished product, so you can revise any standing confirmations. This link with the sales order
provides you the framework necessary for more precise planning.
In the R/3 System, these functions have been realized in the planning strategy called Assembly Processing.
This strategy provides you with the functionality required to carry out an availability check at component
level when the sales order is created (or a customer quotation or inquiry), with the following results:
•

The committed order quantity of the sales order is based on the component with the smallest available
quantity.

•

The confirmed delivery date of the sales order is based on the availability date of the component that is
latest on the available time axis.

Changes to quantities or dates in the sales order affect production and procurement. Changes to dates or
quantities in production and procurement change the confirmation date and the committed quantity in the
sales order.

Assembly Processing—Procedure
When you create a sales order with the planning strategy assembly processing, the system automatically
creates a procurement element—the assembly order. You can choose between the following procurement
elements for the assembly order:
•

Planned order

•

Production order

•

Process order

•

Network (project)

Scheduling is carried out for the assembly order. If desired, when creating the sales order, you can also
plan capacity. Furthermore, the bill of material is usually exploded for the assembly order to determine the
corresponding components. The availability check is carried out automatically for the components. The
check can be carried out either according to ATP logic or against planned independent requirements
(planned independent requirements at assembly level). This check determines the committed quantity for
the desired delivery date. If no quantity can be committed for the desired delivery date, the system
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calculates and displays the missing parts. If necessary, it also determines a partial quantity and a total
confirmation date (if you carry out the check using the ATP logic).
If a material is configured in the sales order, the results of the configuration are copied to the assembly
order and the system checks the availability of the components selected on the basis of the configuration.
Any changes to the date or the quantity in the sales order are immediately passed onto the assembly order.

Changes to the Planned Order
When you work with planned orders, the changes made to sales orders affect planned orders at all times.

Changes to the Production Order
The following is valid for the production order:
•

Changes made to the sales order are only valid for the production order until it is released.

•

Changes to the assembly order automatically adjust the committed quantities and dates in the sales
order. You can also set the system so that any changes made to the assembly order do not affect the
sales order.

Additionally, the following procedures (assembly types) are supported:
•

A 1:1 procedure, that is, exactly one procurement element exists for each sales order item (static
procedure)

•

A loose link exists between sales order items and procurement elements in which you can split
quantities and dates in the sales orders and production (dynamic procedure)

Custom Strategies
You can create your own planning strategies for assembly processing because you might want to change
one of the following:
•

Create assembly orders with your own order types

•

Use specific methods of availability check for the components (for example, to display a missing parts
list)

•

Use specific methods for capacity check

In fact, the planning strategies delivered in the standard system for assembly processing provide examples
on how you could proceed. Planning strategies 81, 82, and 86 are similar to the planning strategy Make-toOrder Production (20), discussed in chapter 4, in terms of production planning. That is, no real production
planning is involved; the order is merely created without the leveraging procurement started by planned
independent requirements.
However, you could also set up planning strategies for assembly processing that would work similar to
Planning Without Final Assembly (50) or Planning with a Planning Material (60), both discussed in chapter 4.
That is, you could set up planning strategies where you would create planned independent requirements
first to procure the components and then assemble the finished product by using assembly processing.
A “recipe” to construct your own planning strategy for assembly processing requires you perform the
following steps (for each step, use a number range starting with Z or 9):
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1. Copy the proper requirements classes into your custom requirements class.
2. Create a requirements type and include your newly created requirements class.
3. Create a planning strategy and include your newly created requirements type.
4. Create a strategy group and include the newly created planning strategy.
The following sections describe each step in detail.

Copy the Proper Requirements Classes into your Custom Requirements Class
1. In the IMG, choose Sales and Distribution → Basic Functions → Availability check and transfer of
requirements → Transfer of requirements.
2. Select the line Define requirements classes.
3. Click Execute.
4. Select an existing requirements
class line (in this example, ReqC
201).

5

5. Click Copy as.

4

When choosing requirements class lines, select the requirements class:

6–4

•

200, 201, or 040 to get a planning strategy similar to Make-to-Order Production (20)

•

045 to get a planning strategy similar to Planning Without Final Assembly (50)

•

060 to get a planning strategy similar to Planning with a Planning Material (60)

•

200 to get a planning strategy similar to Assembly Processing with Characteristics Planning
(89)
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6. Change the Reqmts class key and
add short text (to change the key,
use a number range starting with
Z or 9).
7. Under Assembly, enter your
Assembly type (for example 2).

12

13
6

See the above section Changes to
the Production Order concerning
assembly types.
8. Enter your Order type (for example
PP04). Change this field for
production and process orders;
leave blank for planned orders

7
8
9

9. Select Avail. Components if desired.
10. Enter your Dialog assembly (for
example 3). This entry determines
the reaction on the ATP check.

10
11

11. Enter Capacity check if desired.
12. Click Enter.
13. Click Save.

Create a Requirements type and Include the Newly Created Requirements Class
1. In the IMG, choose Production → Master Planning → Demand Management → Planned Independent
Requirements → Requirements Types/Requirements Classes.
2. Select the line Define requirements types and allocate requirements class.
3. Click Execute.
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4. Select an existing requirements
type line (in this example, RqTy
KMFA).

5

5. Click Copy as.

4

6. Change the RqTy key. Use a
number range starting with Z or 9
(for example, change KMFA to
ZMFA).
7. Enter short text for Requirements
type.

9
10
7
6

8

8. Under ReqCl, enter the new
requirements class created in the
previous section. This step links
your requirements type to that
requirements class.
9. Click Enter.
10. Click Save.
You will see the new requirements type in the sales order on the Overview → Procurement screen later on.

Create a Planning Strategy
1. In the IMG, choose Production → Master Planning → Demand Management → Planned Independent
Requirements → Planning Strategy.
2. Select the line Define strategy.
3. Click Execute.
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4. Select an existing line (in this
example, Strategy 82).

5

5. Click Copy as.

4

6. Change the Strategy key (use a
number range starting with Z or
9), and add short text.
7. Link this strategy to the newly
created requirements type(s) (See
the Tips & Tricks below).

8
9
6
7

7
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To link newly created requirements types you can either:
•

Leave blank Reqmt type for Indep reqmts. In Reqmt type of customer reqmt enter the copy of the
requirements type that links to requirements class 200, 201, or 040 to get a planning
strategy similar to Make-to-Order Production (20).

•

In Reqmts type for indep. Reqmts enter requirements type VSE (which links to requirements
class 103). In Reqmt type of customer reqmt enter the copy of the requirements type that links
to requirements class 045 to get a planning strategy similar to Planning Without Final
Assembly (50).

•

In Reqmts type for indep. Reqmts enter requirements type VSEV (which links to requirements
class 104). For the Reqmt type of customer reqmt enter the copy of the requirements type that
links to requirements class 060 to get a planning strategy similar to Planning Without
Planning Material (60)

•

In Independent requirements enter requirements type VSE (which links to requirements class
103). For Reqmt type of customer reqmt enter a copy of the requirements type that links to
requirements class 200 to get a planning strategy similar to Assembly Processing with
Characteristics Planning (89).

8. Click Enter.
9. Click Save.

Create a Strategy Group and Include the Newly Created Planning Strategy
1. In the IMG, choose Production → Master Planning → Demand Management → Planning Strategy.
2. Select the line Define strategy group and click Execute.
3. Select an existing line (in this
example, Strtgy grp 82).

4

4. Click Copy as.

3
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5. Change the Strategy group key (use
a number range starting with Z or 8
9).

9

6. Enter the short text in Description.

5
6

7. Enter the new planning strategy in
Main plg. Straty to link to the
newly created planning strategy.

7

8. Click Enter.
9. Click Save.
You can now use the planning strategy in you material masters.

Assembly Processing with Production Orders (82)
Assembly processing with production orders is particularly useful, if you:
•

Require status management functionality
You can use status management, for example, to:
- Document the current processing status of an object
- Allow or forbid certain business transactions
- Group or select objects by status (for example, all orders with the status released, or all components
with the status missing part)
- Trigger rework functions automatically (using trigger points)

•

Want to carry out business functions at operation level, such as:
- Releasing operations
- Printing shop papers
- Entering completion confirmations

•

Keep track of costs during the production process
Every confirmation or goods movement carried out for the production order causes an update of the
actual order costs.

•

Want to use the collective order functionality
A collective order is a structure that links production orders over several manufacturing levels. It offers
the following advantages:
- Any changes to dates or quantities have an immediate effect on any dependent orders within the
collective order.
- No goods movements are required for subassemblies
- You can carry out an availability check across all production levels
Each production order is automatically settled to the superior production order. The top production
order is then automatically settled to the sales order.
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Collective orders are especially suited to the following types of production:
- Continuous flow production
- Production using parallel production lines
- Make-to-order production
•

Want to use the rework functionality
You can use the rework functionality to compensate for malfunctions or errors that occur during the
production process.
With unplanned malfunctions/errors, you can:
- insert rework operations
- insert reference operation sets
- create rework orders
With planned malfunctions/errors, you can control rework by using trigger points

•

Produce co-products
Only if you set up assembly processing with production orders can you use co-products.

Creating a Production Order Directly or Through a Planned Order
When creating a sales order, you can either:
•

Create a production order directly
You can make immediate use of all the production order functionality (such as the status maintenance).

•

Create a planned order first, which is converted into a production order at a later date
In this case, you can also implement planning decisions (such as external procurement or in-house
production) later on in the assembly process.

Note that in assembly processing, you can only convert planned orders into production orders if you use a
strategy group or requirements class with a dynamic assembly type. For more information, please refer to
the sections later this chapter entitled, Assembly Processing with Planned Orders and Assembly Processing with
Projects.

Special Settings for Production Orders
All customizing settings required for assembly processing with production orders, such as strategy group,
requirements class, and order type, are already predefined by SAP in the standard system.

Strategy Groups
Strategy group 82, assembly processing with production orders, is predefined for production orders. In
this strategy, the static procedure (that is, the 1:1 link between the production order and sales order) is
preset as the assembly type.
Requirements Type and Requirements Class

Strategy group 82 refers to both the following requirements type and requirements class in the standard
system.
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•

Requirements type KMFA

•

Requirements class 201

Order Type
Order type PP04, production order with assembly processing, is predefined in the requirements class 201.
Note that if, for some reason, you want to use an order type different from the one predefined by SAP, you
must ensure that the following scheduling parameters are set for that order type:
•

Enter Backward scheduling.

•

Select Adjust basic dates.

If you use all the standard system settings, you do not need to make any additional settings in
Customizing.

Sample Scenario: Strategy 82
Stage 1: Demand Management
This stage does not apply to this strategy.

Stage 2: Procurement Before Sales
This stage does not apply to this strategy in the sense that there is no production without a sales order. If
sales orders exist in the system in advance, production is performed before the required delivery date.

Stage 3+4: Sales Order and Creation of a Production Order
Once a sales order is created (by choosing Logistics → Sales/Distribution → Sales, Order → Create), the
following happens:
1. The system finds the requirements type KMSE (under Overview → Procurement in the sales order menu)
because the strategy group has been set to 81.
2. The system checks each component’s availability individually (unless you enter an availability check that
says no check, which makes sense for unimportant parts, for example, for nuts and bolts). The
accessibility of the least available component determines the overall confirmation date.
The checking rule is determined by both the Availability check field in each single component’s material
master and the setting for the checking group of the PP-customizing.
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When you are on the screen to the
right, you can go back to the sales
order screens by clicking Back
until you reach the ATP check
screen.

3. Because strategy 82 is set to
assembly type Static, it is possible
to display the planned order
directly within the sales order
using Items → Schedule lines →
Quantities/Dates, edit →
Procurement Details. At this point,
you can change anything in the
production order.

4

4. In this scenario, enter 1 piece for
Order quantity with a required
delivery date of today.

5. Once the sales order has been entered, the stock/requirements list appears as follows:

Date

MRP
Element

Received/
Required
Quantity

Available
Quantity

<today>

Stock

<today>

Cstock

000333/0010

<today>

Order

000333/0010/001

1-

1-

<t+rlt>

PrdOrd

1000120/PP04

1

0

0
0

t + rlt = today + replenishment lead time
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Note the following about the stock/requirements list:
•

Cstock lines divide the total stock into independent customer sections

•

The system created a production order without running MRP

When you try to change the production order the following warning appears: Assembly order - changes
have effect on sales order.
6. This production order is the starting point for production. You must release the production order
before assembly can take place.
7. After goods receipt for the order, the stock/requirements list is as follows:

Date

MRP
Element

Received/
Required
Quantity

<today>

Stock

<today>

Cstock

000333/0010

<today>

Order

000333/0010/001

Available
Quantity
0
1

1-

0

Stage 5: Goods Issue for Delivery
After goods issue for the delivery (Logistics → Sales and distribution → Shipping → Delivery → Create), the
stock/requirements list is reset to empty.

Assembly Processing with Planned Orders (81)
Assembly processing with planned orders is particularly useful, if production control is managed using:
•

Production orders
However, you do not want to create the production order along with the sales order. You can use the
planned order for adjusting planning and then convert it into a production order at a later date.

•

Repetitive Manufacturing
The planned order is then the run schedule quantity, which you can plan using the planning and
control tools provided by Repetitive Manufacturing. With this procedure, the goods receipt for the
material can be posted with reference to the sales order number. Thus, the costs can also be directly
assigned to the sales order, even in Repetitive Manufacturing.

The following sections provide a description of several criteria, as well as an example scenario for assembly
processing with Repetitive Manufacturing.
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Special Settings for Planned Orders
All the settings you require in customizing for assembly processing with planned orders are already
predefined by SAP. These settings include, for example, the strategy group and the requirements class. The
settings in the system standard allow the planned order to be converted into a production order, and in
Repetitive Manufacturing it can be used as a run schedule quantity.

Strategy Group
Strategy group 81, assembly processing with planned orders, is predefined for planned orders. In this
strategy, the dynamic procedure (that is, the loose link between the planned order and sales order) is
preset as the assembly type.
Requirements Type and Requirements Class

Strategy group 81 refers to both the following requirements type and requirements class in the standard
system:
•

Requirements type KMSE

•

Requirements class 200

Assembly Processing with Repetitive Manufacturing
It makes sense to use assembly processing with Repetitive Manufacturing if you can apply several of the
following situations:
•

If production of the finished product is carried out in clear and simple steps

•

If the assembly is produced in a constant flow over the production lines

•

If simple routings are used, or if assembly can be carried out without routings

•

If the components can be staged anonymously at the production lines
The components are procured, for example with Kanban, using consumption-based planning, or with
the planning strategy subassembly planning

•

If you want to reduce the effort required for production control and backflushing

Assembly processing with Repetitive Manufacturing is described in the following scenario:
•

The production process is kept as simple as possible. There are only a limited number of production
levels involved in producing the product. The number of components is relatively low, however, and it
is fully possible to produce a large number of finished products due to configuration options.

•

The components required for final assembly are selected through the configuration in the sales order
and are staged at the production line anonymously. You can use the assembly order to carry out an
availability check for the selected components. Components that are always readily available are
excluded from the availability check by setting the appropriate indicator in the material master record.

•

The finished product is assembled without a routing and the operations are similar. The planning table
in Repetitive Manufacturing provides the planner with an overview of the production rates. At this
point, the planner can also check capacities for the production lines and distribute the ordered
quantities to the production lines with available capacity.
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•

When production is complete, the goods receipt for the finished product is posted with reference to the
sales order number –(a special function exists in Repetitive Manufacturing for this step). After the
goods receipt posts, the goods are withdrawn for the specific sales order and the assembly order is
deleted.

For the scenario described above, you can also work without using the planning functions of Repetitive
Manufacturing. In this case, capacity planning is not carried out from the planning table in Repetitive
Manufacturing, but instead, using the capacity leveling functions in capacity planning. However, you can
still use the backflushing functions in Repetitive Manufacturing.

Special Settings for Repetitive Manufacturing
For assembly processing with Repetitive Manufacturing, the same strategy group and requirements
type/class are used as described in the previous section Special Settings for Planned Orders.
If you use the planning table in Repetitive Manufacturing, you have more settings to make.

Repetive Manufacturing for Make-to-Order Production With or Without the Planning Table
The special settings for Repetitive Manufacturing depend on whether you:
•

Want to use the planning table in Repetitive Manufacturing to assign the production quantities to
production lines or to carry out capacity planning, for example

•

Do not want to use the planning table to plan the run schedule quantities, and instead, for example,
you want to use:
- The current stock/requirements list from MRP to gain an overview of the run schedule quantities
- The capacity leveling functions from the stock/requirements list or from capacity planning to
adjust the master plan.

Repetitive Manufacturing for Make-to-Order Production with Planning Table
If you want to use the planning table, you must maintain the following data:
•

In the material master record, you must:
- Allow Repetitive Manufacturing for the material. To do so, you must enter a Repetitive
Manufacturing profile. Various control parameters are contained in this profile, for example, for the
movement types in backflushing and for posting costs.
We recommend you use a profile for which a cost collector has to be created manually, as a cost
collector is not required for make-to-order production.
The Repetitive Manufacturing profile also determines whether the costs are posted with or without
activities (machine costs, labor costs, and so on) when backflushing. If you decide to post with
activities, they are automatically posted with the final backflush.
- Create a production version containing the data relevant for production –(alternative BOM, group,
group counter, production line, and so on). If you work without routings, you must enter at least
the BOM and the production line in the production version.

Repetitive Manufacturing for Make-to-Order Without the Planning Table
If you choose not to work with the planning table, you must include the appropriate settings in the
material master record.
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You must enter a Repetitive Manufacturing profile. Various control parameters are contained in this profile
(for example, for the movement types in backflushing and for posting costs). We recommend that you use
a profile for which a cost collector has to be created manually, as a cost collector is not required for maketo-order production. The Repetitive Manufacturing profile also determines whether the costs are posted
with or without activities (machine costs, labor costs, and so on) during backflush. If you decide to post
with activities, they are automatically posted with the final backflush.
Note that the special goods receipt posting with reference to the sales order is available whether you work
with or without the planning table.

Sample Scenario: Strategy 81
Stage 1: Demand Management
This stage does not apply to this strategy.

Stage 2: Procurement Before Sales
This stage does not apply to this strategy, because there is no production without a sales order. If sales
orders exist in the system in advance, production is performed before the required delivery date.

Stage 3+4: Sales Order and Creation of Planned Order
After a sales order is created (Logistics → Sales/Distribution → Sales, Order → Create), the following activities
occur:
1. The system checks each component’s availability individually (unless you enter an availability check that
says no check, which makes sense, for example, for nuts and bolts). The accessibility of the least
available component determines the overall confirmation date.
The checking rule is determined by both the Availability check field in each single component’s material
master and the setting for the checking group of the PP-customizing.
2. The system finds the requirements
type KMSE (under the Overview →
Procurement in the sales order
menu) because the strategy group
has been set to 81.
3. Because strategy 81 is not set to
assembly type static, it is
impossible to display the planned
order directly within the sales
order using the Items → Schedule
lines → quantities/Dates, edit →
Procurement Details.
However it is possible to display it
by choosing Edit → Item
Availability, and double-click on
the planned order. Note the field
Assembly type.
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4. In this scenario, an order with a
quantity of 1 piece is now entered
with a required delivery date of
today.
5. Once the sales order has been entered, the stock/requirements list appears as follows:
Date

MRP
Element

Received/
Required
Quantity

Available
Quantity

<today>

Stock

<today>

Cstock

000333/0010

<today>

Order

000333/0010/001

1-

1-

<t+rlt>

PlOrd.

0004711/Ord.*

1

0

0
0

t + rlt = today + replenishment lead time

Note the following about the stock/requirements list:
•

Cstock lines divide the total stock into independent customer sections

•

The system creates a firmed planned order without running MRP

6. This planned order is the starting point for production. Various possibilities exist for handling the
production process in the R/3 System. As mentioned above, the following possibilities exist:
•

Convert the planned order into a production order to release the production order and a goods
receipt of the yield quantity

•

Process the planned order using repetitive manufacturing

7. After goods receipt for the order, the stock/requirements list is as follows:
Date

MRP
Element

<today>

Stock

<today>

Cstock

000333/0010

<today>

Order

000333/0010/001
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Received/
Required
Quantity

Available
Quantity
0
1

1-

0
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Stage 5: Goods Issue for Delivery
After goods issue for the delivery (Logistics → Sales and distribution → Shipping → Delivery → Create), the
stock/requirements list is reset to empty.

Assembly Processing with Characteristics Planning (89)
This planning strategy is described in chapter 5, the section Assembly Processing with Variant Configuration
(89).
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R/3 System MRP Strategies Made Easy—Evaluation Form
Basic Information

R/3 System MRP Strategies Made Easy—Evaluation Form
We’re interested in getting your feedback
on the R/3 System MRP Strategies Made
Easy.
Please fill out and return this questionnaire
to us as soon as possible.

Please Mail or fax the completed evaluation to:
SAP Labs, Inc.
R/3 Simplification Group
3475 Deer Creek Road
Palo Alto, CA 94404-2127
Phone (650) 849-4000
Fax (650) 849-4003

Basic Information
Name:
Title:
Company:
Phone number:
Email address:
Customer Name:

General Impressions
On a scale of 1–10 (10 being most satisfactory), please rate the items listed below by circling a number:

Relevance of Topics

1

2

3

4

5

6

7

8

9

10

Ease of Use

1

2

3

4

5

6

7

8

9

10

Overall Quality

1

2

3

4

5

6

7

8

9

10

Organization

1

2

3

4

5

6

7

8

9

10

Accuracy of Information

1

2

3

4

5

6

7

8

9

10

Overall Usefulness

1

2

3

4

5

6

7

8

9

10
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R/3 System MRP Strategies Made Easy—Evaluation Form
Questions

Questions
1. Which tool are you reviewing?

2. Please rate how useful you found this tool (1 being least useful; 10 being most useful)?

3. Would you use this tool again or recommend it to someone else?

4. Approximately how many person-days did you save by using this tool?
Consultant person-days:
Customer person-days:

5. What dollar amount would you estimate you saved by using this tool (include saved consulting days
into this US dollar amount)?

2
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Questions

6. By how many project days were you able to cut your implementation time in this area?

7. Please describe, in detail, how you used this tool:

8. What did you like about this tool (consider ease-of-use, practicality, and whether the tool is
professional)?

9. What did you not like about this tool? How would you like to see this changed? (Please describe bugs,
additional functionality, and any impracticalities.)
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Questions

10. Please provide other comments, general ideas about the future of this tool.

4
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strategy 10, 2–19, 2–20
strategy 11, 2–28
strategy 30, 2–14, 2–15
strategy 40, 2–6
strategy 50, 4–4, 4–5, 4–6
strategy 52, 2–34
strategy 59, 3–10, 3–14
strategy 60, 4–11
strategy 70, 3–4, 3–7
without replenishment lead time, 2–27
Available to promise. See ATP logic

B
Backflush field, 3–9
Backflushing, 2–39, 2–48, 3–9, 3–14, 6–15
Backorder processing, 2–14
Backward consumption, 2–4, 2–13, 2–24, 2–31, 2–33, 2–45, 3–3,
3–9, 3–16, 3–19
description, 1–4
Bill of materials. See BOMs
BOMs, 2–33, 2–34, 4–3
applying planning from sales order, 4–14
assembly processing, 5–26
characteristics planning with dependent requirements, 5–24
components, 2–41, 4–3
group, 2–40
phantom assembly, 3–10, 3–13
replenishment lead time, 3–22
similar products, 4–9
stock-keeping at different levels, 3–20
useful planning, 4–8
variant products, 2–42

C
Capacity planning
capacity leveling functions, 6–15
strategy 63, 2–42
Characteristics
plan directly, 5–3
type matching, 5–11
value level, 1–3
values, 5–16
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variant determination, 5–4
Characteristics planning, 2–42, 5–2, 5–3, 5–16
assembly processing with, 5–26
comparing dependent and independent requirements, 5–31
creating planned independent requirements, 5–17
with dependent requirements, 5–23
Characteristics Planning with Dependent Requirements (56), 5–23
compared to strategy 89, 5–31
goods issue for delivery and reduction of planned independent
requirements, 5–26
master data settings, 5–23
planning, 5–23
process flow, 5–23
procurement after sales, 5–25
procurement before sales, 5–24
sales order stage, 5–24
usage probabilities, 5–17
Checking control, 3–8
Checking group, 3–7
Checking rule, 2–16, 3–7, 6–11, 6–16
Collective order functionality, 6–9
Component-level planning, 1–2, 3–2
prerequisites, 3–2
process flow, 3–2
similar to make-to-stock, 3–2
Components
characteristics value, 1–3
consumption-based, 2–15
expensive, 5–9
important vs. unimportant, 5–9
individual planning of, 2–15
insufficient coverage, 2–12, 2–13
limited number of parent materials, 3–18
long replenishment lead times, 5–9
none stored on level below finished product, 3–21
one set of planned independent requirements, 5–3
overplanning and underplanning, 2–43
planning directly, 5–3
procurement based on sales forecast, 2–45
procuring, 1–3
procuring non-variable, 2–40
separate requirements, 3–17
setting for assembly processing, 5–26
settings for characteristics planning, 5–23
sold as spare parts, 3–15
sold with sales orders, 3–17
strategies for planning, 3–1
used in several finished products, 3–15
using materials as, 3–17
Configurable materials
allocating planning variant to, 5–13
goods issue of, 5–26
make-to-order production with, 5–32
master data, 5–5
planned independent requirements created for, 5–23
planning of, 5–2
production of, 5–25
reduction of dependent requirements, 5–25
replacing with variants, 5–4
selling using variants, 5–3
usage probabilities, 5–17
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Consumption
assembly level, 5–27, 5–30
configurable material level, 5–25
fields, 3–19
strategies and logic, 1–4
Consumption mode, 2–4, 2–13, 2–24, 2–31, 2–33, 2–45, 3–3, 3–9,
3–16, 3–19
maintaining, 1–4
Consumption parameters, 2–4, 2–33, 2–45, 3–9, 4–3, 5–23, 5–27
material master, 2–13
Consumption period, 2–4, 2–20
backward consumption, 1–4
forward consumption, 1–4
maintaining, 1–5
process flow, 1–4
Conversion field, 3–12
Co-products, producing, 6–10
Costs
tracking during production, 6–9
Cross-plant planning, 1–10
process flow, 1–10
purpose and prerequisites, 1–10
Customer requirements
combining with independent requirements, 3–16
element CREQ, 3–17
planned independent requirements, 1–5
sales orders entered as, 4–4
same planned independent requirements, 3–17

D
Daily requirements, 2–16
Delivery
time, 3–22
Demand levels
satisfying large and small, 2–26
Demand Management
cross-plant planning, 1–10
displaying order quantities, 2–6
planning strategies maintained in, 1–6
requirements classes, 1–6
strategy 10, 2–20
strategy 11, 2–28
strategy 20, 4–14
strategy 30, 2–16
strategy 40, 2–6
strategy 50, 4–5
strategy 52, 2–35
strategy 54, 5–13
strategy 55, 5–8
strategy 59, 3–11, 3–12
strategy 60, 4–11
strategy 63, 2–43
strategy 65, 5–9
strategy 70, 3–5
strategy 81, 6–16
strategy 82, 6–11
Demand quantity
reducing, 2–31
viewing original, 2–31
Dependent requirements, 2–48, 3–14, 3–18, 3–19
characteristics planning with, 5–23
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compared to independent in characteristics planning, 5–31
consumption periods, 1–4
creating simulative in long-term planning, 5–28
replaced by order reservation, 2–39
Dynamic assembly type, 6–10

E
Element
CREQ, 3–17
OrdRe, 2–39
OrdRes, 2–48
RESE, 3–17
Elements
for assembly order, procurement, 6–2
External procurement, 2–22, 2–30, 2–35, 3–6, 3–22

F
Final assembly
planning variants without, 5–7
planning with, 2–4
planning without, 2–32, 4–3
stock-keeping for strategies without, 3–21
Finished products
assembled without a routing, 6–14
based on sales orders, 2–32, 4–8
consumption-based, 3–2
level, 1–2
no components stored below, 3–21
planning according to, 4–3
stock-keeping
one level below, 3–21
two levels below, 3–21
variant products, 5–3
variety of, 3–2
Forward consumption, 2–4, 2–13, 2–24, 2–31, 2–33, 2–45, 3–3,
3–9, 3–16, 3–19
description, 1–4

G
Goods
sold from stock, 2–19
Goods issue
for production order
strategy 59, 3–14
strategy 70, 3–9
Goods issue for delivery
strategy 11, 2–32
strategy 20, 4–16
strategy 81, 6–18
strategy 82, 6–13
Goods issue for delivery and reduction of planned independent
requirements
strategy 10, 2–23
strategy 25, 5–33
strategy 30, 2–18
strategy 40, 2–11
strategy 50, 4–8
strategy 52, 2–39
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strategy 56, 5–26
strategy 60, 4–13
strategy 63, 2–48
Goods receipts, 2–27, 2–31, 2–37, 2–45, 3–6, 3–12
result in a customer stock, 4–8
Gross Requirements Planning (11), 2–27
availability check, 2–28
compared to strategy 10, 2–28
Demand Management, 2–28
goods issure for delivery, 2–32
prerequisites, 2–27
process flow, 2–27
procurement before sales, 2–30

H
Header materials, 3–8
Heavy-duty industries, 2–27
High stock levels
avoiding, 2–3
High variance, 4–10, 5–16

I
Independent requirements, 2–6, 2–29
combining with customer requirements, 3–16
compared to dependent in characteristics planning, 5–31
phantom assembly, 3–13
Individual requirements, 2–16
Individual/coll. indicator, 2–33, 3–2, 3–9, 4–3
make-to-stock environment, 3–3
stock-keeping, 3–21
In-house production, 3–22
Insufficient coverage, 2–12
suggestions, 2–13

L
Leftover stock, 2–15
Legacy system, 2–27
Logistics Information System (LIS)
integrating, 5–22
Long-term planning
assembly processing, 5–27
carrying out MRP, 5–28
Lot size
optimization, 2–15, 2–26, 2–28, 2–33
production by, 2–14
rounding mechanisms, 2–15
Lot-size key, 2–3, 3–3
EX, 2–33, 3–3, 4–2

M
Make-to-order environment, 4–2
in make-to-stock production, 3–2
make-to-stock procurement, 4–9
Make-to-Order for Material Variants (26), 5–6
compared to 20 and 25, 5–6
master data settings, 5–7
process flow, 5–7
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Make-to-order production, 4–1, 4–2, 5–2
for variants, 5–6
most widely used strategies, 4–3
prerequisites, 4–2
process flow, 4–2
repetitive manufacturing
with planning table, 6–15
without planning table, 6–15
Make-to-Order Production (20), 4–13
assembly orders, 4–14
compared to 25 and 26, 5–6
goods issue for delivery, 4–16
key properties, 4–14
prerequisites, 4–13
process flow, 4–14
procurement after sales, 4–15
purpose, 4–13
sales order and allocation stage, 4–15
sample scenario, 4–14
Make-to-Order Production with Configurable Materials (25), 5–32
compared to 20 and 26, 5–6
goods issue for delivery and reduction of planned independent
requirements, 5–33
master data settings, 5–32
process flow, 5–32
procurement after sales, 5–33
sales order stage, 5–32
Make-to-stock production
for variants, 5–5
in make-to-order environment, 3–2, 4–9
prerequisites, 2–3
process flow, 2–3
strategies for, 2–1
strategy stages, 2–4
using returns, 2–8
Mass production environments, 2–18, 2–27
Master data, maintaining for
assembly processing with characteristics planning, 5–26
characteristics planning with dependent requirements, 5–23
configurable material, 5–5
gross requirements planning, 2–27
make-to-order material variant, 5–7
make-to-order production, 4–13
make-to-order production with configurable materials, 5–32
net requirements planning, 2–19
phantom assembly, 3–9
planning
with a planning material, 2–40
with final assembly, 2–4
without final assembly, 2–33
planning at assembly level, 3–3
planning variants, 5–11
with a planning material, 5–9
without final assembly, 5–8
planning without final assembly, 4–3
production by lot size, 2–14
setup, 3–2
stock-keeping, 3–21
variant determination, 5–5
Material master
assembly processing with characteristics planning, 5–26
characteristics planning with dependent requirements, 5–23
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consumption parameters, 2–13
creating a variant, 5–5
creating for planning variants, 5–13
cross-plant planning, 1–10
maintaining, 2–24, 2–26, 2–31
maintaining for spare part, 3–16
make-to-order production with configurable materials, 5–32
MRP group, 1–5, 1–6
repetitive manufacturing
with planning table, 6–15
without planning table, 6–15
Material requirements planning system, 2–27
Material-level planning. See Component-level planning
Materials
as components, 3–17
grouping, 1–1
in sales order precessing, 3–17
Materials, multi-use. See Multi-use materials
Mixed MRP indicator, 2–27, 3–9
MRP group
assigning planning strategy via, 1–5
maintaining, 2–24
material master, 1–7
parameters, 2–13
MRP types, 2–33
MTO. See Make-to-order production
Multi-level availability check, 5–26
Multi-use materials
creating separate requirements, 3–17
planning, 3–17
planning objectives, 3–15
sold in sales orders, 3–19
strategies for, 3–14
uses, 3–15

N
Net Requirements Planning (10), 2–18, 2–19
availability check, 2–20
combined with strategy 30, 2–26
compared to strategy 11, 2–28
compared to strategy 40, 2–24
Demand Management, 2–20
displaying sales orders, 2–20
key properties, 2–19
prerequisites, 2–19
process flow, 2–19
procurement before sales, 2–21
sales order stage, 2–22
Netting, 2–20, 2–34, 4–5
Non-SAP MRP systems, 2–27
Non-variable components
planning, 4–10
planning materials, 5–9
procuring, 4–8

O
Order quantities
displaying in Demand Management, 2–6
Order reservations, 2–39, 2–48
Order type. See Planned orders, order type

© 1998 SAP Labs, Inc.

Index

Ordering plants, 1–10
Orders
hiding display, 2–32
Overplanning components, 2–43

P
Packaged goods industry
strategy 10, 2–18
Packaging materials, 2–40
Pallet size, 2–15
Parent materials, 3–8
planned-consumption based, 3–15
planning with requirements, 3–18
planning without requirements, 3–19
separate plans, 3–17
Phantom assemblies
availability check, 5–26
Phantom assembly. See also Planning at Phantom Assembly Level
(59)
components, 3–9
planning, 3–9
procurement factors, 3–12
Planned independent requirements
assembly processing, 6–3
capacity planning, 2–42
compared with customer requirements, 2–5, 2–33
consumed
as spare parts, 3–18
during production, 3–5, 3–10
consumption, 1–4
of production orders, 3–4
created
automatically, 5–26
for configurable material, 5–23
for the planning material, 4–11
for the production plan, 3–11
creating for characteristics planning, 5–17
customer requirements, 1–5
determine procurement, 2–19
entered
at assembly level, 3–4
at finished product level, 2–5, 4–4
for the planning variants, 5–13
entered at configurable material level, 5–23
inactive versions, 5–27
left unreduced, 2–20
not consumed by orders, 2–15
one set for all components, 5–3
planning
procurement quantities, 2–19
production quantities, 2–28, 2–33
with only one, 3–9
production and sales orders, 3–17
production determined by, 2–27
reduced at goods issue, 2–11, 2–18, 2–19, 2–24, 2–27, 2–39,
2–48
reduced in phantom assembly, 3–13
reducing in future, 2–20
strategy 40, 2–4, 2–5
unconsumed quantities, 3–5
used to procure important components, 5–9
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Planned orders
assembly processing with, 6–13
changes to, 6–3
convertible, 4–4
for components, 3–4
converting, 2–8, 2–36, 2–39, 2–48, 3–12
creation of, assembly processing, 6–16
finished product level, 4–4
order type
ORD, 4–8, 4–13
STCK, 4–8, 4–13
VP, 2–44, 3–12, 4–4
phantom assembly, 3–13
special settings for, 6–14
unconvertible quantity, 4–4
Planned quantities, 2–27
Planning at Assembly Level (70), 2–15, 3–3
combined with strategy 40, 3–16, 3–20
Demand Management, 3–5
goods issue for production order, 3–9
process flow, 3–4
procurement before use in production, 3–6
production order and allocation, 3–7
sample scenario, 3–5
Planning at Phantom Assembly Level (59), 3–3, 3–9
Demand Management, 3–11
goods issue for production order, 3–14
prerequisites, 3–9
process flow, 3–10
procurement before use in production, 3–11
production order and allocation, 3–13
purpose, 3–9
sample scenario, 3–11
Planning levels, 1–2
Planning material. See also Planning with a Planning Material
non-variable parts planned with BOM of, 4–10
planning several finished products, 4–10
planning variants with, 5–8
planning with, 2–40
Planning plants, 1–10
Planning procurement, 2–3
Planning strategy
assigning via MRP group, 1–5
assignments table, 1–7, 2–23, 2–29, 3–5
component level, 3–1
creating for assembly processing, 6–3, 6–4, 6–6
main, 2–26
MRP group, 1–6
requirements types and classes, 1–6
used in
PP-PI, 1–9
Service Management, 1–9
the Project System, 1–9
Planning table
repetitive manufacturing, 6–15
Planning Variants (54), 5–9
compared to strategy 55, 5–15, 5–16
delivery, 5–14
master data setup, 5–11
planning important components, 5–10
process flow, 5–13
procurement before sales, 5–13
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production after sales, 5–14
sales order stage, 5–13
similarity check, 5–12
Planning Variants with a Planning Material (65), 5–8
master data settings, 5–9
process flow, 5–9
Planning Variants Without Final Assembly (55), 5–7
compared to strategy 54, 5–15, 5–16
master data settings, 5–8
process flow, 5–8
Planning with a Planning Material (60), 4–3, 4–8
and strategy 50, compared to 52 and 63, 4–5
Demand Management, 4–11
goods issue and reduction of planned independent requirements,
4–13
prerequisites, 4–9
process flow, 4–10
procurement after sales, 4–12
procurement before sales, 4–11
purpose, 4–8
sales order and allocation stage, 4–11
sample scenario, 4–10
Planning with a Planning Material and Without MTO (63), 2–3,
2–32, 2–40
and strategy 52, compared to 50 and 60, 4–5
capacity planning, 2–42
Demand Management, 2–43
prerequisites, 2–40
process flow, 2–42
procurement after sales, 2–47
procurement before sales, 2–43
purpose, 2–40
Planning with Final Assembly (40), 2–4, 3–17
availability check, 2–6
combined with strategy 70, 3–16, 3–20
compared to
strategy 10, 2–24
strategy 70, 3–4
Demand Management, 2–6
goods issue, 2–11
key properties, 2–5
prerequisites, 2–4
process flow, 2–5
procurement before sales, 2–8
sample scenario, 2–6
Planning Without Final Assembly (50), 4–3
and strategy 50, compared to 52 and 63, 4–5
Demand Management, 4–5
goods issue and reduction of planned independent requirements,
4–8
key properties, 4–4
prerequisites, 4–3
process flow, 4–4
procurement after sales, 4–7
procurement before sales, 4–6
purpose, 4–3
sales order and allocation stage, 4–6
sample scenario, 4–5
Planning Without Final Assembly and Without MTO (52), 2–3,
2–32
and strategy 63, compared to 50 and 60, 4–5
availability check, 2–34
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Demand Management, 2–35
prerequisites, 2–33
process flow, 2–33
procurement after sales, 2–38
procurement before sales, 2–35
sales order and allocation stage, 2–37
Process flow
make-to-stock production, 2–3
strategy 10, 2–19
strategy 11, 2–27
strategy 20, 4–14
strategy 30, 2–14
strategy 40, 2–5
strategy 50, 4–4
strategy 52, 2–33
strategy 54, 5–13
strategy 55, 5–8
strategy 56, 5–23
strategy 59, 3–10
strategy 60, 4–10
strategy 63, 2–42
strategy 65, 5–9
strategy 70, 3–4
strategy 81, 6–16
strategy 82, 6–11
strategy 89, 5–27
using as a component, 3–20
using in sales orders, 3–20
using materials
as components, 3–17
in sales order processing, 3–17
Process orders, 2–39, 2–48
Procurement
based on
sales forecast, 2–45
sales orders, 2–14
before
production order stage, 3–10
receipt of sales orders, 2–5
use in production, 3–6, 3–11
by planning components, 3–2
decreasing, 2–20
determined only by planned independent requirements, 2–19
elements for assembly order, 6–2
maintaining costs for sales orders, 4–14
non-variable components, 4–8
planned independent requirements entered at finished product
level, 4–4
possibilities in R/3, 2–18, 2–35
quantities, 2–19
requisitions, 2–30, 3–12
strategy 30, 2–14
without sales orders, 2–37
Procurement after sales
strategy 20, 4–15
strategy 25, 5–33
strategy 30, 2–17
strategy 50, 4–7
strategy 52, 2–38
strategy 56, 5–25
strategy 60, 4–12
strategy 63, 2–47
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strategy 89, 5–29
Procurement before sales
strategy 10, 2–21
strategy 11, 2–30
strategy 40, 2–8
strategy 50, 4–6
strategy 52, 2–35
strategy 54, 5–13
strategy 56, 5–24
strategy 60, 4–11
strategy 63, 2–43
strategy 89, 5–29
Procurement requisitions, 2–8, 2–17, 2–22, 2–35, 2–36, 2–43, 3–6,
3–11, 3–12, 4–15
Production
based on sales orders, 2–40, 4–8
before receipt of sales orders, 2–5
component-level planning, 3–2
determined by a production plan, 2–18
level, 1–3
maintaining costs for sales orders, 4–14
optimization, 2–15
regardless of stock, 2–27
requirements combined with sales orders, 3–15
responsibility for, 1–3
smoothing for seasonal demand, 2–18
smoothing of, 2–19, 2–27, 3–3
triggered within sales order processing, 5–26
with variant configuration, 5–1
Production after sales
strategy 54, 5–14
Production by Lot Size (30), 2–14, 2–16
availability check, 2–15
combined with strategy 10, 2–26
key properties, 2–15
prerequisites, 2–14
process flow, 2–14
procurement after sales, 2–17
sales order stage, 2–16
sample scenario, 2–16
Production execution system, 2–27
Production orders, 2–48
and allocation, 3–7, 3–13
assembly processing with, 6–9, 6–13
changes after sales orders, 3–4, 3–10
changes to, 6–3
converted from planned order, 2–8, 2–39
created for the finished product, 3–14
creating
directly, 6–10
through planned order, 6–10
creation of, assembly processing, 6–11
element RESE, 3–17
goods issue, 3–9
special settings, 6–10
Production planning
goals, 1–1
Purchase orders, 3–7
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R
Repetitive manufacturing, 2–27, 2–36, 2–39, 2–44, 2–48, 3–12
assembly processing, 6–13, 6–14
make-to-order production
with planning table, 6–15
without planning table, 6–15
special settings for, 6–15
Replenishment lead times, 3–22
availability check, 3–22
with, 3–8
without, 2–19, 2–27
checking with in strategy 30, 2–15
integration, 3–22
keeping low, 4–2
using in check, 2–17
Requirements
from parent material, 3–18
planning separately, 3–17
planning without from the parent material, 3–19
Requirements classes
040, 6–4
045, 6–4, 6–8
060, 6–4, 6–8
103, 6–8
104, 6–8
200, 6–4, 6–8, 6–14
201, 6–4, 6–11
and requirements types, 1–6
assembly processing, 6–4
assigning to planned independent requirements and sales orders,
1–6
Requirements types
and requirements classes, 1–6
assigning planning strategy via MRP group, 1–5
BSF, 2–29
changing, 2–26
combining independent with customer requirements, 3–16
consumption, 1–4
creating for assembly processing, 6–4, 6–5
determination of, 1–7
determining, 1–5
for customer requirements, 1–7
for independent requirements, 1–7
KE, 4–15
KEKS, 5–25
KEKT, 5–13
KEL, 5–7
KELV, 5–8
KEV, 4–6
KEVV, 4–11
KL, 2–17, 2–26
KMFA, 6–11
KMSE, 6–11, 6–14, 6–16
KSL, 2–23, 2–27, 2–31
KSV, 2–10, 3–16, 3–17
KSVS, 2–37
KSVV, 2–45
LSF, 2–21
maintaining and defining strategies and strategy groups, 1–6
proposed automatically, 1–7
selling unplanned stock, 2–34
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VSE, 2–35, 4–5, 6–8
VSEB, 3–11
VSEV, 2–43, 4–11, 6–8
VSF, 2–7, 3–20
VSFB, 3–5, 3–16, 3–17, 3–20
Reservations, 3–7
phantom assembly, 3–13
Returns
using in Make-to-stock production, 2–8
Rework functionality, 6–10
Rounding keys, 2–28
Rounding mechanisms, 2–15
Rounding values, 3–3, 4–2

S
Sales Information System, 2–5
Sales orders
and allocation
strategy 50, 4–6
strategy 52, 2–37
strategy 60, 4–11
strategy 63, 2–45
assembly processing, 5–29, 6–2, 6–11, 6–16
characteristics planning, 5–24
combining with production requirements, 3–15
consumption periods, 1–4
costs tracked at, 4–2
demand triggers production, 2–34
displayed for information purposes only, 2–19
displaying, strategy 10, 2–20
entered as customer requirements, 4–4
exceeding planned independent requirements, 2–12
grouping for production in single lot, 2–14
materials segregated and uniquiely assigned, 4–2
not directly influencing production, 2–18
passed to production, 2–5
phantom assembly, 3–13
planned with sales order number, 4–14
processing using materials, 3–17
production with configurable materials, 5–32
replenishment lead time, 3–22
reviewing unconfirmed, 2–14
strategy 10, 2–22
strategy 11, 2–31
strategy 30, 2–16
strategy 40, 2–8
strategy 54, 5–13
using components in, 3–20
Seasonal demand
strategy 10, 2–18
Settings
for production orders, 6–10
for repetitive manufacturing, 6–15
Settings, master data, 5–5
Similarity check, 5–10
Simulative requirements
copying as independent requirements, 5–28
Smoothing, 2–3, 2–27
according to order demand, 3–4
against customer requirements, 3–3
based on order demand, 3–10
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demand program, 2–18
production, 2–19
Spare parts
and dependent requirements, 3–18
and planned indepentent requirements, 3–18
combining sales orders and production requirements, 3–15
components in sales orders, 3–20
maintaining the material master, 3–16, 3–18
planning multi-use materials, 3–17
planning without requirements, 3–19
strategies for multi-use materials, 3–15
Special procurement field, 3–9
Status management functionality, 6–9
Stock
confirming quantity, 2–22, 2–31
influence of, 1–3
leftover, 2–15
not existing for assembly, 3–10
selling unplanned, 2–34
Stockable-types, 5–3
Stock-keeping
at different BOM levels, 3–20
none stored below finished product, 3–21
one level below finished product, 3–21
two levels below finished product, 3–21
Strategies for multi-use materials. See Multi-use materials
Strategy 10. See Net Requirements Planning
Strategy 11. See Gross Requirements Planning
Strategy 20. See Make-to-Order Production
Strategy 25. See Make-to-Order Production with Configurable
Materials
Strategy 26. See Make-to-Order for Material Variant
Strategy 30. See Production by Lot Size
Strategy 40. See Planning with Final Assembly
Strategy 50. See Planning Without Final Assembly
Strategy 52. See Planning Without Final Assembly and Without
MTO
Strategy 54. See Planning Variants
Strategy 55. See Planning Variants Without Final Assembly
Strategy 56. See Characteristics Planning with Dependent
Requirements
Strategy 59. See Planning at Phantom Assembly Level
Strategy 60. See Planning with a Planning Material
Strategy 63. See Planning with a Planning Material and Without
MTO
Strategy 65. See Planning Variants with a Planning Material
Strategy 70. See Planning at Assembly Level
Strategy 81. See Assembly Processing with Planned Orders
Strategy 82. See Assembly Processing with Production Orders
Strategy 89. See Assembly Processing with Characteristics
Planning
Strategy groups
assigning planning strategy, 1–6
assigning to MRP group, 1–5
assinging to the material, 1–6
creating for assembly processing, 6–4, 6–8
maintaining and defining, 1–6
material master record, 1–7
MRP group, 1–6
multiple planning strategies, 1–5
requirements types, 1–5
Subassembly planning, 1–2
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T
Total requirements list, 2–6, 2–24, 3–8, 3–17
checking capacity, 2–42
strategy 40, 2–13
Transferring requirements, 5–28
Type matching, 5–11, 5–13
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